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Documentation

Vous pouvez contribuer à la rédaction de ces pages 1).

Télécharger la version PDF [http://www.ap-i.net/pub/skychart/doc/doc_fr.pdf] de ce document.

Tutoriel

Guide d'utilisation rapide

Installation

Installation pour Windows
Installation pour Mac OS X
Installation pour Debian GNU/Linux
Installation pour Ubuntu
Installation pour Fedora
Installation pour Mageia
Installation de nouveaux catalogues
Faire une installation portable

Manuel de référence

Menu

Fichier
Edition
Configuration
Voir
Carte
Télescope
Fenêtre
Mise à jour
Aide
Menu contextuel de la carte

Barre d'outils

Depuis la version 3.11beta de mai 2014 vous pouvez configurer les bouton des barres d'outils comme vous voulez en utilisant
l'éditeur de barre d'outils. La configuration “Standard” est décrite dans les pages suivantes.

Barre principale
Barre d'objet
Barre de gauche
Barre de droite
Boites à outils
Éditeur de barre d'outils

Zone d'information

Barre d'état
Information détaillée
Liste des objets
Information sur les planètes

Calendrier

Zone de saisie
Crépuscule
Planète
Comète
Astéroïde
Eclipses solaires
Eclipses lunaires
Satellites artificiels

Configuration

Date, Heure
Observatoire
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Carte, Coordonnées
Catalogues
Système solaire
Affichage
Images
Général
Internet

Outils

Labels
Recherche avancée
Position
Liste d'observation
Tour d'observation
Interface SAMP de l'Observatoire virtuel
CatGen
L'éditeur de boite à outil

Divers

Ajouter les éléments orbitaux manuellement
Affichage des objets proches de la Terre (NEO)
Raccourcis clavier
Options de la ligne de commande
Commandes du serveur
Répertoire des données
Référence des scripts
Exemples de script
Méthode de calcul et précision
Installation et compilation du code source
FAQ

Licence

Licence de la documentation Creative Commons et GNU Free Documentation License
Licence du logiciel GNU General Public License

— Patrick Chevalley [mailto:pch%20%5Bat%5D%20ap%20%5Bdash%5D%20i%20%5Bdot%5D%20net] 2014/02/10 17:10

1)

en utilisant le wiki à http://www.ap-i.net/skychart [http://www.ap-i.net/skychart]
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Guide d'utilisation rapide

Mémento à télécharger

Le Mémento est une liste des moyens d'accès aux fonctions de Carte du Ciel.

Afin de pouvoir être imprimé facilement le mémento est disponible au format OpenDocument
[http://fr.wikipedia.org/wiki/OpenDocument] et PDF.

memento_1.1_fr.odt 

memento_1.1_fr.pdf

Contenu du Guide

Installation
La Carte
Système Solaire
Ciel profond
Guider un télescope
CdC comme serveur d'application

Installation

Télécharger le package à partir d'ici 
Lancer l'installateur CdC.
Si CdC V2 est déjà installé, vous pouvez utiliser le même répertoire.

Approfondir ⇒ Pour les détails d'installation selon les plateformes voir :

Installation Linux
Installation Mac
Installation Windows
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La Carte

Contenu du Guide

Installation
La Carte
Système Solaire
Ciel profond
Guider un télescope
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Quand vous démarrez CdC, le logiciel affiche cette fenêtre :

Lieu et Heure d'observation

Dans Configuration > Observatoire (ou avec l'icône  dans la barre gauche) choisir un pays, puis une ville proche de votre
lieu d'observaion.

Approfondir ⇒ Vous pouvez élargir votre choix en téléchargeant des fichiers contenant des lieux plus détaillés et/ou créer de
nouveaux lieux, voir Observatoire .

Par défaut, l'heure est celle du système quand CdC démarre.
Dans Configuration > Date/Heure (ou avec l'icône  dans la barre gauche), vous pouvez régler une heure différente.

Avec le groupe d'icônes du temps  dans la barre principale, Vous pouvez faire évoluer le

temps par intervalles choisis.

Approfondir ⇒ Vous pouvez simuler le déplacement des objets du Système solaire sur la carte, voir Simulation du temps

Lignes / Grilles

Dans Carte > Système de coordonnées ou avec les icônes , , ,  dans la barre gauche, vous pouvez choisir entre
quatre systèmes de coordonnées :

Coordonnées équatoriales
Coordonnées Alt-Az (défaut)
Coordonnées écliptiques
Coordonnées galactiques

Vous pouvez ajouter la grille équatoriale à la grille Alt-Az avec Carte > Lignes/Grilles > Ajouter la grille équatoriale ou
l'icône  dans la barre objets.
Le même menu ou les icônes , , ,  dans la barre objets permettent dafficher les dessins et le limites des constellations,
l'équateur galactique et l'écliptique.

Vous pouvez aussi modifier la projection utilisée pour la carte, voir la page comparaison des projections

Approfondir ⇒ Vous avez plus d'options dans le menu Configuration > Carte, coordonnées .

Horizon, Position
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Si vous voulez voir de ciel dans la direction d'un des points cardinaux, vous pouvez utiliser Carte > Voir l'horizon ou l'une
des icônes N, S, E, W dans la barre de droite.
Si vous voulez placer le zénit local au centre de la carte, utilisez l'icône  dans la barre de droite.
Vous pouvez aussi utiliser l“icône “Position”  dans la barre principale, qui ouvre une boite de dialogue pour entrer les
coordonnées du centre de la carte.
Si vous voulez voir le ciel sous l'horizon, utilisez le menu Carte > Sous l'horizon ou l'icône  dans la barre objets.

Approfondir ⇒ Vous pouvez afficher une ligne d'horizon locale, voir Configuration > Observatoire > Horizon .

Symétrie et rotation

Vous pouvez intervertie le haut et le bas et/ou la droite et la gauche de la carte ou touner la carte vers la droite (sens des
aiguilles d'une montre) ou gauche (sens inverse des aiguilles d'une montre) de 15° à la fois avec Carte > Transformation ou
avec les icônes , , , , dans la barre gauche.
L'icône “Position”  dans la barre principale permet la rotation de la carte degré par degré.

Agrandir, réduire

La largeur de la carte représente le champ de vision en degrés. Par défaut, onze champs de vision sont définis dans CdC.
Vous pouvez modifier le champ de vision de la carte avec :

le menu Carte > Champ de vision
les zones sensibles du haut de la barre de droite.
le menu Voir > Zoom avant et Zoom arrière ou les icônes +  et -  dans la barre principale qui divisent ou
multiplient le champ de vision par 2.
l'icône  dans la barre principale qui ouvre une boit de dialogue où le champ de vision peut être modifié avec un
curseur.
la zone d'entrée de la boite de dialogue ouverte par l'icône “Position”  dans la barre principale qui permet un réglage
du champ de vision à la seconde d'angle près.

L'icône  dans la barre de droite positionne le champ de vision à 360°.

Approfondir ⇒ Vous pouvez modifier les plages des champs de vision standards dans le menu Configuration > Carte,
coordonnées > Champ de vision .

Etiquettes

Vous pouvez afficher ou non les étiquettes dans le menu Carte > Voir les labels ou avec l'icône  dans la barre objets.

Avec l'icône  dans la barre objets vous pouvez passer en mode “modifier les labels”. Ensuite, vous pouvez modifier une

étiquette : Par un clic droit l'étiquette, un menu contextuel apparait où vous pouvez la déplacer, en modifier le contenu ou la
cacher.

Approfondir ⇒ Dans les menus Configuration> Affichage > Labels et Polices , vous pouvez changer la police, sa taille et
sa couleur, choisir les objets à étiqueter et personnaliser le contenu standard.

Vision de Nuit

Vous pouvez utiliser CdC pendant vos observations nocturnes avec l'icône “Vision de nuit”  dans la barre principale ou le
menu View > Vision de nuit : Vous obtenz un fond noir et des nuances de rouge pour les lignes, les étiquettes et les icônes.

Recherche d'objets

Vous pouvez chercher un objet avec la zone d'entrée de recherche rapide  dans la barre principale. Vous devez

entrer l'identifiant entier (avec le préfixe catalogue).
L'icône  ouvre une boite de dialogue de recherche avancée qui vous aide dans le choix des catalogues.
Quand il est trouvé, l'objet est placé au centre de la carte (mais pas verrouillé).

Verrouillage des cartes

Cette fonction conserve l'objet sélectionné au centre de la carte jusqu'à ce que vous le déverrouillez. Vous pouvez verrouiller
une carte sur un objet par un clic droit sur l'objet et l'entrée “Verrouiller sur …” dans le menu contextuel ou utiliser l'icône
{en:documentation:i80.png|}} dans la barre objets.

Cartes multiples, Liens

Dans CdC V3, vous pouvez ouvrir plus d'une carte dans une seule instance de l'application par le menu Fichier > Nouvelle
Carte ou l'icône  dans la barre principale.
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Vous pouvez arranger vos cartes avec le menu Fenêtres ou les icônes   dans la barre principale.
Les cartes multiples peuvent être liées, C'est à dire que toutes les cartes gardent le même centre, quelque soit l'échelle
(champ de vsion) et les autres réglages de chacune. Utilisez l'icône  dans la barre objets.

Champs des oculaires et capteurs CCD

Vous pouvez afficher sur la carte le champ de vos oculaires et capteurs CCD avec le menu Carte > Lignes/Grilles > Voir
les marques ou l'icône  dans la barre objets.
Ces marques sont mises à l'échelle de la carte.

Approfondir ⇒ Vous pouvez décrire vos oculaires et capteurs CCD dans les menus Configuration > Configuration du
programme > Affichage > Cercle du chercheur et Rectangle du Chercheur

Liste des Objets

Vous pouvez choisir le type d'objets à afficher avec :

le menu Carte > Voir les Objets ou
les icônes       dans la barre objets ou
le menu Configuration > Configuration du programme > Carte, Coordonnées > Liste des Objets .

Vous pouvez obtenir la liste complète des objets affichés sur la carte avec l'icône  dans la barre principale. Elle ouvre la liste
dans une fenêtre, vous pouvez la trier par Ascension Droite, l'imprimer, la sauver dans un fichier CVS.

Informations détaillées

Quand vous sélectionnez un objet, la partie droite de la barre d'état affiche se coordonnées équatoriales et ses
caractéristiques et vous pouvez obtenir plus d'information détaillée par un clic droit sur l'objet. Dans le menu contextuel,
choisissez la première entrée Au Sujet de ... 
Dans la fenêtre d'information détaillée obtenue, vous pouvez centre l'objet sur la carte et obtenir une liste des objets de son
voisinage (DE+/-1°, RA +/- 4m) qui est un extrait de la liste générale des objets.

Imprimer la carte

Vous pouvez imprimer la carte avec le menu Fichier > Imprimer ou l'icône  dans la barre principale.

Approfondir ⇒ Vous pouvez convertir la carte en fichier postscript ou bitmap avec le menu Fichier > Options Imprimante
.

Sauver, restaurer la carte

Vous pouvez sauver votre carte dans le format CdC (pour la restaurer plus tard) avec le menu Fichier > Enregistrer sous
... ou l'icône  dans la barre principale.
Vous pouvez aussi sauver votre carte comme fichier PNG avec le menu Fichier > Enregistrer l'image ... .

Vous pouvez restaurer une carte sauvée dans le format CdC par le menu Fichier > Ouvrir ou l'icône  dans la barre
principale.
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Système Solaire
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Planètes

Vous pouvez afficher ou non le Soleil, les planètes and les satellites avec le menu Carte > Voir les Objets > Voir les
planètes ou l'icône  dans la barre objet.

Approfondir ⇒ Dans le menu Configuration > Configuration du programme > Système solaire > Planète , vous
pouvez choisir l'apparence des objets du Système solaire, régler la longitude de la GTR de Jupiter, Mettre en évidence l'ombre
de la Terre (éclipses lunaires) et un mode transparent d'affichage des planètes pour mettre en évidence les occultations.

Comètes

L'installation standard de CdC contient un fichier exemple de 207 comètes qui est chargé dans la base de données.

Ensuite vous pouvez afficher ou non les comètes avec le menu Carte > Voir les Objets > Voir les comètes ou l'icône 
dans la barre objet.

Approfondir ⇒ Dans le menu Configuration > Configuration du programme > Système solaire > Comète - Charger
le fichier , vous pouvez télécharger du Site MPC des fichiers à jour des comètes, dans le même menu, l'onglet “Maintenance”
vous permet de gérer la base données des comètes et l'onglet “Ajouter” vous permet d'ajouter les paramètres d'une nouvelle
comète.

Conseils: Si vous voulez voir toutes les comètes dans le fichier sur une carte à grand angle définir les options suivantes:
“Afficher un symbole», … plus faible que : 999, Voir les comètes 999 magnitude plus faible …

Astéroïdes

L'installation standard de CdC contient un fichier exemple de 5000 astéroïdes qui est charger dans la base de données lors de
l'instalation.

Vous pouvez afficher ou non les astéroïdes avec le menu Carte > Voir les Objets > Voir les astéroïdes ou l'icône  dans
la barre objet.

Approfondir ⇒ Dans le menu Configuration > Configuration du programme > Système solaire > Astéroïde -
Charger le fichier , vous pouvez télécharger du Site MPC des fichiers à jour des astéroïdes, et ensuite exécuter les calculs
mensuels (même menu, onglet suivant).
Dans le même menu, l'onglet “Maintenance” vous permet de gérer la base données des astéroïdes et l'onglet “Ajouter” vous
permet d'ajouter les paramètres d'un nouvel astéroïde.

Simulation d'orbites

Vous pouvez simuler le déplacement des objets du Système solaire sur leurs orbites dans le menu Configuration >
Date/Heure > Simulation .

Simulation de crépuscule

Vous pouvez simuler les couleurs du crépuscule par le menu Configuration > Couleur > Couleurs du ciel (bouton radio

“Fixe noir” ou “Automatique”) ou par l'icône  dans la barre objet.

Approfondir ⇒ Dans le même menu, vous pouvez modifier les couleurs du crépuscule ou la couleur fixe du fond du ciel
comme vous voulez.

Ephémérides

Vous pouvez obtenir les Ephémérides des objets du Système solaire dans le menu Fichier > Calendrier ou l'icône  dans la
barre principale. Ceci comprend le crépuscule, les planètes, les comètes, les astéroïdes, les éclipses lunaires et solaires.

Approfondir ⇒ Dans le même menu, vous pouvez télécharger les dernières prévisions d'éclipses faites par Fred Espenak du
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Site NASA Eclipse [http://eclipse.gsfc.nasa.gov/eclipse.html] .
Vous pouvez aussi modifier la coleur des comètes, des astéroïdes et de orbites dans le menu Configuration > Configuration
du programme > Affichage > Couleurs d'affichage et les couleurs du crépuscule et du fond du ciel dans le menu
Configuration > Configuration du programme > Affichage > Couleurs du fond du ciel .
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Ciel profond
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Etoiles

Vous pouvez afficher ou non les étoiles avec le menu Carte > Voir les Objets > Voir les étoiles ou l'icône  dans la barre
objets.

L'apparence des étoiles peut être modifiée par le menu Configuration > Mode d'affichage ou l'icône  dans la barre
objets (ceci modifie aussi l'apparence des objets du ciel profond).

Approfondir ⇒ Vous trouvez plus d'options dans l'onglet Couleurs d'affichage du menu Configuration > Configurer le
programme > Affichage .

Vous pouvez ajuster le nombre d'étoiles affichées par l'icône  qui ajoute 0.5 à la limite de magnitude maximum et à l'icône 
qui enlève 0.5 à la limite de magnitude maximum. Ces icônes sont dans la barre principale.

Approfondir ⇒ Vous pouvez régler la magnitude maximum des étoiles selon la plage de champ de vision dans le menu
Configuration > Configurer le programme > Carte, coordonnées > Filtre d'objet .
Vous pouvez afficher le déplacement propre des étoile par le menu Configuration > Lignes .

objets du ciel profond

Vous pouvez afficher ou non les objets du ciel profond avec le menu Carte > Voir les Objets >
menucarte#voir_les_objetsVoir les nébuleuses ou l'icône  dans la barre objets.
Le contour des nébuleuses (telles que M42 dans Orion) peut être affiché avec le menu Carte > Voir les Objets > Voir les

lignes ou l'icône  dans la barre objets.

L'apparence des objets du ciel profond peut être modifiée par le menu Configuration > Mode d'affichage ou l'icône 
dans la barre objets (ceci modifie aussi l'apparence des étoiles).

Approfondir ⇒ Vous trouvez plus d'options dans l'onglet Couleurs d'affichage du menu Configuration > Configurer le
programme > Affichage .

Vous pouvez ajuster le nombre d'objets du ciel profond affichés par l'icône  qui ajoute 1 à la limite de magnitude maximum
et à l'icône  qui enlève 1 à la limite de magnitude maximum. Ces icônes sont dans la barre principale.

Approfondir ⇒ Vous pouvez régler la magnitude maximum des objets du ciel profond et leur taille maximum en arcminutes
selon la plage de champ de vision dans le menu Configuration > Configurer le programme > Carte, coordonnées >
Filtre d'objet .

Catalogues

Avec l'installation par défaut de CdC, les catalogues suivant sont livrés :

Bright Stars Catalog contenant 9096 étoiles de magnitude maximum 6.5 (461 k).
SAC contenant 10 600 objets du ciel profond (2.6 Mo)

Approfondir ⇒ Des catalogues plus complets peuvent être téléchargés du site SourceForge SkyChart Catalog Download
Page [http://sourceforge.net/project/showfiles.php?group_id=64092&package_id=208104] . Les catalogues
supplémentaires peuvent se recouvrir et les objets peuvent ne pas apparaitre quand le champ de vision est trop large, vous
pouvez donc choisir les catalogues en fonction de vos besoins dans le menu Configuration > Catalogues (onglets CdC
Etoiles et CdC Nébuleuses ).

Images

Pour obtenir une apparence plus réaliste des objets du ciel profond que des symboles, vous devez télécharger du site
SourceForge CdC Site [http://sourceforge.net/project/showfiles.php?group_id=64092&package_id=97423] un extrait
des images RealSky correspondant au contenu du catalogue SAC et l'installer. Il n'est pas livré avec CdC à cause de sa taille
(234 Mo).
Ensuite vous devez construire la base données des images avec l'onglet Configuration > Images > Objet (bouton

10



“Parcourir le répertoire”).

Beaucoup de ces images font 1°x1°, elles ne sont donc visibles qu'avec des champs de vision inférieurs à 30°. Vous affichez ou
non les images par le menu Carte > Voir les Objets > Voir les images ou l'icône  dans la barre objets.

DSS/RealSky

Pour un objet particulier, vous pouvez télécharger son image du Site DSS [http://archive.eso.org/dss/dss] par l'icône 
dans la barre objets.
L'image est stockée temporairement dans le répertoire Votre_profil\documents\Carte du Ciel\pictures\$temp.fit comme
précisé dans l'onglet Configuration > Configurer le programme > DSS/RealSky (paramètre “Fichiers temporaires”).
Vous pouvez choisir l'image à afficher par l'icône  dans la barre objets.

Approfondir ⇒ Vous pouvez spécifier plus d'options dans le menu Configuration > Configurer le programme >
DSS/RealSky .
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Guider un télescope
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Les étapes de base sont:

1. Sélectionnez le pilote de télescope (ASCOM ou INDI, assurez-vous d'avoir installé les pilotes correspondants)
2. Une fois que vous avez sélectionné le pilote de télescope, allez dans le panneau de contrôle du télescope et de définir la

configuration de base du télescope: port COM, variante du modèle, …
3. Lorsque vous êtes prêt (tous les câbles fixés, initialisation de la raquette faite), connecter le télescope en utilisant le

bouton Connecter.
4. Cliquez sur le bouton Goto pour commander le télescope d'aller à votre cible.

La documentation complète est disponible avec le menu Télescope.

Voir l'aide spécifique sur chaque pilote pourASCOM ou INDI.
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CdC comme serveur d'application
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Il est possible d'utiliser CdC en tant que serveur pour automatiser certaines tâches.

C'est la fonction qui est utilisé quand un autre logiciel peut ouvrir CdC pour montrer une carte de l'objet sur lequel vous
travaillez. 
Ces fonctions sont normalement décrites dans le logiciel appelant.

Du côté de CdC il n'y a qu'une configuration minimale qui est disponible. Juste être sûr que Utiliser le serveur est coché,
que Interface réseau est 127.0.0.1 et que Port est 3292. Un redémarrage du programme est nécessaire après un
changement de ces options.

Si vous prévoyez de vous connecter à partir d'un autre ordinateur sur votre réseau, vous devez modifier l'Interface réseau à
0.0.0.0

Pour savoir si un programme est relié à CdC vous pouvez utiliser la fenêtre Information sur le serveur.

Vous ne pouvez pas quitter CdC tant qu'une autre application est connectée. Dans ce cas, toute action permettant de fermer
CdC ne fait que le minimiser dans la barre des tâches.

Pour fermer CdC vous devez quitter toutes les applications connectées premier. Selon l'application, il peut également fermer
CdC automatiquement.

Vous pouvez développer vos propres applications ou scripts pour automatiser CdC. Voir la liste des Commandes du serveur et
les scripts d'exemples.
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Installation pour Windows

Instruction pour l'installation des binaires sur un système Windows.

Nouvelle installation

Pour une nouvelle installation, téléchargez le programme d'installation correspondant à votre système

skychart-xxx-windows.exe pour un système 32 bit.
skychart-xxx-windows-x64.exe pour un système 64 bit.

Lancer le programme d'installation skychart-xxx.exe et choisir votre répertoire d'installation. (p.ex: C:\Program Files\Ciel)

Mise à jour

Pour effectuer une mise à niveau vers une nouvelle version, téléchargez et exécutez le nouveau programme d'installation.
Assurez-vous d'installer dans le même répertoire que la version précédente.

Si vous désinstallez d'abord la version précédente, cela supprimera également tout les catalogues supplémentaire que vous
avez pu installer et réinitialise votre configuration.

Si vous passez d'une version 32 bits à 64 bits, vous devez également conserver l'ancien répertoire d'installation. Le
programme 64 bits sera installé dans “Program files (x86)” mais cela n'a aucune conséquence.
Si cela vous ennuie, désinstallez d'abord la version 32 bits. Mais avec l'effet décrit ci-dessus.

Options

Pilote de télescope

Seul un nombre limité de télescope sont supportés nativement. 
Pour un plus grand choix installez la platforme ASCOM [http://ascom-standards.org/] ainsi que les pilotes [http://ascom-
standards.org/Downloads/ScopeDrivers.htm] nécessaires.

Enregistrement de vidéo

L'enregistrement de vidéo demande le programme ffmpeg [http://www.ffmpeg.org]

Vous pouvez trouver des téléchargement tout prêt pour Windows:
http://www.videohelp.com/tools/ffmpeg [http://www.videohelp.com/tools/ffmpeg] 
http://sourceforge.net/projects/mplayer-win32/files/FFmpeg/ [http://sourceforge.net/projects/mplayer-win32/files/FFmpeg/]

Vous pouvez l'installer ou vous voulez mais n'oubliez pas de renseigner la position de ffmpeg.exe dans le menu Configuration /
Date-Heure / Animation
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Installation pour Mac OS X

Prérequis

Un Mac récent avec un processeur Intel, les processeurs PPC ne sont pas supportés pour le moment.

Mac OS X 10.6 ou supérieur.

Instruction pour l'installation sur un système Mac OS X.

Téléchargez le fichier d'installation, par exemple skychart-3.1-i386-macosx.dmg

Ouvrez le fichier pour le monter.

Le disque monté s'ouvre, il contient le paquet skychart.pkg.

Faite un clic droit sur cet icone et suivez les instruction pour l'installation du programme. Selon vos réglages de sécurité
vous devrez peut-être accepter que le paquet n'est pas signé. Voir plus d'informations au sujet de Gatekeeper
[http://support.apple.com/kb/HT5290].

Vous pouvez démonter le disque en le tirant dans la poubelle.

Lancement du programme

Ouvrez le dossier Applications - Cartes du Ciel

Ouvrez l'icone “skychart”

Options

Pilotage du télescope

Le pilotage des télescope demande l'installation des pilotes INDI [http://www.indilib.org] Regardez cette page
[http://www.indilib.org/devices.html] pour savoir si votre télescope est supporté.

Le plus simple pour installer Indiserver est un paquet pour Mac OS X disponible depuis http://www.cloudmakers.eu/xindi
[http://www.cloudmakers.eu/xindi]

Wine

Wine est requis pour calculer la position des satellites artificiels dans le Calendrier.

La méthode la plus simple est d'installer un paquet disponible depuis https://dl.winehq.org/wine-builds/macosx/download.html
[https://dl.winehq.org/wine-builds/macosx/download.html] 
Voir aussi https://wiki.winehq.org/MacOS [https://wiki.winehq.org/MacOS]

DOSBox

Si vous voulez aussi afficher la prédiction des flares Iridium en plus des passages de satellites vous devez installer le
programme DOSBox.

Téléchargez le dmg de DOSBox depuis: http://www.dosbox.com/download.php?main=1
[http://www.dosbox.com/download.php?main=1]
Installez le dans /Applications
Pour que Cartes du Ciel puisse l'utiliser vous devez le copier dans un répertoire de $PATH, par exemple au même
endroit que Wine ci-dessus. Faite attention de le renommer entièrement en minuscules lors de la copie:

sudo cp /Applications/DOSBox.app/Contents/MacOS/DOSBox /opt/local/bin/dosbox

Pour le tester entrer dosbox depuis un terminal.

Enregistrement de vidéo

L'enregistrement de vidéo demande le programme ffmpeg [http://www.ffmpeg.org]

Vous pouvez installer la version OS X depuis http://www.ffmpeg.org/download.html [http://www.ffmpeg.org/download.html]
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Installation sur Debian GNU/Linux
Des paquets Debian sont disponibles pour une installation automatique avec apt-get. 
Les architectures supportées sont i386, amd64, armhf.

Toutes ces commandes nécessitent des droits d'administration et doivent être exécutées avec l'utilisateur root. Elles sont
données à titre d'exemple et vous devez les adapter à votre façon préférée d'installer de nouveaux logiciels : GUI, root shell,
su, ….

Ajouter la signature de Patrick Chevalley à APT :

La nouvelle clé utilisée depuis la version 3.11:

apt-key adv --keyserver keyserver.ubuntu.com --recv-keys 8B8B57C1AA716FC2

Ajoutez une nouvelle source dans /etc/apt/sources.list.d 
Pour la version stable:

sh -c "echo deb http://www.ap-i.net/apt stable main > /etc/apt/sources.list.d/skychart.list" 

Si vous désirez des mises à jour plus fréquente avec les versions de développement:

sh -c "echo deb http://www.ap-i.net/apt unstable main > /etc/apt/sources.list.d/skychart.list" 

A partir de la vous pouvez lancez votre gestionnaire de paquet préféré en mode graphique et chercher “skychart”, ou
continuer en ligne de commande comme décrit ci-dessous:

Rafraichir la liste des paquets avec la commande:

apt-get update

Pour installer l'ensemble des programmes avec tous les pré-requis et les données supplémentaires utilisez la commande:

apt-get install skychart

Les logiciel requis sont normalement installé automatiquement. En cas de problème vérifiez que vous avez les paquets
libpasastro [https://sourceforge.net/projects/libpasastro/files/version_1.1-20], libgtk2.0-0, libglib2.0-0, libpango1.0-0, libjpeg62,
libpng12-0, libsqlite3-0, xplanet, indi, ffmpeg

C'est tout, quitter le shell root et tapez skychart pour lancer le programme.

La mise à jour vers une nouvelle version se fera en même temps que les autres logiciels de votre distribution. Normalement
une fois par semaine le lundi pour la version unstable.

Vous pouvez encore installer les logiciels suivants depuis le même répertoire:

ccdciel

eqmodgui

indistarter
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Installation pour Ubuntu
La procédure d'installation ci-dessous utilise uniquement la ligne de commande car c'est la méthode la plus simple à suivre
simplement en faisant un copier/coller des commandes dans un terminal. Ces instructions sont testée avec les versions
d'Ubuntu supportée actuellement.

1. Ajouter la clé publique de Patrick Chevalley's pour APT:

sudo apt-key adv --keyserver keyserver.ubuntu.com --recv-keys 8B8B57C1AA716FC2

2. Ajouter le dépôt de Cartes du Ciel:

sh -c "echo deb http://www.ap-i.net/apt stable main > /etc/apt/sources.list.d/skychart.list" 

Note: Si vous voulez installer la version beta en cours de développement remplacer le mot “stable” par “unstable” dans
la commandes.

sh -c "echo deb http://www.ap-i.net/apt unstable main > /etc/apt/sources.list.d/skychart.list" 

3. Mettre à jour les dépôts:

sudo apt-get update

4. Installer Cartes du Ciel sans les dépendances recommandées (n'installe pas les logiciels requis pour voir les satellites
artificiels, vous pourrez les installer plus tard):

sudo apt-get install --no-install-recommends skychart

5. C'est tout ce dont vous avez besoin pour observer le ciel à l'oeil nu. Mais si vous voulez voir plus d'objets du ciel profond
vous pouvez installer les paquets supplémentaires suivants:

sudo apt-get install skychart-data-stars skychart-data-dso skychart-data-pictures

6. Lancer Cartes du Ciel depuis un terminal:

skychart

Vous trouverez aussi le bouton Skychart dans le menu principal.

7. Le programme ce lance. il prend quelques secondes pour s’initialiser. Lisez les dernier changement et cliquez sur
Suivant.

8. La fenêtre Observatoire s'ouvre. Vous devez indiquer au programme votre lieux d'observation. Le bouton “Base de
donnée” permet de choisir un pays et ville près de chez vous. Vous pouvez télécharger plus de détail pour votre pays ou
utiliser le bouton “Localisation par Internet”. Dans ce dernier cas la précision dépend de votre fournisseur d'accès.

9. C'est tout, le programme est maintenant configuré et se lance. Voir le guide d'utilisation rapide pour la prise en main
des différentes fonctions.
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Installation pour Linux Fedora
Logiciel de base

La version stable de Skychart est incluse dans les paquets de Fedora.

Pour installer le logiciel, rechercher “skychart” dans le menu “Add/Remove Software”:

Pour l'installer depuis un terminal en ligne de commande, entrez:

yum install skychart

Notez qu'en raison des règles pour les paquets Fedora certaines fonctionnalité ne sont pas disponible (satellites
artificiels et flare Iridium).

Pour installer la documentation:

yum install skychart-doc

Catalogues supplémentaires

Seul un minimum de donnée sont incluse dans le paquet logiciel de base.
Pour plus d'étoiles, nébuleuses installez:

yum install skychart-data-stars

et / ou

yum install skychart-data-dso

Pour les images des nébuleuses téléchargez le RPM depuis la page de téléchargement
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Installation pour Linux Mageia
Logiciel de base

La version stable de Cartes du Ciel est déjà inclus dans les paquets fournis par les dépôts Mageia. Pour installer le logiciel, il
suffit d'utiliser rpmdrake (ou le Centre de Contrôle de Mageia) comme le montre la figure ci-dessous:

Pour installer à partir d'un terminal de ligne de commande, tapez en tant que root:

urpmi skychart

ou en utilisant sudo comme un utilisateur standard:

sudo urpmi skychart

Certaines fonctionnalités de CdC ne sont pas disponibles dans le rpm des dépôts de Mageia (calcul des
satellites artificiels et flare Iridium).
Si vous avez besoin de ces fonctionnalités veuillez utiliser les rpm fourni sur la page de téléchargement.

Documentation

Pour préserver la bande passante, depuis CdC 3.4, la documentation en ligne est fournie par un paquet séparé nommé
skychart-wikidoc. Pour l'installer à partir d'un terminal de ligne de commande, tapez en tant que root:

urpmi skychart-wikidoc

Catalogue supplémentaires

Seules les données minimales sont incluent avec logiciel.
Vous pouvez obtenir les fichiers RPM pour plus d'étoiles, de nébuleuses et de photos sur la page de téléchargement.
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Installation des catalogues supplémentaires
Avec Cartes du Ciel il est facile d'installer des catalogues supplémentaires prêtes à l'utilisation que vous pouvez télécharger
et utiliser gratuitement. La plupart des catalogues ne sont pas plus grand que quelques dizaines de mégaoctets, ceux-ci
seront utiles pour de nombreux amateurs éclairés. 
Mais peut-être que vous voulez pousser les choses un peu plus loin. Par exemple, vous voulez que vos cartes affichenet des
étoiles à une magnitude de 19. Alors, vous devez télécharger le catalogue USNO-A2.0. Avant de commencer le
téléchargement, pensez à sa taille. Installé, ce catalogue va consommer 6.11 Go. Toujours intéressé? Voir Les grands
catalogues 

Vous pouvez également choisir de construire votre propre catalogue. Comme base, vous pouvez choisir parmi des milliers de
catalogues existants et de les modifier pour une utilisation dans Cartes du Ciel. Vous pouvez également recueillir des
informations dans votre propre fichier texte. Pour utiliser ces types de catalogues, vous avez besoin de l'outil CatGen afin de
les adapter pour Cartes du Ciel. Ces catalogues exigent un peu plus de temps avant que vous puissiez les utiliser dans Cartes

du Ciel. Mais il s'agit d'un chapitre sur les catalogues prêts à l'emploi, continuons avec cela: 

Les catalogues prêts à l'emploi

Pour accéder à la source de ces catalogues, vous allez à la page de téléchargement [http://www.ap-
i.net/skychart/fr/download/] depuis la page principale de Cartes du Ciel [http://www.ap-i.net/skychart/]. 

Nom du catalogue Description répertoire
d'installation

taille
installée

catalogue de base
cdc

Le catalogue de base. Une nécessité absolue. Habituellement, vous
obtenez cela avec le programme d'installation du programme pour les
versions stables ou bêta.
Il contient:
XHIP le Extended Hipparcos Star Catalog
SAC le catalogue Saguaro Astronomy Club version 8.1 Objets du ciel
profond avec index 
Deep Sky Outlines contours des nébuleuses brillantes
Index l'index de recherche NGC, Messier et IC

cat/xhip 
cat/DSoutlines
cat/ngc2000 
cat/sac

total 
24 MB

cdc catalogue
d'étoiles
supplémentaires

Ajoute les catalogues d'étoiles suivant:
Tycho-2 catalogue d'étoiles, contenant des données sur 2,5 millions
d'étoiles jusqu'à la magnitude 11.
WDS le Washington Double Star Catalog, contient les données des
systèmes d'étoiles multiples.
GCVS catalogue d'étoiles variables avec des informations sur tous les
types d'étoiles variables. 
index de recherche pour les numéros d'étoile SAO, BD, HD, GC.

cat/tycho2 
cat/gcvs 
cat/wds

total 
85 MB

catalogue UCAC 4 Ajoute le catalogue d'étoiles:
UCAC 4, inclut 113 millions d'étoiles jusqu'à la magnitude 16. Pour plus
d'information

cat/ucac4 total 
5.9 GB

GAIA DR2 Ajoute le catalogue d'étoiles:
GAIA DR2, inclut jusqu'à 1.7 milliard d'étoiles jusqu'à la magnitude 21.
Plusieurs version sont disponible avec différent contenu et magnitude
limite afin de réduire la taille de téléchargement. Nécessite l'utilisation
d'une version de CdC supérieur à 4.1.1-3736. Pour plus d' information

cat/gaia total 
300 MB
à 45 GB

cdc catalogue
supplémentaires de
nébuleuses

Un groupe de catalogues d'objets du ciel profond. 
GCM: Globular Clusters in the Milky Way (Harris, 1999) contient les
données de 147 amas globulaires proches de notre Voie Lactée. 
GPN: Catalogue of Galactic Planetary Nebulae (Acker+, 1992). 1143
nébuleuses planétaires prouvées ou probables, et 347 possible
nébuleuses planétaires. 
LBN: Lynds' Catalogue of Bright Nebulae (Lynds 1965). Il contient
également une référence à NGC, Index Catalogue (IC), Sharpless (1959)
Catalogue of HII regions, Cederblad (1956) Catalogue of Diffuse Galactic
Nebulae, et Dorschner and Gurtler (1963).
NGC2000: Il s'agit d'une collection modernisée du New General
Catalogue of Nebulae and Clusters of Stars (NGC), du Index Catalogue
(IC), et du Second Index Catalogue composé par J. L. E. Dreyer (1888,
1895, 1908). Contient 13,226 objets du ciel profond, équinoxe B2000.0 
OCL: The fifth edition of the Lund Catalogue of Open Cluster Data,
fournit des informations clés sur tous les amas ouverts connus dans
notre Voie Lactée. 

cat/gcm 
cat/gpn 
cat/lbn 
cat/ngc2000 
cat/ocl 
cat/pgc

total 
174 MB
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PGC Catalogue of Principal Galaxies, extrait de la base de données
HyperLeda 2012, contient des données sur 1,5 million de galaxies.

cdc_rngc_catalog.zip By Wolfgang Steinicke examiné par Jeff Burton
[http://x.astrogeek.org/software/cdc/catalog.php] pour Cartes du Ciel

liste adaptée d'objets NGC et IC, à l'origine composée par Dreyer.
Contient des données sur 14.000 Objets du ciel profond. L'équinoxe est
ici 2000.0, cette version date du 24 novembre 2002. Activez ce catalogue
dans le premier onglet de la configuration des catalogues en réglant
le chemin d'accès au fichier “hdr.” .

cat/RNGC 2,54 MB

Lorsque vous souhaitez installer ces catalogues pour tous les utilisateurs, vous devez avoir les droits Administrateur

(Windows) ou root (Linux). Si vous ne les avez pas, vous pouvez choisir d'installer les catalogues quelque part dans votre
ordinateur où vous avez les droits suffisants. (Par exemple, votre répertoire personnel.)

Télécharger les fichiers de catalogue que vous souhaitez, les sauver(temporairement)quelque part sur votre ordinateur.
Utilisez votre programme unzip préféré pour décompresser les fichiers dans le répertoire d'installation de Cartes du Ciel.
Avec Windows, il s'agit généralement quelque chose comme C:\Program Files\Ciel, avec Linux c'est /usr/share/skychart.
Mais vous pouvez choisir un autre chemin. N'oubliez pas de configurer le chemin de votre catalogue avec Configuration →
Catalogue.

Activation des catalogues

Vous pouvez activer ou désactiver vos catalogues avec les boîtes de dialogue de Configuration → Catalogues. Cliquez sur
l'onglet correspondant à votre catalogue spécifique. 

Les grands catalogues

La plupart de ces catalogues sont maintenant obsolète et remplacé par GAIA DR2. 
Pour une nouvelle installation voir GAIA DR2 ci-dessus.
Mais vous pouvez toujours vous référer à cette documentation si vous possédez déjà ces catalogues ou si vous avez une raison
particulière de les utiliser.

HST GSC original FITS

HST-GSC est un acronyme pour “Hubble Space Telescope Guide Star Catalogue”. L'objectif initial était de garder le HST sur
sa cible. Ce catalogue contient plus de 19 millions d'objets plus lumineux que la magnitude 16, dont 15 millions ont été
identifiés comme des étoiles. Ce catalogue est considérée comme obsolète. Seulement pour être complet, je vais décrire
comment récupérer ce catalogue. Je vous recommande plutôt d'utiliser le HST GSC Compact.

This large catalog is available from ftp://adc.gsfc.nasa.gov/pub/adc/superseded/1/1220/GSC/
[ftp://adc.gsfc.nasa.gov/pub/adc/superseded/1/1220/GSC/]. After you have done everything that is needed to use this
catalog, you will discover that this catalog consumes 1.18 GB of space. The .gsc files in this version contain ASCII data. 

In the directory of the ftp-server you find directories and 'tarball' files with names like LFFF.tar.gz. (Yes, there is also a file
with the name N0730.tar.) To download this catalog, you can choose to do it in a fast way or a slow way. 
The fast way: download all tarball files to your computer, including the N0730.tar. To correct this small error, rename N0730.tar
to N0730.tar.gz. 
Next step is to 'untar' all tarballs with your favorite archive (unzip) program. (With Windows, I use ZipGenius
[http://www.zipgenius.com/]. Every Linux distribution knows how to deal with tarballs.) Usually, the content of the tarball
will be written in a directory with the same name as the tarball with omission of the '.tar.gz' part. In this directory you use
your favorite archive program again to decompress every file with the .gz extension. 

Watch this: After the untar action, pretty often the contents of the tarballs (i.e. N0000.tar.gz) ends up in a directory
export\pub\ftp\pub\adc\archives\superseded\1\1220\GSC\LFFFF, and pretty often they don't. Whatever the result, after
decompression move all 'LFFFF' directories with their content to one common directory. After that, set Cartes du Ciel-

SkyChart to use the common path with the Setup → Catalog → CDC Stars dialog box. 

Downloading the tarball is quite fast, the decompression of all the .gz files however isn't. (It's well possible that it will take you
a few hours to do them all.) In any case, this is the fast way. The slow way would be to download every single .gz file from
every subdirectory of the FTP-server. And then you still need to decompress them..

HST GSC Compact

Pour l'utilisation avec Cartes du Ciel il n'y a pas beaucoup de différence entre la HST-GSC original FITSet le HST GSC

Compact. Il est basé sur les mêmes 19 millions d'objet et présente les mêmes problèmes de qualité. Il est également
obsolète mais si vraiment vous en voulez un prenez celui-la qui consomme moins d'espace disque.

The original Cartes du Ciel-SkyChart version 2.7x allready could work with the version 1.1 [ftp://cdsarc.u-
strasbg.fr/pub/cats/I/220/GSC/]. Now, this catalog is considered obsolete. The version 1.2 [ftp://cdsarc.u-
strasbg.fr/pub/cats/I/254/GSC/] version became its successor (also obsolete now), at this moment we recommend you the
HST-ACT version to serve as your HST GSC Compact catalog. You can download this one from 
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ftp://cdsarc.u-strasbg.fr/pub/cats/I/255/GSC_ACT/ [ftp://cdsarc.u-strasbg.fr/pub/cats/I/255/GSC_ACT/], or from 
ftp://adc.astro.umd.edu/pub/adc/archives/catalogs/1/1255/GSC_ACT/
[ftp://adc.astro.umd.edu/pub/adc/archives/catalogs/1/1255/GSC_ACT/]. 

When your only possibility is to use HTTP, you might consider downloading from 

http://cdsarc.u-strasbg.fr/ftp/cats/i/255/GSC_ACT/ [http://cdsarc.u-strasbg.fr/ftp/cats/i/255/GSC_ACT/]. 

From your download source, copy all files to a local directory. If you still have got the older HST GSC compact versions 1.1 en
1.2, you still can use them with Cartes du Ciel-SkyChart. 

Last but not least: Activate your catalog with the Setup → Catalog → CDC Stars dialog box.

USNO-A2.0

Comme je l'ai dit plus tôt, c'est un grand catalogue. Il contient des données de 526 280 881 étoiles, parmi les données il y a les
magnitudes V et B. La magnitude limite est à 19+. Malheureusement, ce catalogue ne contient pas de données sur le
mouvement propre.

Il y a plusieurs versions du catalogue 'USNO A', la plus récente est la version 2.0. Il y a aussi un petit sous-ensemble du
catalogue 'USNO A', ce résumé est considérablement plus petit et est appelé USNO-SA 2.0 mais il est totalement inadapté
pour faire des cartes.

Et puis il y a la version USNO B. Depuis l'arrivée de ce catalogue, les professionnels considèrent USNO A2.0 comme obsolète.
USNO B contient des données de 1 milliard d'objets, complet avec des données sur leurs mouvements propres. Voir le
paragraphe suivant.

Le catalogue installé occupera 6,11 GB sur votre disque.
Le catalogue USNO-A2.0 n'est plus disponible depuis NOFS mais j'en ai placé une copie sur mon serveur. 
Utilisez le lien suivant et copier tous les fichiers:

https://vega.ap-i.net/pub/usnoa/ [https://vega.ap-i.net/pub/usnoa/]

Après avoir récupérez votre catalogue USNO-A , s'assurer que votre catalogue contient des fichiers avec les extension .acc

et .cat . les fichiers de ftp://cdsarc.u-strasbg.fr/pub/cats/I/252/USNO_A2 [ftp://cdsarc.u-strasbg.fr/pub/cats/I/252/USNO_A2]
contenir des fichiers avec l’extension .pmm. Ces fichiers ne fonctionnent pas avec Cartes du Ciel, évitez cette déception.

Après le téléchargement, mettre tous les fichiers dans un même répertoire si vous ne l'avez pas déjà fait. 

Et encore: Activez votre catalogue avec Configuration → Catalogue .

USNO-B1.0

Depuis la version 3.9 Cartes du Ciel peut utiliser le catalogue USNO-B1.0 au format US Naval Observatory, 180 répertoire
000-179, chacun avec 10 fichiers .acc et 10 fichiers .cat, 78 Go de taille totale.

Vous pouvez télécharger de catalogue en utilisant Bittorent [http://fr.wikipedia.org/wiki/BitTorrent_(protocole)], la taille du
téléchargement est 46 GB:

Télécharger le fichier torrent [http://www.ap-i.net/pub/skychart/usnob/usno-b1.0.torrent]
Ouvrir le fichier torrent dans votre logiciel bittorrent [https://fr.wikipedia.org/wiki/Liste_de_clients_BitTorrent]. Vous
pouvez éventuellement choisir de télécharger seulement certaines zones. Chaque fichier zip contient les données pour
une zone de déclinaison d'un degré, le nom du fichier est la distance du pole sud (DEC+90) de la zone.
Quand le téléchargement est terminé il faut décompresser chaque fichier zip pour recréer la structure originale du
catalogue.
Merci de laisser le torrent actif après la fin du téléchargement afin d'aider les autres personnes qui désirent ces
données!

Le réglage de la configuration est dans l'onglet Catalogue → Obsolète pour deux raisons: pour ne pas ennuyer les
nombreuses personnes qui ne peuvent obtenir ces fichiers, mais aussi parce que je pense vraiment que NOMAD ou PPMXL
sont un réel progrès par rapport à ce catalogue.

NOMAD

Le catalogue Naval Observatory Merged Astrometric Dataset (NOMAD) contient des données astrométriques et
photométriques pour plus d'1 milliard d'étoiles provenant des catalogues Hipparcos, Tycho-2, UCAC2, et USNO-B1.0 pour
l'astrométrie et la photométrie optique, complétée par la photométrie proche infrarouge de 2MASS.

Voir sur cette page la procédure d'installation de NOMAD pour l'utilisation avec Cartes du Ciel. Les données doivent être
téléchargé à l'aide Bittorrent.

PPMXL

Le catalogue PPMXL des positions et des mouvements propres dans le système ICRS. Combinaison de USNO-B1.0 et de “two
Micron All Sky Survey” (2MASS).
Il contient environ 900 millions d'étoiles, est complet jusqu'à la magnitude 20 et comprent le mouvement propre de chaque
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objet.

Voir sur cette page la procédure d'installation PPMXL pour l'utilisation avec Cartes du Ciel. L'ensemble des données est
facilement téléchargeable depuis le CDS.
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Faire une installation portable
Une installation portable signifie que vous installez CdC sur un support amovible (clé USB, disque externe) et vous pouvez le
brancher à n'importe quel PC pour exécuter l'application sans autre configuration. La configuration est aussi écrit sur le
support amovible, ainsi vous récupérez vos paramètres préférés sur n'importe quel ordinateur.
La version 3.8 ou plus récente est nécessaire pour ce processus.

L'exemple est donné ici pour Windows, mais vous pouvez faire à peu près la même chose sur Linux, dans ce cas utiliser
l'installation tar pour une installation facile. 
Vous pouvez également utiliser la version portable pour Windows sur Linux/Mac en utilisant Wine. De cette façon, vous avez
besoin d'une seule clé USB pour toute plate-forme.

Les commandes supposent le support amovible est monté sur le lecteur E: changer en conséquence si il utilise une autre
lettre.

Cette description utilise principalement une fenêtre de ligne de commande pour la clarté de l'exposé, mais vous pouvez
également utiliser l'outil graphique équivalent.
Pour ouvrir une fenêtre de ligne de commande, utilisez le menu Démarrer → Accessoires → Invite de commandes

1) Créez un nouveau dossier sur votre support amovible:

E:

mkdir portable_skychart

cd \portable_skychart

mkdir Ciel

2) Télécharger le fichier CdC Windows zip depuis la page de Téléchargement. Enregistrez le fichier zip dans le dossier
E:\portable_skychart\Ciel\

3) Extraire le fichier zip dans ce dossier:

cd \portable_skychart\Ciel

unzip skychart-3.8-2450-windows.zip 

4) Créez un dossier pour la configuration du programme:

cd \portable_skychart

mkdir userdata

5)Créez un script de démarrage:

cd \portable_skychart

notepad skychart.cmd

Copiez les lignes suivantes et enregistrez le fichier:

@ECHO off

set basedir=%CD%

start %basedir%\Ciel\skychart.exe --config="%basedir%\userdata\skychart.ini" --userdir="%basedir%\userdata"

   

Maintenant, vous pouvez brancher cette clé USB sur n'importe quel ordinateur (Windows) et exécuter le programme en
double-cliquant sur skychart.cmd.

Etapes facultatives

Ne pas laisser de trace dans le registre

Si vous voulez ne pas laisser de trace dans le registre de l'ordinateur, vous devez désactiver la fonctionnalité de serveur.
Sinon, une clé de registre indiquant le port de connexion est créé.

cd userdata

notepad skychart.ini

Repérez la ligne commençant par AutostartServer, définir la valeur suivante et enregistrez le fichier:

[main]

AutostartServer=0

Copiez la configuration du programme

Depuis la version 3.8, il est possible de copier le fichier de configuration skychart.ini d'une installation existante dans le
dossier userdata.

Une autre option est de sauvegarder et recharger une carte à l'aide du menu Fichier / Enregistrer sous, Fichier / Ouvrir.

Faire un script pour exécuter sur Linux avec Wine
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Montez la clé USB configurée sur votre système Linux.

cd /media/my-usb-key/portable_skychart

vi skychart.sh

Copiez les lignes suivantes et enregistrez le fichier:

#!/bin/bash

wine cmd /C skychart.cmd

   

Comme vous ne pouvez pas régler le bit exécutable sur un système de fichiers FAT, utiliser la commande suivante pour
l’exécuter:

cd /media/my-usb-key/portable_skychart

bash skychart.sh
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Menu Fichier
Le menu Fichier comprend les options suivantes

Nouvelle carte

La version 3 de Cartes du Ciel permet d'ouvrir des cartes du ciel dans des fenêtres séparées. L'avantage est de pouvoir
visualiser en même temps des cartes de différentes régions du ciel, différentes heures, différents observatoires et même
différentes configurations d'affichage.

Après avoir créer plusieurs cartes, vous pouvez les disposer à l'aide du menu Fenêtres les mettre en pleine fenêtre principale,
en arrière plan, les fermer, les redimensionner en tirant leur côté droit ou leur base.

Ouvrir

Cette option permet d'ouvrir une carte du ciel préalablement sauvée avec sa propre configuration de lieu et d'heure

Enregistrer sous

Cette option sauve la carte courante dans un fichier qui pourra être rechargé plus tard par l'option Ouvrir

Fermer la carte

Cette option ferme la carte courante dans le cas ou plus d'une carte sont ouvertes

Enregistrer l'image

La carte courante est sauvée comme fichier image. On peut choisir un fichier de format PNG, JPEG ou BMP

Imprimer

Imprimer le contenu de la fenêtre vers une destination choisie. L'impression peut se faire en couleurs comme à  l'écran, en
noir sur fond blanc ou en blanc sur fond noir. On peut aussi choisir l'orientation et les marges.

Vous pouvez choisir d'imprimer une en-tête avec le texte de description et un pied de page avec la légende.

L'orientation par défaut est Paysage afin de correspondre au mieux au format de l'écran et d'obtenir le même rendu. Si vous
voulez imprimer en orientation portrait il est recommandé de redimensionner la fenêtre à l'écran selon ce format afin
d'ajuster le cadrage et la visibilité des objets. 

Options imprimante
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Configurer l'imprimante pour imprimer le contenu de la fenêtre. Il y a trois options :

1. Imprimante du système : Ceci permet de configurer l'imprimante du système
2. Postscript: Ceci permet d'imprimer vers un fichier postscript. C'est la manière d'obtenir un fichier vectoriel que vous

pourrez ensuite convertir au format PDF ou SVG. Avec Windows il est necessaire Ghostscript et GsView32 soient
installés et que le chemin d'appel soit correct pour voir le résultat. Ceci ne fonctionne qu'avec la version 7.xx de
GsView32

3. Fichier bitmap : Ceci permet d'imprimer la carte dans un fichier BMP. Ceci nécessite de configurer correctement le
chemin vers MsPaint

Sortie

Sortir de l'application Cartes du Ciel
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Menu Edition

Recherche avancée

Ouvre le dialogue de recherche avancée. Vous pouvez rechercher des planètes, étoiles, nébuleuses, comètes ou astéroïdes.

Modifier les labels

Tout comme le bouton  de la barre d'objets ce menu permet de passer les labels en mode d'édition. Dans ce mode les labels

peuvent être modifiés ou déplacés. Un clic droit affiche le menu d'édition. Eviter d'utiliser ce mode en permanence car il
ralentit l'affichage.

Copie

Copie la carte dans le presse-papier. Vous pouvez ainsi facilement la copier dans un programme de traitement de texte ou
d'édition d'image. 
Utiliser la fonction d'impression BMP si vous voulez une image de plus grande résolution.

Défaire

Annule la dernière modification de la carte.

Refaire

Refait la dernière modification annulée.
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Menu Configuration

Éditeur de barre d'outils

L'éditeur de barre d'outils vous permettent de modifier la disposition des barres de boutons.

Gérer les boites à outils

Choisir les fonctions que vous desirez voir dans le panneau des boites à outils de gauche.

Configuration du programme

Ouvre la fenêtre principale de configuration où vous pouvez régler tous les paramètres de l'application.
Cette fenêtre contient neuf sections :

Date / Heure

Vous permet de spécifier les paramètres temporels d'une simulation.

Observatoire

Vous permet de spécifier les coordonnées du lieu d'observation et de régler le comportement de la simulation d'horizon local.

Carte, Coordonnées

Vous permet de régler plusieurs aspects de la carte comme le système de coordonnées, le champ de vision et l'espacement
des grilles.

Catalogues

Vous permet de choisir parmi les catalogues d'objets à afficher sur la carte.

Système Solaire

Vous permet de régler le rendu des planètes et de gérer les données relatives aux comètes et astéroïdes.

Affichage

Vous permet de régler l'interface graphique de l'application. Vous pouvez aussi définir les champs de vos oculaires et
capteurs CCD.

Images

Vous permet de choisir les réglages de l'affichage des objets et de mettre en oeuvre les services DSS et RealSky.

Général

Vous permet différent réglages de la base de données et de la connexion des télescopes.

Internet

Vous permet de régler comment le PC se connecte à Internet et accède aux ressources en ligne.

En bas de la fenêtre de configuration, la case à cocher “Appliquer à toutes les cartes” vous permet d'appliquer les
changements à toutes les cartes ou seulement à la carte en cours.

Enregistrer la configuration

Cette entrée permet de définir les rélages actuels comme réglages par défaut.

Enregistrer la configuration en quittant

Si cette option est cochée, l'application demandera à sauver la configuration avant de se terminer.

Réinitialiser la langue

Réinitialiser la langue à la valeur par défaut de votre ordinateur. 
Pour des raisons évidentes il n'est pas possible de traduire le texte du menu qui s'affiche toujours en anglais
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Carte et options par défaut

Les options suivantes sont disponible:

Efface toute la configuration et relance le programme comme la première fois que vous l'avez utilisé.
Recharge la carte et les options à l'état du dernier enregistrement. C'est la même chose que de quitter le programme
sans sauvegarde et de le relancer.
Modifie certaines options pour favoriser la performance d'affichage plutôt que l’aspect visuel.
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Menu Voir

Affichage plein écran

Agrandit la fenêtre CdC pour remplir l'écran. L'affichage des bares d'outils, de menu, d'état, des ascenseurs et de la barre des
menus ne change pas. Un nouveau clic rétabli la taille d'origine de la fenêtre. La touche F11 joue le même rôle.

Vision de nuit

Un clic sur cette entrée fait basculer les couleurs de la carte entre l'affichage normal et l'affichage de nuit :
fond noir, nuances de rouge pour les grilles, étiquettes et autres marques, icônes des barres d'outils de la couleur définie dans
Configuration > Affichage > Couleurs d'affichage 
Cette fonction n'affecte que la carte et les boutons, voir ci-dessous pour régler votre bureau.

Particularité de Windows

Vous pouvez sélectionner un thème sombre à partir de l'écran de Personnalisation de Windows.
Le thème “Hight Contrast Black” est un bon point de départ. Vous pouvez personnaliser davantage la couleur à partir des
paramètres de “contraste élevé”.
Vous pouvez également trouver plus de thèmes sombres pour Windows en ligne.

Particularité de Linux

La couleur des objets ne peut pas être modifiée par une application mais elle est le résultat du choix d'un thème Gtk2.
Il y a tellement de thème sombre pour Gtk2 que le choix peut en devenir difficile. Fermer et redémarrer skychart pour
chaque essai d'un nouveau thème.
Puis choisir “Vision de nuit” pour modifier la couleur de la carte.

Barre d'outils

Montre un sous-menu composé de ces entrées :

Toutes les barres d'outils établit ou annule l'affichage de toutes les barres sauf la barre des menus (raccourci
Ctrl+B).
Barre principale établit ou annule l'affichage de la barre horizontale sous la barre des menus, au-dessus de la carte.
Barre d'objet établit ou annule l'affichage de la barre horizontale sous la barre principale au-dessus de la carte.
Barre de gauche établit ou annule l'affichage de la barre verticale à gauche de la carte.
Barre de droite établit ou annule l'affichage de la barre verticale à droite de la carte.
Barre d'état établit ou annule l'affichage de la barre horizontale sous la carte.
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Boites à outils

Choisir la boite à outil que vous voulez afficher. Vous pouvez aussi utiliser les touches F1 à F8.

Barre de défilement

Etablit ou annule l'affichage des barres de défilement pour déplacer la carte. Vous pouvez déplacer la carte dans sa fenêtre
sans ces barres par différents moyens :

en maintenant la touche “Maj” enfoncée, draguez la carte,
utilisez les flèches haut, bas, droite, gauches du clavier avec ou sans les touches “Ctrl”, “Maj” ou “Alt”.

Information sur le serveur

Montre l'état des connexions TCP/IP aux clients de CdC, vous pouvez les réinitialiser une par une ou choisir la réinitialisation
automatique.

Il est aussi possible de fermer une connexion par un clic droit sur une ligne.

SAMP

SAMP est un protocole de message, qui permet aux logiciels d'astronomie d'interagir et communiquer. Cartes du Ciel peut se
connecter à d'autres logiciels et envoyer ou recevoir des coordonnées, des images FITS et des tables VO ou des sélections.

Le sous-menu comprend ces fonctions:

Connexion au hub SAMP : Connecter Cartes du Ciel à un hub SAMP, par exemple Topcat
[http://www.star.bris.ac.uk/~mbt/topcat/] ou Aladin [http://aladin.u-strasbg.fr/aladin.gml] .
Déconnexion du hub SAMP : Se déconnecte du hub SAMP.
Etat de SAMP : Affiche l'état de la connexion SAMP.
Configuration de SAMP : Ouvre la fenêtre de configuration de SAMP.

Etoiles variables

Lance le programme pour l'observation des étoiles variables VarObs.

Horloge

Montre une fenêtre avec des informations sur l'heure courante. Il montre les éléments suivants:

L'heure légale pour votre zone horaire.
Le temps universel.
Le temps solaire moyen pour votre longitude.
Le temps solaire vrai, basé sur l'angle horaire apparent du Soleil.
L'heure sidérale locale.
Le jour Julien (TU).

Informations sur le système solaire
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Ouvre une fenêtre donnant des informations sur les planètes, leurs visibilité et leurs orbites.

Le graphique de visibilité inclu également l'objet sélectionné.

Calendrier

Cette fonction indique les phénomènes astronomiques pour une période donnée.

La fenêtre se décompose en sept zones :

une zone d'entrée. Voir détails sur cette page
un onglet Crépuscule. Voir détails sur cette page
un onglet Planète. Voir détails sur cette page
un onglet Comète. Voir détails sur cette page
un onglet Asteroïde. Voir détails sur cette page
un onglet Eclipses solaires. Voir détails sur cette page
un onglet Eclipses lunaires. Voir détails sur cette page

Liste d'observation

Ouvre la fenêtre de la liste d'observation.

Mosaïque

Ouvre l'outil de mosaïque pour préparer une mosaïque pour votre caméra.

Règle le champ

Affiche un curseur permettant de modifier le champ de vision de la carte.

Cette même fonction peut être obtenue avec le bouton  de la barre principale.

Si vous voulez un réglage plus précis, utilisez Voir → Position.

Zoom avant

Divise le champ de vision par deux. L'icône Zoom+ de la barre principale a le même effet.
Vous pouvez aussi modifier le champ de vision avec la roulette de la souris.

Zoom arrière

Multiplie le champ de vision par deux. L'icône Zoom- de la barre principale a le même effet.
Vous pouvez aussi modifier le champ de vision avec la roulette de la souris.

Position

Ouvre la fenêtre de réglage de position permettant d'indiquer les coordonnées du centre de la carte, le champ de vision et la
rotation.

Cette même fonction peut être obtenue avec le bouton  de la barre principale.

Liste d'objet

Ouvre la liste de tout les objets visible sur la carte. Vous pouvez filtrer les types d'objet désiré par le menu Configuration →
Carte, coordonnées, Liste d'objet.

Cette même fonction peut être obtenue avec le bouton  de la barre principale.

Liste d'images

Si des images sont affichée, ouvre la fenêtre Liste d'images.

Clignotement de l'image

Affiche alternativement l'image sélectionnée sur la carte.

Couleur du ciel
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Affiche une couleur du ciel différente selon la position du soleil ou de la lune.

Cette même fonction peut être obtenue avec le bouton  de la barre d'objet.
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Menu Carte

Le menu Carte vous permet de configurer l'affichage des cartes selon vos besoins, rapidement et facilement. Si une
configuration plus détaillée est nécessaire, consultez
Configuration → Carte, coordonnées \ 

Projection

Ici vous pouvez choir le système de coordonnées entre :

Coordonnées Equatoriales,
Coordonnées Azimuthales,
Coordonnées Ecliptiques,
Coordonnées Galactiques,

Ceci fonctionne comme le groupe de boutons-radio Système de coordonnée et les icônes du milieu de la barre d'outils de
gauche.

Transformation

Si vou souhaitez retourner ou incliner la carte, vous pouvez choisir l'une des entrées du sous-menu.
Ceci fonctionne comme les icônes du bas de la barre d'outils de gauche.

Champ de vision

Ici vous pouvez modofier l'amplitude du champ de vision.
Ceci fonctionne comme les icônes du haut de la barre d'outils de droite.

Voir l'horizon

Si vous souhaitez voir la carte du point de vue d'un des quatre points cardinaux, choisissez dans le sous-menu

North,
South,
West,
East.

Ceci fonctionne comme les icônes du bas de la barre d'outils de droite.

Animation

C'est les mêmes fonctions que dans la barre de bouton principale

Voir les objets

Ici vous pouvez choisir d'afficher ou non certaines classes d'objets en cochant les entrées du sous-menu :

Voir les étoiles
Voir les nébuleuses (et tous le s objets du ciel profond)
Voir les images
Voir les lignes
Voir les planètes
Voir les astéroïdes
Voir les comètes
Voir la voie lactée
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Ceci fonctionne comme les icônes de gauche de la barre d'outils des objets.

Ces fonctions se situent également dans Liste des objets Affichage lignes et dans les onglets du Sytème solaire

Lignes / Grilles

Si vous voulez afficher ou non des grilles ou des lignes sur la carte, cochez les entrées correspondantes du sous-menu :

Voir les grilles de coordonnées
Ajouter la grille équatoriale
Voir les figures des constellations
Voir les limites des constellations
Voir l'équateur galactique
Voir l'écliptique
Voir les marques (champs des oculaires)

Ceci fonctionne comme les icônes  et  de la barre d'outils des objets. Ces entrées se trouvent aussi dans

Affichage lignes et Affichage oculaires

Voir les labels

Cochez cette entrée pour voir toutes les étiquettes définies dans le menu :

Configuration → Affichage → Affichage étiquettes \ Ceci fonctionne comme l'icône  dans la barre d'outils des objets.

Sous l'horizon

Cochez cette entrée pour voir les objets situés sous l'horizon. Ceci fonctionne comme l'icône  dans la barre d'outils des
objets.

Voir/Cacher les images DSS

Vous permet d'afficher ou non les images DSS sur la carte.

Filtre des étoiles

Augmente ou diminue le nombre d'étoiles sur la carte en agissent sur le filtre.

Même fonction que le groupe magnitude de la barre principale.

Filtre des nébuleuses

Augmente ou diminue le nombre de nébuleuses sur la carte en agissent sur le filtre.

Même fonction que le groupe magnitude de la barre principale.

Affiche une image DSS

Même fonction que le bouton DSS de la barre d'objet.

La source des images se configure dans Configuration → Images → DSS
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Menu Télescope
Dans le menu: Télescope 

Cartes du Ciel peut être utilisé pour piloter une monture à commande électronique, mais vous pouvez également utiliser CdC
pour récupérer des instructions pour tourner les boutons sur une monture à commande manuelle. Quoi qu'il en soit, avant de
pouvoir utiliser votre monture télescope en combinaison avec CdC, vous devez configurer le type de monture et le pilote dans
Configuration → Général → Télescope .

Paramètres pour télescopes

Comme Configuration → Général → Télescope .

Système de coordonnée

Il est très important que le programme et le pilote de télescope utilisent le même système de coordonnées.

La plupart des pilotes INDI et ASCOM spécifient s'ils veulent des coordonnées J2000 ou locales et CdC obéit à cela. 
Même pour les coordonnées locales, il s'agit toujours de coordonnées non réfractées.

Panneau de contrôle

Dans le menu: Télescope → Panneau de contrôle

Ici, vous pouvez effectuer des réglages spécifiques pour le pilote que vous avez choisi plus tôt dans la boîte de dialogue. Il n'y
a que quelques pilotes, mais ils sont utilisables avec une multitude de monture avec chacune leurs possibilités spécifiques. S'il
vous plaît, consultez le manuel fourni avec le pilote et la monture.

Voir une aide spécifique sur chaque panneau pourASCOM ou INDI.

Une caractéristique très importante de tout pilote, est le bouton Connecter. Lorsque le télescope est physiquement connecté
et le pilote / montage des paramètres spécifiques sont OK, le programme se connecte généralement automatiquement. L'état
de la connexion est affiché au bas de la boîte de dialogue. Quelque part entre le bouton Connecter et le bouton Déconnecter, il
y a un carré de couleur. Rouge indique un état déconnecté, vert indique l'état connecté.

Dès que votre ordinateur est connecté à votre monture, CdC va immédiatement lire les coordonnées actuelles de votre
monture dans votre carte. Après cela, CdC va vous montrer cette position centrée sur la carte.

Le bouton  de la barre principale est un raccourci pour cette fonction.

Panneau de contrôle INDI

Cette option n'est visible que lorsque l'interface du télescope est INDI

Ouvre un panneau de configuration standard pour tous vos périphériques INDI

Goto

Du menu: Télescope → Goto

Après votre monture de télescope est connectée et synchronisée sur un objet, vous pouvez déplacer le télescope vers un
autre objet. Sélectionnez l'objet désiré par un simple clic. Maintenant, dans le menu, cliquez sur Télescope, dans le menu
déroulant, cliquez sur la ligne Goto. Maintenant, les coordonnées sont envoyées à la monture. Dans de nombreux cas, la
monture va commencer immédiatement le déplacement. Sur certains contrôleurs de monture, il peut être nécessaire de
confirmer la commande.

Le bouton  de la barre principale est un raccourci pour cette fonction. 
Une autre façon pour orienter le télescope vers l'objet suivant, est un droit de la souris clic de bouton sur l'objet
sélectionné.Dans la fenêtre qui apparaît, cliquez sur la ligne Télescope, puis Goto.

Vous pouvez arrêter l'opération de goto de courante avec le menu Interrompre le goto ou les touches: Ctrl+K.

Sync

Du menu: Télescope → Sync

C'est la façon d'envoyer les coordonnées d'un objet sélectionné sur la carte à la monture du télescope. Et bien sûr, pour ce
faire, votre télescope doit être connecté à l'ordinateur. La connexion doit être physiquement faite par les bons câbles, et aussi
la connexion logique au programme. 
Il est facile: tout d'abord, vous dirigez votre télescope sur un objet que vous avez identifié. L'étape suivante consiste à
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sélectionner cet objet sur la carte, un simple clic sur l'objet suffit. Maintenant, cliquez sur le menu Télescope puis Sync.
Maintenant, les coordonnées de l'objet sélectionné sur la carte sont envoyé à la monture. A partir de maintenant, la monture
connaît les coordonnées de sa position dans le ciel.

Dans le groupe télescope de la barre principale, le bouton  sync est un raccourci pour cette fonction. 
Une autre façon de synchroniser votre télescope à la carte,est en cliquant sur un objet avec le bouton droit de la souris. Dans
la fenêtre qui apparaît, cliquez sur la ligne Télescope, puis Sync.

Suivre le télescope

Centrer la carte sur la position du télescope et le suivre.

Il est important de se rappeler que d'une connexion télescope est lié à la carte qui était active lorsque vous le connectez. 
Cela permet d'utiliser plusieurs télescopes, même avec des pilotes différent, chacun connecté à sa carte.

Donc, si vous voulez que plusieurs cartes suivent le même télescope vous devez lier les autres cartes.
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Menu Fenêtre

Dans ce menu vous pouvez positionner plusieurs cartes à l'intérieur de la fenêtre de CdC.

Lier toutes les cartes

Même fonction que le bouton correspondant de la barre d'objet.

Verrouiller sur ...

Même fonction que le bouton correspondant de la barre d'objet.

Cascade

Les cartes sont disposées en pile décalée.
Même effet avec l'icône  de la barre d'outils principale.

Arrange horizontalement

Les cartes sont disposées les unes au-dessous des autres.

Arrange verticalement

Les cartes sont disposées côte à côte.
Même effet avec l'icône  de la barre d'outils principale.

Agrandir

La carte courante occupe toute la fenêtre CdC.

Liste de cartes

Une liste des cartes ouvertes apparait en bas du menu. Cliquer sur une entrée active la carte correspondante et la met au
premier plan.
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Menu Mise à jour
Ce menu vous permet de garder à jour certaines données qui doivent être régulièrement mises à jour. Vous devez être
connecté à Internet avant d'utiliser ces fonctions.

Rechercher une mise à jour du logiciel

Vérifie si une nouvelle version du logiciel Cartes du Ciel est disponible et propose de télécharger.

Cette vérification ne concerne qu'une nouvelle version stable, sauf si vous utilisez déjà une version bêta. 

Éléments des comètes

Met à jour les éléments des comètes en utilisant vos paramètres actuels.

Cela ouvre la même fenêtre que Configuration → Système solaire → Comète mais ne touchez aucun bouton car tout est
automatisé.

Éléments des astéroïdes

Met à jour les éléments des astéroïdes en utilisant vos paramètres actuels.

Cela ouvre la même fenêtre que Configuration → Système solaire → Astéroïdes mais ne touchez aucun bouton car tout est
automatisé.

Satellites artificiel

Met à jour les TLE des satellites artificiels en utilisant vos paramètres actuels.

Cela ouvre la même fenêtre que Voir → Calendrier → Satellites artificiel mais ne touchez aucun bouton car tout est
automatisé.
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Menu Aide

Contenu de l'aide

C'est ici! Une version locale de la version en ligne de la documentation [http://www.ap-i.net/skychart/fr/documentation/start]
disponible sur le Site de Carte du Ciel. La documentation en ligne est la version de référence.

FAQ

Une liste de problèmes courant et leur solution. 

Vous trouverez la version la plus a jour ici.

Guide d'utilisation rapide

Un Guide d'utilisation rapide pour les débutant avec le programme. Si vous voulez une description complète de toutes les
commandes regarder plutôt le Manuel de référence.

PDF Contenu de l'aide

Télécharge et affiche l'aide au format PDF.
Une fois téléchargée la version locale est affichée tant qu'une version plus récente n'est pas disponible.

Page web de Cartes du Ciel

Page d'accueil du site de Carte du Ciel [http://www.ap-i.net/skychart/fr/start]

Liste de discussions

Groupe de discussion de Carte du Ciel [https://groups.io/g/skychart]

Signaler un problème

Suivi des bogues [http://www.ap-i.net/mantis/] de Carte du Ciel.

Notes de la version

Version locale des notes de version. L'ensemble des notes de versions est disponible sur la page Nouvelles [http://www.ap-
i.net/skychart/fr/news/start] du Site de Carte du Ciel.

A propos

Trois onglets :

A propos Numéro de Version et date.
Auteurs auto-explicatif.
Accord de Licence Texte de la licence GNU.
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Menu contextuel
Ce tableau montre le résultat des actions à la souris sur la carte :

Clic gauche Clic droit

Objet Etiquette complète Menu contextuel

Etiquette (modifiable) Information détaillée Modif. Etiquette

Etiquette (non modif.) Menu contextuel

Zone vide Menu contextuel

 

Le menu contextuel s'obtient par un clic droit sur la carte, sauf sur une étiquette quand le mode “Modifier les étiquettes”
n'est pas actif.
Entrées :

Au sujet de … cette entrée n’apparaît que si le curseur était sur un objet au moment du clic droit. Elle ouvre une
fenêtre d'informations détaillées sur l'objet.
Tous les objets à cette position Ouvre une liste des objets près de la position du curseur.
Recherche par nom Recherche le nom de l'objet sélectionné sur des indexes externes.
Recherche par position Recherche à la position du curseur sur des indexes externes.
SAMP envoi des coordonnées Envoie la position du curseur à d'autres applications SAMP.
Centrer Déplace le centre de la carte a la position du curseur..
Centrer et Zoom + Pareil que “Centrer” et divise le champ de vision par 2.
Centrer et Zoom - Pareil que “Centrer” et multiplie le champ de vision par 2.
Copie les coordonnées copie la position courante dans le presse papier.
Nettoie la carte Efface tout les ajouts temporaire sur la carte.
Menu spécifique de la boîte à outils Si votre boîte à outils courante inclut un menu, il est visible ici.
Cercle du chercheur Montre un sous-menu :

Mosaïque ouvre l'outil de mosaïque pour préparer une mosaïque pour votre caméra.
Nouveau cercle montre un champ d'oculaire flottant que vous fixez par un clic gauche sur la carte. Vous pouvez
en créer autant que vous voulez. Ces champs d'oculaire sont indépendants de la commande “Carte > Lignes/Grille
> Voir les marques” ou l'icône  de la barre d'outils “objet”.
Supprime le dernier cercle efface le dernier champ d'oculaire créé par la commande précédente.
Supprime tous les cercles efface tous les champs d'oculaire créés par la commande “Nouveau cercle”.
Enregistrer enregistre la position des cercles dans un fichier.
Charger depuis un fichier redessine les cercles enregistré dans un fichier.

Liste d'observation Montre un sous-menu :
Voir la liste d'observation Ouvre la fenêtre Liste d'observation.
Ajouter … à la liste d'observation Ajoute l'objet sélectionné la liste d'observation.

Labels Montre un sous-menu :
Nouveau label créé une étiquette utilisateur sur la carte. Voir Etiquettes .
Supprime le dernier label efface la dernière étiquette créé par la commande précédente.
Supprime tous les labels efface toutes les étiquettes créées par la commande “Nouveau label”.
Récupérer les labels cachés Récupère les labels cachés en utilisant le menu d'édition des labels.

Télescope Montre un sous-menu :
Goto position du curseur Déplace le télescope à la position du curseur même si aucun objet n'est sélectionné.
Goto Même commande que Télescope > Goto ou l'icône .
Sync Même commande que Télescope > Sync ou l'icône .
Connecter Même commande que Télescope > Connecter ou l'icône .
Interrompre le goto auto-explicatif.
Suit le télescope Montre toujours la carte à la position du télescope.

Liste des images Affiche la fenêtre Liste des images si des images sont actuellement affichées.
Définir … comme cible choisit l'objet courant comme cible. Un indicateur de direction sera affiché sur le bord de
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l'écran si l'objet n'est pas dans le champ. 

Verrouiller/Déverrouiller la carte sur les coordonnées sélectionnées. Cette entrée n’apparaît que si le curseur était
sur un objet au moment du clic droit.

Le menu contextuel de modification des étiquettes apparaît par un clic droit sur une étiquette quand le mode “Modifier les

labels” est actif (icône  de la barre d'outils “objet”). Voir Etiquettes .

43



Barre principale
Pour beaucoup de boutons sur la barre d'outils vous pouvez accéder au réglage correspondant par un clic droit sur ​​le bouton.

Groupe Fichier

 Crée un nouvelle carte raccourci pour Fichier > Nouvelle carte .
 Ouvrir une carte raccourci pour Fichier > Ouvrir .
 Enregistrer la carte raccourci pour Fichier > Enregistrer sous .
 Imprimer la carte raccourci pour Fichier > Imprimante .

Vision de nuit (Voir)

 Vision de nuit raccourci pour Voir > Vision de nuit .

Groupe Fenêtre

 Cascade raccourci pour Fenêtre > Cascade .
 Arrange verticalement raccourci pour Fenêtres > Arrange verticalement .

Groupe Edition

 Défaire raccourci pour Edit > Défaire .
 Refaire raccourci pour Edit > Refaire .

Groupe Zoom (Voir)

+  Zoom avant raccourci pour Voir > Zoom avant (divise le champ de vision par 2).
-  Zoom arrière raccourci pour Voir > Zoom arrière (multiplie le champ de vision par 2).

 Régle le champ variation continue du champ de vision, le curseur règle le champ de vision à quelques degrés près.

Groupe Magnitude

 Plus d'étoiles ajoute 0,5 à la limite maximum de la magnitude visuelle des étoiles pour en voir davantage.
 Moins d'étoiles soustrait 0,5 à la limite maximum de la magnitude visuelle des étoiles pour en voir moins.
 Plus de nébuleuses ajoute 1 à la limite maximum de la magnitude visuelle des objets du ciel profond pour en voir

davantage.
 Moins de nébuleuses soustrait 1 à la limite maximum de la magnitude visuelle des objets du ciel profond pour en

voir moins.

Groupe Recherche

La zone d'entrée correspond à la recherche rapide, vous devez entre l'identification du catalogue et de l'objet, une liste des
objets recherchés est mémorisée.
L'icône  accède à la recherche avancée .

Position

L'icône  vous permet de définir rapidement et facilement les coordonnées du centre de la carte en système équatorial ou
azimutal, ainsi qu'un champ de vision et une rotation de la carte (voir Position ).

Liste des Objet
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L'icône  vous permet d'obtenir un extrait des catalogues pour tous les objets présents sur la carte. Voir les détails dans
Liste des Objets .

Liste d'observation

 Liste d'observation est un raccourci pour Voir → Liste d'observation
Ce bouton ouvre la fenêtre de la liste d'observation.

Calendrier

L'icône  est un raccourci pour Voir > Calendrier .

Informations sur le système solaire

 est un raccourci pour Voir > Informations sur le système solaire .

Groupe Temps

C'est un moyen pratique de modifier la date et l'heure de la carte, plutôt que de passer par Configuration > Date / Heure.
Les deux zones combinées vous permettent de choisir une unité de temps et un nombre de cette unité, puis avec les deux
flèches, vous ajoutez ou retranchez cet incrément à la date et l'heure de la carte. L'icône carrée ramène à la date et à l'heure
du système (“maintenant”).

Le bouton  permet de lancer ou arrêter une animation avec l'incrément de temps choisit. Un clic droit sur ce bouton

permet d'ouvrir les réglages d'animation et enregistrement

Groupe Télescope

 Connecte le télescope raccourci pour Télescope > Connecter
 Sync raccourci pour Télescope > Sync
 Goto raccourci pour Télescope > Goto
 Interrompre le Goto raccourci pour Télescope > Interrompre le Goto

Groupe Fenêtre 2

 Si vous avez plus d'une carte ouvertes, mais que la carte courante est en plein écran, cette icône restaure la
disposition précédente.

 Fermer Ferme la carte en cours si ce n'est pas la seule. raccourci pour Fichier > Fermer la carte
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Barre d'objet
Pour beaucoup de boutons sur la barre d'outils vous pouvez accéder au réglage correspondant par un clic droit sur ​​le bouton.

Groupe Objet a

 Voir les étoiles raccourci pour Carte > Voir les objets > Voir les étoiles .
 Voir les nébuleuses raccourci pour Carte > Voir les objets > Voir les nébuleuses .

 Voir les lignes raccourci pour Carte > Voir les objets > Voir les lignes .

 Voir les images raccourci pour Carte > Voir les objets > Voir les images .

Groupe images

 Voir une image DSS Télécharger une image du Site DSS, seul moyen d'utiliser cette fonction.
 Modifie l'affichage de l'image raccourci pour Configuration > Images .
 Clignotement de l'image cette fonction ne semble pas operationnelle.

Goupe Objet b

 Voir les planètes raccourci pour Carte > Voir les objets > Voir les planètes .
 Voir les asteroïdes raccourci pour Carte > Voir les objets > Voir les asteroïdes .
 Voir les comètes raccourci pour Carte > Voir les objets > Voir les comètes .
 Voir la voie lactée raccourci pour Carte > Voir les objets > Voir la voie lactée .

Groupe Lignes/Grilles

 Voir les grilles de coordonnées raccourci pour Carte > Lignes/Grilles > Voir les grilles de coordonnées .
 Ajouter la grille équatoriale raccourci pour Carte > Lignes/Grilles > Ajouter la grille équatoriale .
 Voir les figures des constellations raccourci pour Carte > Lignes/Grilles > Voir les figures des

constellations .
 Voir les limites des constellations raccourci pour Carte > Lignes/Grilles > Voir les limites des

constellations .
 Voir l'équateur galactique raccourci pour Carte > Lignes/Grilles > Voir l'équateur galactique .
 Voir l'écliptique raccourci pour Carte > Lignes/Grilles > Voir l'écliptique .

Groupe Marques

 Voir les marques raccourci pour Carte > Lignes/Grilles > Voir les marques .
 Mesure de distance Lorsque la “mesure de distance” est sélectionnée, le clic gauche de la souris change de

comportement. 

Cliquez sur le premier point, sans relâcher le bouton, déplacez le curseur sur le deuxième point et relâchez le bouton. 
La distance, l'angle de position, le décalage RA et DEC sont affichés à gauche de la barre d'état. 
Le premier et le second point peuvent être n'importe quelle position même sans objet. Mais si un objet est identifié près du
curseur, sa position centrale est utilisée au lieu de la position du curseur de la souris. Dans ce dernier cas, le label
d'identification est affichée près de l'objet. 
Cliquez à nouveau sur le bouton “Mesure de distance” pour revenir à l'utilisation normale du curseur.

 Voir les labels raccourci pour Carte > Voir Label .

 Modifier les labels mettre le mode “Modifier les labels” en/hors fonction, si il est en fonction, un clic droit sur une

étiquette montre un menu contextuel pour la modifier. C'est le seul moyen d'utiliser cette fonction.
 Voir les objets sous l'horizon raccourci pour Carte > Sous l'horizon .

 Voir la couleur du ciel raccourci pour Configuration > Couleur > Couleur du ciel .
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Groupe Lien/Verrou

/  Changer le mode de la souris Change le fonctionnement du bouton gauche de la souris: sélection de la fenêtre
de zoom, ou déplacement de la carte.

 Lier toutes les cartes Si ce mode est actif, toutes les cartes montrent le même objet, même si les réglages sont
différents. Si on déplace une carte, toutes les autres vont refléter le même mouvement.

 Vérouiller sur … Si ce mode est actif, la carte est déplacée pour que l'objet sélectionné soit au centre.

Mode de dessin

 Modifie le mode de dessin cet outil permute le mode de dessin des étoiles entre les trois possibilités “Mode ligne”
“Photographique” et “paramétrique”.

Les objets du ciel profond sont dessinés en “Mode ligne” quand les étoiles le sont, sinon ils sont placés en mode “Graphique”.
Voir Configuration > Mode d'affichage .
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Barre de gauche

Observatoire

 Règle le lieu d'observation raccourci pour Configuration > Observatoire.

Date / Heure

 Règle la date et l'heure raccourci pour Configuration > Date/heure.

Configuration

 Configuration du programme raccourci pour Configuration > Configuration du programme .

Groupe Système de coordonnées

 Coordonnée Equatoriale raccourci pour Carte > Système de coordonnée > Coordonnée Equatoriale .
 Coordonnée Alt-AZ raccourci pour Carte > Système de coordonnée > Coordonnée Alt-Az .
 Coordonnée écliptique raccourci pour Carte > Système de coordonnée > Coordonnée écliptique .
 Coordonnée galactique raccourci pour Carte > Système de coordonnée > Coordonnée galactique .

Groupe Transformation

 Miroir horizontal raccourci pour Carte > Transformation > Miroir horizontal (l'icône devient rouge si l'effet est
appliqué).

 Miroir vertical raccourci pour Carte > Transformation > Miror vertical (l'icône devient rouge si l'effet est
appliqué).

 Rotation à droite tourne la Carte de 15° dans le sens des aiguilles d'une montre, raccourci pour Carte >
Transformation > Rotation à droite .
Voir aussi Barre principale > Position .

 Rotation à gauche tourne la Carte de 15° dans le sens inverse des aiguilles d'une montre, raccourci pour Carte >
Transformation > Rotation à gauche .
Voir aussi Barre principale > Position .

 Rotation de 180° tourne la Carte de 180° pour créer le même effet qu'un miroir horizontal et vertical.
Faire un clic droit sur n'importe lequel des ces boutons pour revenir a l'orientation initiale.
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Barre de droite

Groupe Champ de Vision

Chaque zone sensible montre la limite supérieure d'une plage de champ de vision définie par Configuration > Carte,
coordonnées > Champ de Vision .
Si vous cliquez sur la zone, la largeur de la carte est mise à l'échelle pour représenter le champ de vision correspondant.
Même fonction par Carte > Champ de Vision .
La dernière icône  représente la dernière plage de champ de vision avec une limite supérieure de 360°. 

Groupe Horizon

Chaque icône rend le point cardinal correspondant point de vue de la carte. Même fonction par Carte > Voir l'Horizon .
La dernière icône  met le point de vue de la carte au zénith local.
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Boîte à outils

Les boîtes à outils contient des fonctions pour une tâche spécifique que vous pouvez sélectionner en fonction de vos besoins.
Vous pouvez également ajouter une nouvelle fonction en utilisant l'éditeur de script.

Vous pouvez accéder à huit boîtes à outils à partir du menu principal Affichage → Boite à outils ou à l'aide du raccourci clavier
F1 à F8. Appuyez à nouveau sur la même touche pour masquer le panneau gauche.

Les boîtes à outils sont affichées verticalement sur la gauche de l'écran, cela laisse suffisamment d'espace pour la carte elle-
même avec la plupart des écrans. La largeur de la boîte à outils peut être ajustée avec la souris, et si votre écran est trop
petit, une barre de défilement peut être utilisée.

Chaque boîte à outils contient trois parties:
- Jusqu'à deux barre de boutons où vous pouvez ajouter le même bouton que dans les barres standard.
- La zone principale avec les boutons et textes spécifiques.
- En bas, deux boutons permettent de sélectionner ou de modifier les scripts.

Ouvrir le menu Configuration→Gérer les boîtes à outils ou cliquez le bouton Gérer les boîtes à outils

Cliquez sur la colonne Script pour sélectionner l'outil que vous voulez pour la touche F correspondante.
Cliquez avec le bouton droit sur une ligne pour ouvrir un menu qui permet d'ouvrir un script à un autre emplacement ou de
supprimer une affectation de script.

Vous pouvez utiliser l'éditeur de boîte à outils et de script pour créer vos propres outils ou pour faire des modifications aux
existants.

Outils standard

Outils pour l'observation
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Ce panneau contient des fonctions pratiques lorsque vous utilisez le programme connecté à un télescope goto.

Il contient les fonctions de contrôle du télescope, y compris une raquette virtuelle. 
Pour utiliser la raquette, sélectionnez d'abord si la direction doit être changée et la vitesse de déplacement (en degré /
seconde) dans la liste. Cliquez ensuite sur un des boutons de direction pour lancer le déplacement et cliquez sur le bouton
Arrêter pour arrêter.

Vous pouvez naviguer dans votre liste d'observation ou rechercher un nom d'objet.

Chaque fois qu'un objet est sélectionné, les coordonnées “Cible” en haut sont mises à jour et prêtes à être utilisées avec les
boutons du télescope.

La zone d'information donne les informations détaillées sur l'objet sans avoir à ouvrir une fenêtre séparée.

Système solaire

Ce panneau regroupe les informations relatives aux objets du système solaire.

La barre d'outils contient les boutons associés, vous n'avez donc pas besoin de les ajouter à l'écran principal.

Vous pouvez sélectionner une planète, une comète ou un astéroïde à partir de la zone spécifique.
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Pour une comète ou astéroïde, vous pouvez filtrer la liste en utilisant vos critères. 
Cliquez sur une ligne et sur le bouton Centre pour centrer l'objet sur la carte. 
Vous pouvez également sélectionner certains objets dans la liste et cliquer sur le bouton Marquer pour dessiner un cercle sur
la carte à l'emplacement des objets, indépendamment de leur visibilité.

La zone d'information donne les informations détaillées sur l'objet sans avoir à ouvrir une fenêtre séparée.

Lieu / Date

Ce panneau contient les outils permettant de changer rapidement la date et l'emplacement de l'observateur.

La barre d'outils contient les boutons associés, vous n'avez donc pas besoin de les ajouter à l'écran principal.

Le premier groupe permet de changer la date et l'heure. Utilisez le format de signe négatif pour les années avant 0.

Le groupe suivant contient les informations sur l'emplacement actuel. 
Une liste déroulante permet de changer rapidement la zone horaire pour un fuseau UTC.

Puis vos emplacement favoris sont listés pour sélection. 
Vous pouvez également charger une autre liste à partir d'un fichier. 
Quelques sites intéressants sont ajoutés au bas de la liste pour servir d'exemple pour le format de fichier.

La zone Informations donne les informations détaillées sur l'objet sélectionné sans avoir à ouvrir une fenêtre séparée.

PHD Guiding

Ce panneau contient les outils d'interface avec PHD2 Guiding [http://openphdguiding.org/].

L'interface vous permet d'utiliser facilement la fonction de suivit d'une comète pour garder votre télescope pointé sur un
objet en mouvement tout en guidant sur une étoile.

Vous pouvez également activer la fonction “dithering” pour appliquer un décalage aléatoire à votre position de guidage.

52



Connexion à PHD

Démarrez PHD2 et vérifiez que Outils / Activer le serveur est coché.

Dans Cartes du Ciel, vous pouvez changer l'hôte sur lequel PHD est en cours d'exécution et le port de connexion. Si CdC et
PHD s'exécutent sur le même ordinateur, vous pouvez simplement conserver les valeurs par défaut.

Cliquez sur le bouton “Connect”. Le statut doit passer à “Connected” et indiquer l'état actuel de PHD.

Initialiser PHD comme d'habitude et commencer à guider. Le status doit passer au “Guiding”.

Utiliser la fonction Lock shift

Cette fonction vous permet de garder votre télescope pointé sur un objet en mouvement tout en guidant sur une étoile.

Cliquez sur un objet en mouvement dans la carte, par exemple un astéroïde ou une comète. Le déplacement de l'objet en
arcsec/heure est affiché.

Pour envoyer cette vitesse de déplacement à PHD, cliquez sur le bouton “Set rate”. L'état actuel du “lock shift” est affiché
pour confirmer la modification.

Pour démarrer le guidage sur l'objet en mouvement, cliquez sur le bouton “Enable”. Le texte du bouton passe à “Disable” et le
statut PHD passe à “Tracking active”.
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Utiliser la fonction de Dithering

La fonction de dithering vous permet d'appliquer un décalage aléatoire de la position de guidage pour éviter de cumuler les
défauts du capteur à la même position à chaque exposition.

La fonction est désactivée par défaut car cela est normalement effectué par le logiciel de capture entre les poses. L'utilisation
de cette fonction depuis CdC n'est intéressante que si vous prenez vos photos avec un APN autonome ou avec un logiciel qui
ne prend pas en charge le dithering.

Pour activer la fonction, ouvrez la configuration du script avec le bouton “Editeur de script”.

Sélectionner la ligne “Event_0:0:Initialisation” et cliquer le bouton “Modifier le script”.

En haut du script, commenter la ligne qui cache la zone de dithering. Il suffit d'ajouter // au début de la ligne.

Enregistrez le script modifié et cliquez sur le bouton Appliquer. Enregistrez la configuration de Cartes du Ciel pour un
changement permanent.

Pour appliquer un décalage, définissez la valeur des paramètres requis et cliquez sur le bouton Dither. Assurez-vous de
cliquer sur ce bouton uniquement entre les poses lorsque l'obturateur de l'appareil photo est fermé!

Ajouter d'autres fonctions

Vous pouvez utiliser les scripts fournis comme exemple pour interfacer avec d'autres fonctions disponibles avec PHD2.

Le wiki PHD [https://github.com/OpenPHDGuiding/phd2/wiki/EventMonitoring] donne toutes les informations nécessaires sur ces
fonctions.

Carte mobile
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Cet outil vous aide à imprimer une carte du ciel mobile [https://fr.wikipedia.org/wiki/Carte_du_ciel_mobile] avec un disque rotatif
transparent.

Avant de commencer, vous pouvez définir les options souhaitées pour la carte, l'emplacement de l'observatoire (dans les
limites de latitude), la couleur (noir sur blanc), les objets, les labels (“orienter vers le pôle” pour une meilleure lisibilité dans
n'importe quelle orientation).

Faire le carte du base

Quand vous êtes prêt cliquer le bouton “Set chart”.

Faire le disque rotatif

Sans rien changer cliquer le bouton “Set overlay”.

Impression

Utilisez la fonction “Impression dans fichier bitmap” pour enregistrer une image de grande taille pour les deux parties. Dans
Configuration de l'imprimante, sélectionnez “Fichier bitmap”, définissez la largeur et la hauteur à une valeur confortable
en fonction de la taille que vous souhaitez imprimer (quelque chose entre 2000×2000 et 5000×5000 est un bon point de
départ). Donner un nom de fichier pour chaque partie.

Si nécessaire, vous pouvez utiliser un éditeur d'image pour effectuer des ajustements ou des ajouts.

Vous pouvez maintenant imprimer la d'arrière-plan sur du papier ou du carton et le disque tournant sur un film transparent
imprimable.

Enfin, couper le transparent, et percer à l'emplacement du pôle, monter ensemble les deux parties avec une petite vis.

55



Éditeur de barre d'outils
Vous accédez cette fonction depuis le menu Configuration → Éditeur de barre d'outils ou avec un clic droit dans une partie
vide de la barre.

Les fonctions disponibles sont répertoriées sur la gauche, les barres d'outils actuellement configurées sont à droite. Les
fonctions de gauche sont regroupées comme dans le menu.

Utilisez la boîte de sélection en haut à droite pour choisir la barre que vous souhaitez modifier.

Pour ajouter un nouveau bouton, sélectionnez la fonction que vous souhaitez ajouter sur la gauche, la position du
nouveau bouton sur la droite, puis cliquez sur le bouton flèche droite.
Pour supprimer un bouton, sélectionnez le bouton sur la droite, cliquez sur le bouton flèche gauche.
Pour changer la position d'un bouton, sélectionnez le bouton sur la droite, cliquez sur la flèche en haut ou en bas.
Pour déplacer un bouton vers une autre barre que vous devez le retirer de la première barre puis l'ajoutez à la seconde.
La “recherche rapide” et la sélection “incrément de temps” ne sont pas destinés à être placés dans une barre verticale.

Vous pouvez étendre la liste de gauche avec un clic sur le bouton “+”, ou la réduire avec le bouton “-”.

Il y a trois boutons pour régler un agencement préconfiguré:

Minimal Une seule rangée de bouton destiné à l'observation au télescope.
Standard La même configuration de bouton que dans les versions précédentes du programme. Utilisez ce bouton pour
revenir au réglage par défaut.
Vide Effacer toutes les barres pour vous permettre de commencer votre propre mise en page.

Vous pouvez également augmenter la taille des bouton pour les rendre plus faciles à cliquer sur un écran haute résolution. 
Si vous n'ajoutez pas trop de bouton pour votre taille d'écran et si la taille des bouton est d'au moins 40, vous pouvez
également afficher le texte associé.

Lorsque vous êtes prêt, cliquez sur le bouton OK pour appliquer les modifications. Utilisez le menu Configuration →
Enregistrer la configuration maintenant, pour enregistrer vos paramètres pour une session ultérieure.

Vous pouvez toujours choisir d'afficher ou masquer une barre d'outils dans le menu Voir → Barre d'outils, mais une barre vide
ne sera jamais visible.
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Barre d'état

Côté gauche

 Cette partie affiche en permanence les coordonnées du curseur sur la carte (coordonnées

équatoriales apparentes).

Côté droit

Si un objet est sélectionné, cette partie affiche un extrait des informations détaillées sur l'objet :

Coordonnées équatoriales apparentes.
Première partie de la fiche Information détaillée (caracteristiques de l'objet, le type est codé comme dans la liste des
objets).
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Information détaillée

Accès

Cliquez sur une ligne de la Liste des Objets pour obtenir les informations détaillées à propos de l'objet.
Faites un clic droit sur un objet de la carte et selectionnez “A propos …” dans le menu contextuel.

Si le mode “Modif. Label” est actif (icône  dans la barre d'objets) et que vous cliquez sur l'étiquette d'un objet (utile

pour les objets du ciel profond).
Obtenez d'une autre fenêtre d'information la fenêtre “Voisinage” et cliquez sur une ligne comme pour la liste des objets.

Contenu

Type d'objet
Caractéristiques
coordonnées équatoriales (apparentes et moyennes), Ecliptiques and Galactiques.
Visibilité à partir de l'observatoire, TU, Temps Sidéral local, Azimut et altitude, Lever, Culmination et coucher.
Si un objet précédent a été sélecté et verouillé avant de sélectionner un nouvel objet, la différence entre les deux objets
est donnée en système équatorial et le déplacement en système polaire (unités: degrés) sont affichés.

58



59



Liste des Objets

L'icône  de la barre principale vous permet d'obtenir un extrait des catalogues pour tous les objets présents sur la carte.
Une ligne de cette liste correspond à un objet affiché sur la carte. A la fin de la liste, le nombre des objets listés est affiché.

Si on clique sur une ligne on obtient une fiche d'informations détaillées relative à l'objet correspondant.
Cette fiche peut être aussi obtenue par un clic droit sur le même objet de la carte et le choix “Au sujet …” dans le menu
contextuel qui apparaît.

Cette liste peut être imprimée et sauvée dans un fichier .CSV. Vous pouvez chercher un objet dans une longue liste et trier la
liste par Acension Droite.
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Informations sur le système solaire

Cette fenêtre donne des informations sur les planètes, leurs visibilité et leurs orbites. Il permet également la simulation
d'objets en mouvement, la navigation dans le temps, la synchronisation avec l'heure de la carte et le zoom avant / arrière.

Commandes communes:

Icones – Affiche ou masque les icônes de la barre d'outils.
Sync. Heure – Synchronise l'heure avec la carte connectée (celle à partir de laquelle il est ouvert). Si l'heure de la carte
change, il changera également dans cette fenêtre.

Touches de navigation dans le temps (respectivement):

Réinitialiser - Réinitialise l'heure d'origine de la carte
Décrémente le temps - Diminue le temps d'un pas et rafraîchit l'écran.
Incrémente le temps - Augmente le temps d'un pas et rafraîchit l'écran.
Animation en arrière - Lance l'animation en arrière
Animation en avant - Lance l'animation en avant
Plus lentement - Diminuer le pas de temps entre 1 min et le temps de révolution de Pluton. La valeur par défaut est 3
heures par pas.
Plus vite - Augmente le pas de temps entre 1 min et le temps de révolution de Pluton.

Visibilité des planètes

Affiche un graphique de la visibilité des planètes pour la journée en cours. Les bandes bleue marquent l'heure du crépuscule
et pour chaque objet la barre jaune indique qu'il est visible au-dessus de l'horizon. 
Vous pouvez choisir de commencer le graphique à midi pour un meilleur aperçu de la nuit. 
Le graphique de visibilité inclut également l'objet sélectionné, étoile ou nébuleuse.

Vue des planètes

Montre l'aspect actuel des planètes. Permet une vue rectangulaire et sphérique, vue depuis le Soleil, la Terre et pour voir le
satellite à partir de différentes positions dans le système solaire.
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Io vu depuis Jupiter

La Terre lors de l'éclipse totale du 11 août 1999

La Lune vue du Soleil lors de l'éclipse totale du 11 août 1999
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La Terre en vue rectangulaire lors de l'éclipse totale du 11 août 1999

Système solaire interne et externe

Montre les orbites et positions des planètes de Mercure à Mars pour le système solaire interne et de Jupiter à Pluton pour le
système solaire externe. L'affichage de la distance des planètes est optionnel.

Le système solaire interne

Le système solaire externe
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Calendrier, Zone de saisie

Vous pouvez sélectionner une date début, une date de fin, un nombre de jours entre chaque calcul et une heure où les
positions sont calculées. Par défaut les calculs se font pour la date courante, pour une période de cinq jours à 0h TU. Attention
au temps de calcul si trop de dates sont sélectionnées.

On peut cliquer sur une ligne de la table pour afficher la carte correspondante. Le programme utilise la date et l'heure pour
afficher une carte centrée sur l'objet concerné. Si la colonne sélctionnée contient une heure particulière comme celle du lever
d'une planète ou l'heur du crépuscule, cette heure devient celle de la carte.
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Calendrier, Crépuscule

Cet onglet donne l'heure des crépuscules du matin et du soir pour chaque date sélectionnée.
Le crépuscule nautique commence quand le soleil est 12° sous l'horizon. Les étoiles les plus brillantes sont visibles.
Le crépuscule astronomique commence quand le soleil est 18° sous l'horizon. Le ciel est noir et toutes les étoiles sont visibles.

Les dernières colonnes de la table indiquent le début et la fin de la nuit noir en tenant compte de la présence de la Lune. La
fraction illuminée de la Lune est également indiquée afin de mieux estimer son effet.
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Calendrier, Planète

Montre la position, la magnitude, le diamètre apparent, la fraction illuminée, les heures de lever, culmination et coucher,
l'azimuth et l'altitude courantes pour chaque planète, la Lune et le Soleil, pour chaque date sélectionnée.
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Calendrier, Comète

Montre la position, la magnitude, l'élongation solaire, la phase, les heures de lever, culmination et coucher.

L'élévation au dessus de l'horizon et l'azimuth aux heures des crépuscules aident à observer les comètes proches du soleil.
Ceci indique le meilleur moment du matin ou du soir pour observer la comète.

Vous pouvez chercher un nom de comète ou afficher les plus brillantes en premier dans la liste.
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Calendrier, Astéroïde

Montre la position, la magnitude, l'élongation solaire, la phase, les heures de lever, culmination et coucher.

Indiquer un filtre pour le nom de l’astéroïde puis le choisir dans la liste.
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Calendrier, Eclipses solaires

Toutes les informations de cet onglet viennent de Fred Espenak, NASA/GSFC. Vous pouvez visiter son site en cliquant le
grand bouton en haut de l'onglet. La liste montre les éclipses solaires du siècle en cours.
On trouve la date et l'heure du maximum, la disponibilité de la carte détaillée, le type de l'éclipse, le nombre de saros, la valeur
gamma, la magnitude de l'éclipse, le lieu de l'éclipse maximum, l'altitude du Soleil en cet endroit, la largeur du chemin de
l'éclipse en kilomètres, la durée de la phase totale ou annulaire.
Voir une explication détaillée de ces valeurs. Les données vont de 1800 à 2100, vous pouvez télécharger des données
supplémentaires sur la page Web.

Un clic sur la liste montre l'éclipse vue de l'observatoire en cours. Si vous cliquez sur les colonnes Latitude ou Longitude, ceci
vous montre l'éclipse vue de l'endroit où elle est maximum sur Terre. Si vous cliquez sur la colonne Carte ceci montre la carte
détaillée de l'éclipse si elle est disponible.
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Calendrier, Eclipses lunaires

Toutes les informations de cet onglet viennent de Fred Espenak, NASA/GSFC. Vous pouvez visiter son site en cliquant le
grand bouton en haut de l'onglet. La liste montre les éclipses lunaires du siècle en cours.
On trouve la date et l'heure du maximum, le type de l'éclipse, le nombre de saros, la valeur gamma, la magnitude de la
pénombre et de l'ombre, la durée des phases partielles et totales.
Les données vont de 1800 à 2100 dans la version de base, vous pouvez télécharger des données supplémentaires sur la page
Web.

Un clic sur la liste montre l'éclipse vue de l'observatoire en cours comme pour les Eclipses solaires 
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Calendrier, Satellites artificiels

Le calcul des satellites artificiels utilise les programmes QuickSat [http://www.prismnet.com/~mmccants/] de Mike McCant's et
Iridflar de Robert Matson's. Prenez un peu de temps pour lire la documentation de ces programmes qui se trouve dans les
répertoires data/quicksat and data/iridflar.

Commencer par choisir les dates pour lesquels vous voulez la prévision, la limite de magnitude pour l'affichage dans la liste ou
pour le dessin sur la carte, les fichiers TLE à utiliser (vous pouvez en sélectionner plusieurs avec les touches Ctrl ou Shift).
Utiliser les deux coches sur la droite pour indiquer si vous ne voulez voir les passages de jour et si vous voulez inclure les
flares Iridium dans la liste.

Le fichier pour les flares Iridium doit ce nommer iridium.tle et si vous voulez voir sur la carte la trajectoire du satellite avant
et après le flare il faut sélectionner ce fichier dans la liste et choisir une magnitude pour la carte de 8 au moins.

Après avoir cliqué OK les valeurs suivantes sont affichées :

la date et l'heure du maximum d'élévation du satellite
le nom du satellite
la magnitude maximum
l'azimut et l'altitude du maximum
la distance en kilomètres
l'ascension droite et la déclinaison
l'erreur estimée de la prédiction en minutes pour les satellites ou la distance et direction au maxima du flare pour les
Iridium, la direction du mouvement du satellite.

Si la magnitude absolue du satellite n'est pas connue elle est calculée en supposant une valeur de 6 et elle est affichée entre
parenthèses. Il est possible de mettre a jour le fichier des magnitudes “qs.mag” depuis
http://www.prismnet.com/~mmccants/ [http://www.prismnet.com/~mmccants/] , remplacer le fichier dans le répertoire
Configuration utilisateur satellite .

Un click de souris sur une des lignes montre la carte du passage de ce satellite ainsi que tout autre passant dans un intervalle
de temps de +/- 6 minutes et plus brillant que la limite choisie.

Veillez à mettre à jours très régulièrement (une fois par semaine au moins) les fichiers d'éléments TLE, vous pouvez le faire en
cliquant sur le bouton “Télécharger TLE”.
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Le choix des éléments à télécharger ce fait depuis le menu Configuration → Internet → ​Satellites Artificiels

Il est également possible d'utiliser un script pour automatiser le téléchargement. L'exemple suivant peut être utilisé comme
base de travail: pour Windows [http://​www.ap-i.net/​pub/​skychart/​satellites/​tledownload.zip] ou pour Linux ou Mac [http://​www.ap-
i.net/​pub/​skychart/​satellites/​tledownload.tgz]. Il nécessite de créer un compte sur space-track [https://​www.space-track.org].

Installation des logiciels requis
Le programme Quicksat est une application win32, il fonctionne nativement sur Windows 32 et 64 bits.
Avec Linux ou Mac vous devez installer Wine [http://www.winehq.org/]

Linux Debian/Ubuntu:

sudo apt-get install wine

Linux Fedora:

yum install wine

Mac: Voir la page dédiée à cette installation

Le programme Iridflar est une application dos16, il fonctionne nativement seulement sur Windows 32 bits.
Avec Windows 64 bits une version de Dosbox est incluse dans l'installation de Cartes du Ciel.
Avec Linux ou Mac vous devez installer Dosbox [http://www.dosbox.com/]

Linux Debian/Ubuntu:

sudo apt-get install dosbox

Linux Fedora:

yum install dosbox

Mac: Voir juste après l'installation de Wine
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Réglage Date / Heure
Depuis le menu: Configuration → Date / Heure. Vous pouvez aussi obtenir cette boîte de dialogue par un clic sur l'icône 
dans la barre de gauche.
Vous pouvez également accéder directement à la configuration des animations par un clic droit sur le bouton .

Le réglage Date/Heure a trois onglets :

Temps
Simulation
Animation

Temps

Définir la date et l'heure utilisées pour calculer la position des planètes, comètes, asteroïdes, la position azimutale et le
mouvement propre.

Si l'option “Utiliser l'heure système” est cochée : Si l'option “Rafraichissement” a été sélectée, l'écran va est mis à jour
par intervalles du nombre de secondes choisi. Autrement la date et l'heure par défaut sont celles du démarrage du
programme et reste les mêmes durant toute la session (sauf si vous les rafraichissez grâce au bouton “Heure du sytème”).

Si l'option “Utiliser l'heure système” n'est pas cochée : Vous pouvez utiliser la date et l'heure du système ou entrer une
date et une heure valides entre les années -200'000 à +200'000. Cependant, par défaut la position des planètes n'est calculée
qu'entre -3000 et +3000. Vous pouvez étendre cette période en installant un fichier d'éphéméride JPL.
Attention aux années négatives : mettre 1BC pour 0 et 2BC pour -1. Notez que le temps défini est le temps local de
l'observatoire en cours et que la valeur UT dépend de son fuseau horaire.

Le bouton “Cette nuit” règle l'heure pour le début du crépuscule astronomique pour la date courante.

Le bouton Plus d'options permet de modifier la différence entre le temps dynamique utilisé par le programme et le temps
standard.

La zone horaire se définit avec l'observatoire

Simulation
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Il est possible de tracer dans une carte du ciel la simulation à différents moments de la position du Soleil, de la Lune, des
planètes, des astéroïdes et des comètes. L'intervalle de temps peut être défini comme un nombre de jours, d'heures, de
minutes ou de secondes.

Les positions différentes tracées peuvent être jointes par une ligne et chaque position peut recevoir une étiquette avec le nom
de l'objet, la date, l'heure et la magnitude.

Animation

Options temps réels

Réglez le curseur “Délai entre les images” pour ralentir le rafraîchissement de l'écran durant l'animation. Placez le curseur
vers la droite pour un délai de deux secondes ou à gauche pour aucun délai. Il est recommandé de le mettre à gauche lors de
l'enregistrement d'un film.

Options d'enregistrement
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Vous devez d'abord installer le programme ffmpeg pour créer le film. Pour plus de détails, voir la section installation pour
votre système.
Réglez “répertoire du programme ffmpeg” au point où vous avez installé ce programme, ou tout simplement le nom du
programme si il est dans votre chemin de recherche (par défaut sur Linux).

Cochez la case “Enregistre l'animation” pour faire un film vidéo. Sinon, aucun fichier n'est enregistré et l'animation est jouée
uniquement sur la carte courante.

Changez le “Répertoire d'enregistrement” pour indiquer où vous voulez que le film soit enregistré. La valeur par défaut n'est
pas pratique puisque c'est un dossier caché.

Le “Préfixe d'enregistrement” est utilisé pour nommer les films. Avec les valeurs par défaut, le premier sera skychart1.mp4,
puis skychart2.mp4, et ainsi de suite.

Changez “Extension d'enregistrement” pour modofier le conteneur ffmpeg par défaut. Voir la documentation de ffmpeg
[http://www.ffmpeg.org/documentation.html] pour plus de détails.

Réglez le nombre d'“Image par seconde” que vous voulez pour le film final. Utilisez une faible valeur de 0,5 à 2 si vous voulez
le même effet que l'animation en temps réel. Utiliser la valeur entre 15 et 30 si vous voulez un film doux, mais utiliser un
incrément de temps plus petit dans ce cas. Cela règle l'option -r de ffmpeg.

Réglez “Taille d'image” à la taille que vous voulez pour le film. La valeur par défaut est de ne pas changer et d'utiliser le
format de la carte actuelle. Si vous définissez une autre taille, la carte sera automatiquement redimensionnée au début de
l'animation. Cela ne change aucune option de ffmpeg.

“Options supplémentaires ffmpeg” permet de modifier toute option que vous souhaitez donner à ffmpeg. La valeur par défaut
définit un débit relativement élevé pour donner un résultat de bonne qualité pour toute les tailles d'image prédéfinie. Vous
pouvez utiliser ce champ pour modifier le débit binaire, mais aussi le codec vidéo. Voir la documentation de ffmpeg
[http://www.ffmpeg.org/documentation.html] pour plus d'informations.

Vous pouvez essayer ces options à partir d'une fenêtre de ligne de commande avant de les mettre ici. La séquence d'images
de la dernière animation est conservée jusqu'à ce qu'une nouvelle animation soit exécutée. Ainsi, vous pouvez utiliser ces
images pour essayer une nouvelle option ou même utiliser un autre logiciel pour les assembler. Vous trouverez les fichiers
dans le dossier tmp dans le répertoire de configuration utilisateur 
La commande par défaut est “ffmpeg -r 10 -i %06d.jpg -b:v 18000k -bt 10000k skychart1.mp4”

Il est recommandé d'utiliser le logiciel VLC [http://www.videolan.org/vlc/] pour visualiser les vidéos résultante sans s'ennuyer
avec l'installation de codecs.
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Réglage de l'observatoire
Le réglage de l'observatoire a deux onglets :

Observatoire qui permet le choix du Site d'observation
Horizon qui permet d'en décrire l'environnement

Observatoire

Définit le lieu du Site d'observation, utilisé pour calculer l'azimut et l'altitude des objets de la carte du ciel, les heures de lever
et coucher des astres, la parallaxe des objets du système solaire, etc…

Il y a plusieurs façon saisir votre localisation mais il est conseillé de commencer par le bouton “Localisation par Internet” qui,
si votre ordinateur est connecté au réseau, trouvera au moins votre pays. La pertinence du résultat est très variable selon les
pays et les fournisseurs d'accès.

Vous pouvez ensuite affiner le résultat avec le bouton “Base de donnée” qui permet de choisir parmi plusieurs millions de lieu,
voir ci-dessous pour les détails.

Vous pouvez aussi saisir le nom de votre lieu et cliquer sur la carte du monde pour obtenir une position approximative. Ou si
vous désirez la précision maximum entrez les coordonnées et l'altitude indiquée par un GPS.

Il est important de bien choisir le fuseau horaire du Site pour que la différence entre le Temps Universel et le temps local
(compte tenu du décalage horaire saisonnier) soit juste. Ceci est fondamental pour avoir une carte et un calcul des
éphémérides corrects.
Il est recommandé d'utiliser le fuseau horaire du pays puisqu'il corrige pour l'heure d'été pour toutes les époques où les
règles sont connues.
Vous pouvez également utiliser un fuseau horaire UTC si vous voulez un temps fixe tout au long de l'année.

Si vous utilisez fréquemment ce lieu d'observation vous pouvez l'ajouter à la liste des favoris avec le bouton Ajouter une fois
que tout les réglages vous conviennent.

Base de donnée:

Choisir un pays
Choisir un Site (liste des grandes villes du pays)

Pour avoir un choix plus étendu, vous pouvez télécharger un fichier de détails pour ce pays. Si vous voulez copier
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ces données sur un autre ordinateur sans accès Internet vous les trouverez dans le répertoire des données
utilisateur dans le répertoire “tmp”.
Vous pouvez aussi chercher votre Site grâce au filtre et choisir ensuite dans la liste
Le bouton Voisinage liste les sites connus au alentours.
Le Code du lieu permet de résoudre des homonymes, par exemple une montagne et une rivière qui ont le même
nom. Cliquez dans le champ pour afficher la liste des codes.

Vous pouvez ajouter, modifier ou supprimer un Site avec les boutons “Mise à jour” et “Supprimer” . Pour ajouter un site,
entrez son nom dans la liste, ses coordonnées et cliquer sur “Mise à jour”. Préfixer le nom de vos lieu d'observation
favori (p.ex. obs_) afin de les retrouver facilement en entrant ce préfixe dans la boite de recherche.

Horizon

Vous pouvez simuler l'horizon local par une ligne ou une surface (entre la ligne d'altitude 0° et la ligne d'horizon locale). La
définition de l'horizon local est définie dans un fichier par des paires de valeurs en degrés (azimut, altitude) commençant au
Nord (azimut 0°).

Utiliser une image pour l'horizon

Vous pouvez utiliser une image pour le panorama de l'horizon. L'image doit être un fichier PNG ou BMP de n'importe quelle
taille représentant le panorama sur 360° avec une projection équirectangulaire.
La région du ciel doit être transparente pour les fichiers au format PNG ou de couleur magenta (#FF00FF) pour le format
BMP.
L'horizon doit être exactement à mi-hauteur de l'image mais vous pouvez couper la partie inutilisée. Par exemple, si le point le
plus élevé de votre horizon est à une altitude de 20°, il suffit que l'image couvre de -20° à +20°. Au-dessus de 20° le ciel sera
totalement transparent ​et au-dessous de -20° de la carte est remplie avec la couleur configurée pour l'horizon.
Le côté gauche de l'image est la direction Est. Si vous utilisez une autre orientation vous devez indiquer l'angle de rotation. ​
Cet angle peut être lu à partir de la valeur de “​angle_rotatez=“​ dans un fichier landscape.ini qui se trouve dans le même
dossier que l'image.
Si “Haute qualité”​ est coché, un point est calculé pour chaque pixel de la carte sur l'écran. Sinon, il calcule seulement un
point pour quatre pixels. Voir la discussion sur les performances ci-dessous.

Cette fonction est compatible avec les panoramas fait pour le logiciel Stellarium [http://​www.stellarium.org] utilisant la méthode
Single Panorama [http://​www.stellarium.org/​wiki/​index.php/​Customising_Landscapes#​Single_Panorama_Method].
Donc, la façon la plus rapide de tester cette fonction est d'obtenir un fichier [http://​www.stellarium.org/​wiki/​index.php/​
Landscapes] pour Stellarium. Juste être sûr que le format est compatible en consultant la ligne “type = spherical” dans le
fichier landscape.ini.

Par exemple télécharger le panorama du Jungfraujoch [http://​www.waldvogel.com/​stellarium/​landscape_jungfraujoch.zip], et
décompressez le fichier dans votre dossier personnel.
Ouvrir Cartes du Ciel et ouvrir les paramètres de l'observatoire, ajouter un lieu d'observation pour le Jungfraujoch comme
indiqué ici (les coordonnées ne sont pas prisent automatiquement dans le fichier landscape.ini mais vous pouvez le consulter
pour obtenir les bonnes valeurs):
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Dans l'onglet horizon, cocher “​Afficher l'image de l'horizon”,​ cliquez sur le bouton du dossier et ouvrez le fichier jungfraujoch-
4096.png.

Revenez à l'onglet Observatoire et cliquez sur le bouton “Ajouter” pour ajouter à la liste des favoris avec toutes les options de
l'image.

Cliquez sur OK, vous devez voir la carte ci-dessous:

À propos des performances
Dans certains cas les performances de rafraîchissement de la carte peuvent être mauvaises. La raison est que CdC utilise
uniquement le processeur principal pour afficher le graphique, donc si vous avez un grand écran et un processeur lent, vous
pouvez avoir des problèmes.
En utilisant un ordinateur de milieu de gamme avec un processeur Core I5-2500 et un écran 1600×1200 avec la carte en
plein écran, il faut 0.3 secondes pour dessiner le panorama du Jungfraujoch.
Si vous n'obtenez pas cette valeur, vous pouvez essayer ce qui suit:

Décocher “Haute qualité” de sorte que le processeur ai quatre fois moins de travail à faire. La qualité doit être suffisante
si vous utilisez un écran hi-dpi (ordinateur portable avec une haute résolution).
Réduire la taille de la fenêtre de la carte. Avec le même processeur, il faut seulement 0.1 seconde avec une fenêtre de
1024×768.
Assurez vous de cocher “Réduire les détails lors du déplacement de la carte” dans Configuration / Affichage.
Essayez de couper la partie non utilisée de l'image. Le panorama du Jungfraujoch peut être réduit à 4096×1048 sans
perte, en supprimant 500 pixels en haut et en bas de l'image.
Si vous utilisez un grande image (plus que 4096 pixels) elle peut prendre un certain temps à se charger lorsque vous
démarrez CdC. Dans ce cas, essayez d'utiliser le format BMP qui demande moins de ressources. La taille de l'image n'a
pas contre pas d'incidence sur les performances de dessin de la carte.

Pour faire votre propre panorama
Mettre la caméra sur un trépied à l'endroit exact où vous mettrez votre monture télescope par la suite. Si vous utilisez une
colonne fixe, placez une tête photographique sur la colonne. Assurez-vous de niveler soigneusement le trépied. Essayez
d'avoir l'objectif de l'appareil photo à proximité de l'axe de rotation de la tête pour éviter un problème de parallaxe sur des
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objets proches.
Choisissez un moment où vous obtenez l'éclairage le plus uniforme dans toutes les directions. Une couverture ​​uniforme de
nuages élevés peut être bonne.
Obtenez une séquence d'image pour l'ensemble de l'horizon, assurez-vous d'avoir suffisamment de chevauchement entre les
images.
Utilisez un logiciel de panorama comme Hugin [http://hugin.sourceforge.net/] pour assembler les photos. Convertir le résultat au
format PNG pour supporter la transparence. Ensuite, utilisez GIMP [http://www.gimp.org/] pour rendre le ciel transparent en
utilisant l'une des nombreuse méthode [https://www.google.com/#q=gimp+mask+transparency] disponible, J'ai trouvé que faire
un masque pour le ciel fonctionne bien.
Enfin réduire la taille du panorama à une valeur raisonnable, 4096 ou 8192 pixel de large.

Si vous observez depuis une région montagneuse, j'ai aussi eu de bon résultat en utilisant un générateur de panorama en
ligne [http://www.udeuschle.de/Panoramen.html]. Dans le formulaire indiquez vos coordonnées ainsi que “Left edge=90”, “Right
edge=90”, “Tilt=0”, “Elev. exaggeration=1”. Affichez le panorama, enregistrer toutes les tuiles et les assembler avec GIMP
ou en utilisant la commande “montage” de ImageMagick.

Les autres options

Si vous observez en altitude vous pouvez voir les objets en dessous de la ligne d'horizon.
Vous pouvez simuler la situation de votre Site en altitude par une ligne d'horizon abaissée.

Enfin, vous pouvez spécifier la pression, la température et l'humidité, ce qui permet de corriger les altitudes pour la réfraction
atmosphérique locale.

La dernière ligne concerne une petite correction de l'orientation des pôles terrestres. Vous trouverez les valeurs de
prédiction requise dans le dernier IERS Bulletins A [http://​www.iers.org/​IERS/​EN/​Publications/​Bulletins/​bulletins.html] :

                   MJD      x(arcsec)   y(arcsec)   UT1-UTC(sec)              

     2014  1 31  56688       0.0245      0.3483     -0.12827         

   

Par exemple pour le 24 janvier 2014 utilisez X=0.0245 et Y=0.3483
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Réglage Carte, Coordonnées
Le réglage des cartes et des coordonnées a six onglets :

Carte, Coordonnées
Champ de Vision
Projection
Filtre d'objet
Espacement des grilles
Liste des objets

Carte, Coordonnées

Vous pouvez choisir ici le système de coordonnées de la carte. Quatre systèmes sont disponibles :

Coordonnées équatoriales
Coordonnées azimutales
Coordonnées galactiques
Coordonnées écliptiques

Prise en compte de la précession, de la nutation et de l’aberration

Si vous ne cochez pas l'option Mode expert, vous pouvez choisir dans le groupe Type de coordonnées quatre options :

Apparente (équateur vrai, …)
C'est la position apparente pour l'équinoxe de la date de la carte, y compris la correction pour le mouvement propre, la
précession, la nutation, l'aberration, la déflexion de la lumière. Normalement, c'est ce paramètre que vous devez utiliser
car c'est le seul à afficher la position réelle des objets
Moyenne de la date …
La position pour l'équinoxe de la date, avec seulement la correction pour le mouvement propre et la précession. Utilisez
ce paramètre uniquement pour comparer les coordonnées avec d'autres sources qui utilisent ce système, comme un
almanach imprimé
Moyenne J2000 … 
La position moyenne pour la date 2000.0, y compris la correction pour le mouvement propre et la précession à 2000.0.
Utilisez ce paramètre uniquement pour comparer les coordonnées avec d'autres sources qui utilisent ce système,
comme un atlas imprimé
Astrométrique J2000 …
Utilise l'équinoxe 2000.0 et la précession pour 2000.0, mais le mouvement propre pour la date de la carte. Ce paramètre
est utilisé uniquement pour comparer les coordonnées avec un logiciel d'astrométrie.
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Dans le Mode expert vous pouvez spécifier plus de details :

Equinoxe année (de -20000 à 20000)
Epoque année (de -20000 à 20000)
Mouvement propre à cocher pour corriger les positions selon une époque donnée
Position moyenne ou Position vraie pour Nutation et aberration.

Champ de Vision

Ici vous pouvez spécifier les plages de valeur de onze champs de vision (numérotés de 0 à 10).

Pour chaque plage, spécifiez la valeur minimum en degrés, elle devient le maximum de la plage précédente.

Le minimum de la première plage est 0.0° et le maximum de la dernière est 360° (qui apparaît comme 0.0°), on ne peut pas les
modifier.

Ces plages sont affichées au bas de tous les onglets Catalogue et utilisées dans les onglets Projection, Filtres d'objet et
Espacement des grilles. 

Projection
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Pour chaque plage de champ de vision vous pouvez choisir entre quatre types de projection :

ARC Zénithal équidistants. Elle correspond à la projection d'une caméra de Schmidt.
TAN Gnomonique. C'est la projection par défaut jusqu'à 90° de champ. Correspond à la projection d'une image de
télescope sur une plaque photographique. La projection tangente produit une distorsion importante au dessus de 90° et
diverge vers 180°
SIN Orthographique oblique. Utilisée pour afficher des images en radio-astronomie. La projection sinusoïde produit un
recouvrement à 90°.
CAR Cartésienne. Elle n'a pas grand intérêt sauf qu'elle peut afficher un très grand champ de vision.
MER Mercator. Une bonne projection pour les grand champs mais elle diverge vers les pôles. C'est la projection par
défaut entre 90° et 360°.
HAI Hammer-Aitoff. Un bon compromis souvent utilisée pour l'affichage du ciel complet.

 

Les trois projections zénithale d'après E. Griessen, AIPS memo 27

Par défaut les projections CAR, MER et HAI sont obliques, l'équateur de la projection est déplacé au centre de la carte afin de
minimiser les distorsions.
Si vous voulez l'apparence classique d'une de ces projection vous devez décocher “Utilise des projections obliques” dans la
configuration. 
Voir la page comparaison des projections pour plus d'informations.

Filtre d'objet

Cet onglet règle la limite de magnitude de étoiles et des objets du ciel profond selon le champ de vision de la carte.

Filtrer les étoiles peut être :

désactivé (seulement pour les petits champs de vision),
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automatique et vous pouvez spécifier une magnitude limite comme Référence pour l'oeil nu,
manuel et vous pouvez spécifier une magnitude limite pour chaque plage de champ de vision.

Filtre de nébuleuses (en réalité des objets du ciel profond) peut être :

désactivé (seulement pour les petits champs de vision),
manuel et vous pouvez spécifier une magnitude limite pour chaque plage de champ de vision.

Vous pouvez aussi filtrer les objets de grande taille en précisant une taille limite en minutes.

Espacement des grilles

Cet onglet règle l'espacement des grilles de coordonnées selon le champ de vision de la carte.

Degrés pour l'altitude ou la déclinaison
Heures pour l'azimuth ou l'ascension droite

Vous pouvez désactiver ou activer le tracé des grilles pour chaque champ de vision.

Vous pouvez désactiver ou activer le tracé de la boussole, ajuster sa taille ou choisir un simple pointeur N/E. 

Liste des objets
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Vous pouvez choisir quel type d'objet sera affiché dans la liste des objets de la carte.

Cliquer le bouton  de la barre principale pour afficher la liste des objets.
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Comparaison des projections

Grand champ de vision

Les plus grand champs de vision sont ceux pour lesquels les différences entre les projections sont les plus marquées.
Les exemples montrent un champ de 150° et 360° en utilisant les différentes options disponibles dans le menu The example
show a field of 150° and 360° wide using the different options available in the menu Configuration -> Carte, Coordonnées

MER, Mercator

Champ de 150°, standard et oblique :

 

Champ de 360°, standard et oblique :

 

HAI, Hammer-Aitoff

Champ de 150°, standard et oblique :

 

Champ de 360°, standard et oblique :

 

CAR, Cartésien

Champ de 150°, standard et oblique :
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Champ de 360°, standard et oblique :

 

ARC, ciel complet

Quand vous cliquez le bouton “Voir tout le ciel”  la projection change automatiquement pour “ARC, ciel complet” visible ci-
dessous.
Le même changement se produit si vous utilisez simultanément: une projection oblique, un système de coordonnée azimutal,
un très champ de vision, et l'altitude au milieu de la carte est de plus de 45°.
Vous retrouverez la projection sélectionnée en zoomant ou en ramenant le centre de la carte plus près de l'horizon.

Petit champ de vision

Pour les petit champ de vision la différence entre les projections est beaucoup moins visible mais importante si vous voulez
que votre cartes corresponde à une image particulière.
Les exemples sont avec un champ de 70° afin que les différence soient visible a cette échelle. Regardez la courbure des grilles
pour mieux voir les différences.

TAN, Gnomonique

Champ de 70° :

ARC, Zénithal équidistant

Champ de 70° :
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SIN, orthographique oblique

Champ de 70° :

MER, Mercator

Champ de 70°, oblique :

HAI, Hammer-Aitoff

Champ de 70°, oblique :

CAR, Cartésien

Champ de 70°, oblique :
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Catalogues
Dans le menu: Configuration → Catalogues

Voir aussi comment installer plus de données pour en savoir plus sur l'installation de catalogues supplémentaires.

CdC Etoiles

Utilisez la case à cocher d'un catalogue pour le sélectionner ou le désactiver.

Avant de pouvoir sélectionner les catalogues Tycho 2, GCVS ou WDS, vous devez installer le paquet catalogue d'étoiles
supplémentaire à partir de la page de téléchargement.

Dans le champ “Min”, entrez le code du champ de vision minimum comme décrit en bas de l'onglet. Dans le champ “Max”,
entrez le code du champ de vision maximum. Evitez le recouvrement du même champ de vision par plusieurs catalogues.

Si le catalogue n'est pas dans le dossier standard, le champ “chemin de répertoire” est au rouge. Utilisez l'icône “Dossier” à
droite de la ligne pour spécifier le bon emplacement du catalogue.

Les catalogues marqués “pm” sont dotés de l'information “mouvement propre”. CdC utilise cette information pour calculer la
position des objets à la date sélectionnée. Il est possible d'afficher le mouvement propre sur une période de 1-9999 ans sous
forme d'une ligne. Voir Affichage Lignes

CdC Nebuleuses
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Utilisez la case à cocher d'un catalogue pour le sélectionner ou le désactiver.

Avant de pouvoir sélectionner les catalogues Lynds, PGC, OCL, GCL ou GPN vous devez installer le paquet catalogue de
nébuleuses supplémentaire à partir de la page de téléchargement.

Dans le champ “Min”, entrez le code du champ de vision minimum comme décrit en bas de l'onglet. Dans le champ “Max”,
entrez le code du champ de vision maximum. Evitez le recouvrement du même champ de vision par plusieurs catalogues.

Si le catalogue n'est pas dans le dossier standard, le champ “chemin de répertoire” est au rouge. Utilisez l'icône “Dossier” à
droite de la ligne pour spécifier le bon emplacement du catalogue.

Pour de meilleures performances et pour éviter le recouvrement d'objets, n'utilisez pas plusieurs catalogues pour le même
type d'objets et le même champ de vision. Comme indiqué en bas de l'onglet, utilisez les catalogues d'un seul des trois groupes
à la fois, sinon un message d'avertissement est affiché.

Catalogues

Ici vous pouvez ajouter un catalogue extérieur préparé à l'aide de l'utilitaire CatGen. On appelle Catgen grâce au bouton
“CatGen” en haut à droite.
Vous trouverez plus d'information sur Catgen ici

Utilisez le bouton “Ajouter” pour ajouter une ligne pour un nouveau catalogue et le bouton “Supprimer” pour enlever le
catalogue sélectionné.

Cliquez sur l'icône “Dossier” à la droite de la ligne pour choisir un nouveau catalogue. Choisir le fichier .hdr qui contient la
description du catalogue. En cas d'erreur, la première cellule passe au rouge.

Ensuite modifiez les champs “Min” et “Max” selon le code du champ de vision (les valeurs sont décrites en bas de l'onglet).
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Si le catalogue permettre cette option, vous pouvez changer la couleur de l'objet par un clic sur l'icône dans cette colonne.
Sélectionnez une couleur noir pour revenir à la couleur par défaut.

Certains catalogue permettent une mise à jour des données du catalogue depuis Internet. Cliquez sur la flèche circulaire dans
la colonne Recharger pour télécharger la dernière version du catalogue.

Cliquez sur la première cellule pour la faire passer au vert et activer le catalogue.

Catalogue VO

De onglet, vous pouvez gérer n'importe quel catalogue en ligne disponible depuis l'interface Observatoire Virtuel de Vizier, il y
a plus de 9000 catalogues disponibles.

Cela nécessite une connexion Internet pour rechercher et télécharger un nouveau catalogue. Mais après vous que les
données sont téléchargées vous pouvez aussi les utiliser hors ligne. Vous pouvez copier les fichiers vers un autre ordinateur,
ils sont situés dans le dossier Configuration utilisateur/vo . Repérez le nom du fichier dans la colonne Fichier et copier les
deux fichiers .xml et .config.

Régler Enregistrements max. au nombre maximum d'enregistrements que vous souhaitez télécharger à la fois pour un
catalogue. Vous pouvez augmenter la valeur par défaut si vous voulez un catalogue complet pour une utilisation hors ligne. Ou
diminuer la valeur si vous souffrez de ralentissement lorsque la carte est redessinée. Toute modification prend effet que pour
les prochains téléchargement.

Initialement, la liste est vide, cliquez sur le bouton Ajouter pour ouvrir la fenêtre de l'interface de l'observatoire virtuel et
suivez les instructions sur cette page.

Si vous voulez changer le réglage d'un catalogue, comme la sélection des colonnes, le symbole de dessin ou la couleur,
sélectionnez le catalogue dans la liste et cliquez sur le bouton Mise à jour .

Cliquez le bouton Supprimer pour effacer tous les fichiers du catalogue sélectionné.

Cliquez sur la première colonne à gauche de la ligne pour le rendre vert et activer le catalogue. Mettez la rouge lorsque vous
pas besoin de ce catalogue.

Pour afficher toutes ces données sur la carte, le bouton  dans la barre supérieure doit être coché. C'est un moyen rapide

de sélectionner ou non tous les catalogues.

Si un catalogue n'est pas téléchargé dans son intégralité, que pour les grand relever qui incluent des millions d'objets, vous
pouvez cliquer sur la flèche dans la colonne Recharger pour actualiser les données pour le champ de la carte actuelle. 

Choisir d'abord un champ assez serré sur la carte, 1 ° ou 30' est un bon début. Puis faire un clic droit sur le bouton  pour

ouvrir cette fenêtre et recharger le catalogue que vous souhaitez.

Si vous êtes connecté à un hub SAMP, vous avez la possibilité d'envoyer la table sélectionnée à l'un ou à tous les clients.

Objets personnels
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Vous pouvez ajouter ici un objet ou un point d'intérêt que vous voulez afficher sur la carte.

Cliquez Ajouter pour ajouter un nouvel objet, puis sélectionnez ses propriétés. Au moins les coordonnées doivent être
entrées. Puis cliquez sur le point rouge sur la gauche pour le passer au vert pour sélectionner l'affichage de l'objet. Pour
afficher toutes ces données sur la carte, le bouton  dans la barre supérieure doit être coché. C'est un moyen rapide de
sélectionner ou non tous les objets.

Vous pouvez également sauvegarder et charger la liste d'objet dans un fichier en utilisant les boutons correspondants.

Données d'autres logiciels

Vous pouvez utiliser des catalogue de données provenant d'autres logiciels.

Deepsky Astronomy Software [http://www.mikehotka.com/DAS/index.htm] est un très bon logiciel de planification d'observation
qui s’intègre [http://www.mikehotka.com/DAS/cartes.htm] avec Cartes du Ciel.
Vous pouvez maintenant télécharger le logiciel complet et ses données [http://www.mikehotka.com/DAS/masterdownload.htm]
gratuitement.

Entrer ici le répertoire des différents catalogues de ce logiciel pour les utiliser pour les cartes de CdC.

Obsolete

Si vous voulez utiliser vos anciens catalogues, spécifiez les dans cet onglet de la même façon que dans les deux précédents.
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Interface de l'Observatoire Virtuel
Depuis le menu: Configuration → Catalogues → Catalogue VO → Ajouter

Cet écran vous permet de sélectionner et de télécharger des données de plus de 9000 catalogues disponibles à partir de
Vizier [http://vizier.u-strasbg.fr] “Virtual Observatory”.

Sélection des catalogues

La première fois que vous ouvrez cette fenêtre, vous devez sélectionner un site miroir de Vizier à proximité de votre
emplacement.

Il y a deux façon d'obtenir une liste de catalogue:

Par nom : tapez un mot du nom du catalogue, acronyme, nom de l'objet.
Autour de la position : cela recherche des catalogues avec des données autour de la position du centre de la carte.

Faites défiler la liste pour sélectionner la ligne avec les données que vous souhaitez et appuyez sur Choisir le catalogue
pour aller à l'écran suivant. 
Comme exemple nous sélectionnons ici un catalogue des Céphéides dans la galaxie M101.

Table et paramètres

Soyez attentif et prenez votre temps pour examiner cet écran. Il y a certaines option qui influent grandement sur le résultat
final et malgré que le programme essaie de déterminer les meilleurs réglages à partir des données vous voudrez
probablement en modifier quelques unes.

La prochaine étape est de cliquer sur les onglets du haut pour sélectionner la table de données que vous voulez. Seules les
tables qui contiennent les coordonnées des objets sont affichée parce que c'est nécessaire pour afficher les objets sur la carte.
Par exemple, ici la table 2 liste les étoiles de références et la table 3 les Céphéides de M101, nous choisissons donc la table 3.

La liste contient tous les champs de la table. Avec un “x” dans la première colonne, le champ est sélectionné pour être inclut
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dans le téléchargement.
Le programme utilise le champ UCD [http://www.ivoa.net/Documents/latest/UCDlist.html] et les unités pour reconnaître les
données.
Examinez attentivement la liste pour être sûr que les données requises pour tracer l'objet sont sélectionnés:

identification (ucd = meta.id,meta.main)
magnitude (ucd = phot.mag,em.opt.V)
dimension (ucd = phys.angSize)

Si la table contient plusieurs données du même type (même UCD), vous pouvez sélectionner ci-dessous la colonne à utiliser
sur la carte pour la magnitude, la taille et l'identification. Vous pouvez également changer le préfixe du nom par un autre
texte que le titre de la colonne.
Les unités sont également importants, ne vous attendez pas a ce que le programme dessine l'objet de la bonne taille si elle est
donnée en millimètres sur la plaque photographique!

A ce stade, il peut être utile de jeter un oeil aux données, cliquer le bouton Prévisualiser pour charger un échantillon dans
l'écran décrit ci-dessous.

En dessous est affiché le nom de la table, le nombre total d'enregistrements, la description de la table et une case à cocher
pour choisir vous voulez télécharger le catalogue complet ou uniquement les données pour la position actuelle de la carte. Sur
la gauche, vous pouvez sélectionner:

La magnitude par défaut qui est utilisée si les données sont manquantes.
Le type d'objet ou le symbole à dessiner sur la carte.
La taille par défaut en seconde d'arc qui est utilisée si les données sont manquantes.

Pour remplacer la couleur par défaut pour le type d'objet: cocher “Forcer la couleur” et cliquez sur le carré de couleur.

Ensuite, choisir le type de dessin “comme étoile” ou “comme nébuleuse” dans la case du milieu. 
Parfois, le programme fait le mauvais choix. Par exemple, il veut dessiner un catalogue d'étoiles comme des nébuleuses parce-
qu'il inclue une mesure angulaire prise à tort pour la taille de l'objet.
Ou comme avec les Céphéides de notre exemple nous préférons afficher la position des étoiles avec un symbole, alors nous
choisissons “comme nébuleuse”.

Quand tout est prêt presser le bouton Télécharge le catalogue.

Quand il termine, la fenêtre se ferme et nous revenons aux paramètres des catalogue.

Prévisualisation des données

C'est juste un aperçu de quelques lignes des données que vous avez sélectionné dans l'écran précédent.

Appuyez sur le bouton Retour pour revenir.

Résultat sur la carte
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Les Céphéides de notre exemple sont des carrés verts. 
Nous avons déjà choisi les régions HII de M101 comme cercle bleu, les losanges rose représentent le catalogue HyperLeda, et
les étoiles proviennent du catalogue NOMAD.
Notez que le bouton VO sur la barre du haut est coché pour afficher ces données supplémentaires.

Si vous avez besoin de fonctions plus puissantes pour sélectionner les données vous pouvez utiliser Topcat
[http://www.star.bris.ac.uk/~mbt/topcat/] avec l'interface SAMP. 
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Système solaire
Le réglage du Système solaire a quatre onglets :

Système solaire
Planète
Comète
Asteroïde

Système solaire

Vous pouvez spécifier si vous voulez la position géocentrique ou topocentrique. Toujours indiquer topocentrique, sauf si vous
voulez comparez les résultats avec des éphémérides imprimée.

Indiquez aussi si Pluton doit être considéré ou non comme une planète.

La dernière option permet de montrer ou non quelques 33 faibles satellites des planètes extérieures. La plupart de ces
satellites ne sont jamais visibles avec un télescope depuis la Terre, il peut donc être utile de désactiver cette option.

Ephémérides

Pour fournir la meilleur précision possible le calcul de la position des planètes ainsi que la nutation utilise les éphémérides JPL
DExxx. 
Afin de limiter la taille du téléchargement seul le fichier DE405 pour la période 2000-2050 est inclut avec le programme.

Vous pouvez ajouter des fichiers pour couvrir une plus longue période ou utiliser une autre éphéméride. Télécharger les
fichiers binaires depuis ftp://ssd.jpl.nasa.gov/pub/eph/planets/Linux [ftp://ssd.jpl.nasa.gov/pub/eph/planets/Linux] ou
ftp://ssd.jpl.nasa.gov/pub/eph/planets/SunOS [ftp://ssd.jpl.nasa.gov/pub/eph/planets/SunOS] .
Puis placez les fichiers lnx* ou unx* dans le répertoire d'installation sous data\jpleph\ sans créer de sous-répertoire. Vous
devez relancer le programme après avoir ajouté ou supprimé des fichiers.

Le programme essaye de charger dans l'ordre: DE430, DE431, DE423, DE421, DE422, DE405, DE406, DE403, DE200
Les fichiers “lnx*” sont utilisé de préférence aux “unx*” car ils ne demande pas de renverser l'ordre des octets.

Si aucun fichier n'est trouvé pour la date, le programme utilise plan404 de Steve Moshier [http://www.moshier.net/index.html]
qui permet les calculs de -3000 à +3000 avec une précision meilleur qu'une seconde d'arc.

Si DE431 est présent le calcul de la position des planètes peut être fait entre -13000 et +17000 ans.

Si vous sélectionnez une date pour laquelle il n'existe aucun moyen de calculer la position des planètes, l'affichage des
planètes est automatiquement désactivée. Vous devez cliquer sur le bouton Voir les planètes après que vous êtes revenu à une
date valide.

Planète
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Vous pouvez activer ou désactiver l'affichage du Soleil, des planètes et de leurs satellites.

Quatre modes de représentation des objets du système solaire sont disponibles, ils sont surtout distincts quand le champ de
vision est suffisamment faible pour afficher la surface de la planète.

Cochez la boite correspondante pour afficher une image du Soleil en temps réel provenant des satellites SDO
[http://sdo.gsfc.nasa.gov/] ou SOHO [http://sohowww.nascom.nasa.gov/home.html] 
Choisir l'image que vous voulez dans la liste. Celle par défaut AIA 4500 correspond à l'aspect visuel mais vous pouvez aussi
essayer d'autres longueurs d'ondes.
L'image sera rafraichie après le temps indiqué ou à chaque changement de longueur d'onde. La fréquence de mise à jour
effective de l'image dépend de l'opération des satellites, voir les indication sur leur site respectif. La source de l'image et sa
date sont indiquée sur la carte à coté du soleil.
Cette fonctionnalité demande une connexion Internet ainsi que d'avoir configuré le proxy si cela est nécessaire.

Vous pouvez mettre à jour la longitude de la Grande Tâche Rouge de Jupiter : cliquer le bouton Obtenir des mesures
récentes du projet JUPOS, il télécharge un fichier avec une mesure récente et met à jour les valeurs.
Vous pouvez aussi ouvrir la page du projet Jupos [http://jupos.privat.t-online.de/] dans votre navigateur, vous trouvez page de la
longitude de la GTR dans le menu de gauche. Notez la position des points rouges en bas du graphique pour obtenir la position
la plus récente du centre de la GTR. Elle était par exemple de 160 en décembre 2010:

Cochez Voir l'ombre de la Terre pour une simulation des éclipses lunaires.

Mode transparent (occultation) Ce mode permet de voir les étoiles derrière les planètes (utile en cas d'occultation).

Comète
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Avant d'afficher les comètes, vous devez charger dans la base de donnée de CdC le dernier fichier du MPC contenant leurs
éléments orbitaux. Vous pouvez aussi ajouter les élément orbitaux d'une nouvelle comète et effacer les entrées obsolètes de la
base de données ou toutes les informations sur les comètes.

Quatre onglets dans cette fenêtre :

Paramètres généraux où :
Vous pouvez activer ou désactiver l'affichage des comètes.
les comètes peuvent être symbolisées par un point ou comme une étoile de taille proportionnelle à la taille de leur
queue.
Vous pouvez filtrer l'affichage des comètes moins brillantes qu'une magnitude donnée. Par contre vous pouvez
afficher les comètes d'une magnitude relative donnée inférieure au minimum fixé pour les étoiles en fonction de la
plage du champ de vision.
Le bouton Réglage BD vous conduit à l'onglet Système > Système.

Charger le fichier (le premier à utiliser) :
Le bouton Télécharger descend la dernière version du fichier des éléments orbitaux du site IAU Minor Planet
Center [http://minorplanetcenter.net/] et stocke les informations dans la base de données. Le fichier source est sauvé
sous le nom COMET-yyyy-mm-dd.DAT où yyyy-mm-dd est la date de téléchargement.
à l'aide de Utiliser le fichier local accompagné de l'icône dossier, vous pouvez spécifier un fichier
COMETxxx.DAT et le charger dans la base avec le bouton Charger. Ceci est automatiquement réalisé après
téléchargement.
une fenêtre message affiche le resultat des étapes du traitement.

l'onglet Maintenance vous permet d'effacer des comètes obsolètes ou toutes les comètes de la base de données. Une
fenêtre message affiche le resultat des étapes du traitement.
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l'onglet Add vous permet d'ajouter tous les élément orbitaux d'une nouvelle comète dans la base de données.
Regarder ici sur la façon de saisir les élément orbitaux.

Astéroïde

Avant d'afficher les astéroïdes, vous devez charger dans la base de donnée de CdC les derniers fichiers du MPC contenant
leurs éléments orbitaux. Vous pouvez aussi ajouter les élément orbitaux d'un nouvel astéroïde et effacer les entrées obsolètes
de la base de données une par une ou avant un mois donné ou toutes les informations sur les astéroïdes.

Cinq onglets dans cette fenêtre :

Paramètres généraux où :
Vous pouvez activer ou désactiver l'affichage des astéroïdes.
les astéroïdes peuvent être symbolisés par un point ou comme une étoile de taille proportionnelle à leur
magnitude.
Vous pouvez filtrer l'affichage des astéroïdes moins brillants qu'une magnitude donnée. Par contre vous pouvez
afficher les astéroïdes d'une magnitude relative donnée inférieure au minimum fixé pour les étoiles en fonction de
la plage du champ de vision.
Le bouton Réglage BD vous conduit à l'onglet Système > Système.
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Charger le fichier (le premier à utiliser) :
Le bouton Télécharger descend les dernières versions des fichiers des éléments orbitaux (astéroïdes brillants,
inhabituels et distants) du site IAU Minor Planet Center [http://minorplanetcenter.net/] et stocke les informations
dans la base de données. Les fichiers source sont sauvés en un seul fichier MPCORB-yyyy-mm-dd.DAT où yyyy-
mm-dd est la date de téléchargement.
à l'aide de Utiliser le fichier local accompagné de l'icône dossier, vous pouvez spécifier un fichier
MPCORBxxx.DAT et le charger dans la base avec le bouton Charger. Ceci est automatiquement réalisé après
téléchargement.
une fenêtre message affiche le resultat des étapes du traitement.

 

l'onglet Données mensuelles permet de traiter les données d'une plage de mois. Une fenêtre message affiche le
resultat des étapes du traitement.

l'onglet Maintenance vous permet d'effacer des astéroïdes obsolètes, les astéroïdes antérieurs à un mois donné ou tous
les astéroïdes de la base de données. Une fenêtre message affiche le resultat des étapes du traitement.
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l'onglet Ajouter vous permet d'ajouter tous les élément orbitaux d'un nouvel astéroïde dans la base de données.
Regarder ici sur la façon de saisir les élément orbitaux.
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Affichage
Le réglage de l'Affichage possède neuf onglets :

Affichage
Couleurs d'affichage
Couleurs des objets du ciel profond
Couleurs du fond du ciel
Lignes
Etiquettes
Polices
Oculaires
Capteurs CCD

Affichage

Apparence des étoiles et des objets du ciel profond.

Vous pouvez afficher le contour (Mode ligne) des objets du ciel profond ou leur surface (Graphique).

Vous pouvez afficher des étoiles dessinées (Mode ligne), avec un aspect photographique simple (photographique)ou
paramétré (Paramétrique) : Dans le mode paramétrique, vous pouvez choisir la taille apparente des étoiles, leurs brillances,
leurs contrastes et la saturation de leurs couleurs. Ces paramètres existent en quatre combinaisons pré-réglées : Défaut,
Oeil nu, Couleur forte et Noir/Blanc.

Il faut normalement cocher “Dessin avec anti alias” mais vous pouvez essayer de l'enlever si vous avez des problème de
performance avec un ancien ordinateur.

Couleurs d'affichage

Dans ce menu, vous pouvez changer la couleur des lignes, grilles et objets dessinés sur la carte. Pour cela, cliquez sur la figure
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colorée sous l'étiquette correspondante.

Dans le groupe Couleur standard vous pouvez choisir un jeu de couleurs prédéfini : Défaut qui affiche les couleurs de la
carte semblables aux couleurs du ciel réèl. Rouge passe à un mode de couleurs moins adapté à la vision de nuit (nuancier de
rouge). Blanc sur noir affiche la carte en noir sur fond blanc et Noir sur blanc affiche la carte en blanc sur fond noir (les
deux derniers labels semblent permutés).

Dans les groupes Boutons par défaut et Vision de nuit vous pouvez définir la couleur des boutons des barres d'outils
quand le bouton Vision de nuit dans la barre principale est activé ou non. 

Couleurs des objets du ciel profond]

Les objets du ciel profond sont très différents les uns des autres. Dans ce dialogue, vous pouvez les couleurs des différents
types d'objets pour mieux les différencier sur la carte.

Deux modèles de couleurs prédéfinis sont disponibles, correspondant à CdC V2 ou V3.

Couleurs du fond du ciel

Dans ce dialogue vous pouvez choisir la couleur du fond de la carte. Si l'option Fixe noir est choisie dans le groupe Couleur
du ciel, le fond de la carte a toujours la même couleur (celle de Fixed sky color). Si c'est Automatique qui est choisi, Le
fond de carte varie selon les heures du jour pour marquer les crépuscules nautiques et astronomiques.

Vous pouvez modifiez la couleur fixe ou le modèle de couleurs du crépuscule en cliquant sur chaque couleur. 
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Lignes

Ici vous pouvez choisir les lignes qui seront montrées sur la carte et d'en choisir le type:

Voir les grilles de coordonnées va tracer la grille de coordonnées définies dans le menu Cartes, coordonnées - Sytème
de coordonnées. Vous pouvez ajouter la grille de coordonnées équatoriales en cochant Ajouter la grille équatoriale. Cette
grille sera très utile si votre télescope est doté d'une monture équatoriale. La signification de Voir l'écliptique et Voir
l'équateur galactique est claire. Voir les labels des grilles va montrer les valeurs en degrés (et en heures) des lignes des
grilles.

Dans quatres groupes vous pouvez choisir les possibilités suivantes :

Figure des constellations: Si Afficher les figures est coché, CDC va tracer les lignes dessinant les constellations.
Voie lactée: La case à cocher Voir la voie lactée va activer le tracé des limites de la voie lactée. Remplir la voie
lactée va remplir cette zone d'une couleur semi-transparente.
Limites des constellations: Comme indiqué, Voir les limites va activer le tracé des limites des constellations.
Mouvement propre: Chaque étoile a un mouvement propre dans la voie lactée. Vous pouvez activer le tracé de ce
mouvement propre des étoiles pour les xxx prochaines années.

Etiquettes

La case à cocher Afficher les labels contrôle toutes les étiquettes sauf les coordonnées des grilles (contrôlées par Voir les
labels des grilles dans l'onglet Lignes).

Si vous voulez afficher les informations de la carte dans la barre du menu, cochez Afficher les informations ….

Par le panneau Labels des objets vous pouvez contrôler la couleur et la taille des polices utilisées pour chaque type d'objet.
Autre label Montre les étiquettes des points cardinaux sur la ligne d'horizon.

Dans les panneaux Label des étoiles et Label des constellations vous pouvez choisir le contenu des étiquettes
correspondantes.

Difference Magnitude sont des plages (0 à 10) qui filtrent les étiquettes selon la magnitude des objets : Plus le nombre est
petit, plus on voit d'étiquettes (liaison avec les 11 intervalles de champ de vision ?) 
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Polices

Cet onglet contrôle le nom des polices utilisées par CdC. Pour modifier une police, cliquez sur l'icône Police à droite de la
ligne.

Cliquez sur le bouton Défaut pour revenir aux noms par défaut.

Oculaires

Cet onglet vous permet de définir le champ de vision (en minutes) de vos oculaires et leur position.

Rotation est l'angle (en degrés) de l'axe X, parallèle à l'équateur céleste et d'origine le centre de la carte (ce qui est la
position par défaut du centre du champ affiché), et la nouvelle position de l'oculaire.
L'angle de rotation peut également être modifié de manière interactive à partir de la carte. Vous pouvez modifier la rotation
sur la carte avec les touches fléchées du clavier. Pour l'activer utilisez Shift+C pour la caméra principale, Shift+G pour le
guide, Shift+S pour les deux a la fois.

Décalage est la distance (en minutes) entre le centre de la carte et le centre de l'oculaire. 

Le bouton Calcul ouvre un calculateur simple pour trouver le champ de vos oculaires.
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Capteurs CCD

Comme pour les oculaires, cet onglet permet de définir le champ de vision de vos capteurs CCD. Le champ est un rectangle
dont hauteur et largeur s'expriment en minutes. Il est parallèle à l'équateur celeste, au centre de la carte. Rotation et
Décalage ont la même signification que pour les oculaires.
L'angle de rotation peut également être modifié de manière interactive à partir de la carte. Vous pouvez modifier la rotation
sur la carte avec les touches fléchées du clavier. Pour l'activer utilisez Shift+C pour la caméra principale, Shift+G pour le
guide, Shift+S pour les deux a la fois.

Le bouton Calcul ouvre un calculateur simple pour trouver le champ de votre caméra.
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Images
Il ya deux endroits où sont gérées les images fit :

répertoire d'installation data\pictures\sac\ qui contient les images des objets du catalogue SAC.
répertoire utilisateur pictures\ Qui est utilisé pour stocker les images téléchargées de DSS ou les images temporaires
de RealSky.

Images des catalogues

D'abord vous devez balayer le répertoire des images du catalogue SAC pour charger leurs caractéristiques dans la base de
données de CdC. Un chemin différent peut être spécifié dans la zone d'entrée (aidez vous avec l'icône répertoire).
Notez qu'il ne s'agit pas du répertoire contenant les fichiers fits, mais celui juste au dessus. C'est pour permettre l'installation
d'images pour d'autres catalogue dans des répertoires séparés.

Quand le balayage est fini, un message est affiché : Il y a xxxx images cataloguées (9894 dans la V3 beta 0.1.4). Si il reste avec
0 image relisez le paragraphe précédent.

Vous pouvez régler la luminosité et le contraste des images et vous devez cocher la case “Voir le images sur la carte” en bas
de la fenêtre. 

Arrière-plan

Ici vous pouvez spécifier l'affichage d'une image particulière (par exemple celle sur laquelle la carte est centrée) en entrant
son nom de fichier (contenu dans le répertoire vos_documents\Carte_du_ciel\pictures par défaut).

Vous pouvez régler l'échelle de visualisation, la luminosité, le contraste et la transparence des images et vous devez cocher la
case “Voir l'image”.

DSS Realsky
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Si vous êtes connecté à Internet, vous pouvez télécharger les images DSS. Vous spécifiez ici le jeu d'images DSS que vous
désirez.

La section suivante concerne l'archivage des images téléchargées. Vous pouvez indiquer le répertoire d'archive ainsi que si
vous voulez un message de confirmation avant d'archiver une image.

Ici vous pouvez préciser l'endroit où est implanté RealSky dans votre PC.
Vous devez spécifier le jeu de CD utilisé, où sont les fichiers auxiliaires, le nom de votre lecteur de CD et où peuvent être
stockés les fichiers temporaires.
Vous pouvez demander à pouvoir choisir dans une liste de plaques et limiter la taille des images.

Archive des images

Vous pouvez sélectionner ici le mode d'affichage des images d'archives.
Seule les images au format FITS [http://fits.gsfc.nasa.gov/fits_home.html] qui contiennent des informations WCS
[http://fits.gsfc.nasa.gov/fits_wcs.html] sont éligibles pour une utilisation ici.Il existe de nombreux logiciels qui vous permettent
de lancer une réduction astrométrique sur vos images, et également des solutions en ligne [http://nova.astrometry.net].

La liste peut contenir jusqu'à dix répertoire où le programme va rechercher des images à afficher sur la carte.

Sélectionnez dans la première colonne si vous voulez que ce répertoire soit actif.

La deuxième colonne est le répertoire lui-même. Assurez-vous de toujours inclure le répertoire que vous sélectionnez pour
l'archivage automatique des images DSS téléchargées.

La dernière colonne indique le nombre d'images dans la base de données du programme. Si vous avez ajouté des images
manuellement dans un répertoire vous devez cliquer sur le bouton “Parcourir les archives” pour mettre à jour la base de
données avec les nouveaux fichiers.

109



Vous pouvez choisir si vous voulez afficher les images sur la carte et si vous voulez une étiquette avec le nom du fichier
d'image.
Vous pouvez également sélectionner le nombre maximum d'images le programme affichera sur la carte. Méfiez-vous des
problèmes de performances si vous sélectionnez une valeur trop élevée.
Vous pouvez utiliser la fenêtre liste d'image à partir d'un clic droit sur la carte pour modifier ce paramètre ainsi que pour
sélectionner d'autres images que celles choisies automatiquement par le programme.
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Liste des images

Utilisez le menu du clic droit sur la carte pour ouvrir cette fenêtre.

La liste d'images permet de voir et modifier quelles images sont affichées sur la carte.
Cela comprend la dernière image DSS téléchargée, ou les images de vos Archives.

Vous pouvez choisir quelles images utiliser par une sélection dans la première colonne. Cette sélection reste valable tant que
la position ou le champ de la carte n'est pas modifié. Cliquez OK après avoir terminer la sélection.

Vous pouvez aussi afficher l'en-tête FITS du fichier sélectionné ou ouvrir la configuration des Archives.

Si vous êtes connecté à un hub SAMP vous pouvez envoyer l'image sélectionnée à un autre client SAMP.
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Général

Général

Dans cette fenêtre, vous gérez la base de données CdC. Celle-ci contient les éléments orbitaux des comètes et des astéroïdes,
les informations sur les images du catalogue SAC, les informations sur les images DSS/RealSky et celles sur la localisation des
observatoires.
Après l'installation, vous devez créer les éléments orbitaux des comètes et des astéroïdes (voir les onglets comete et asteroide
de la fenêtre Configuration > Système solaire).
De même, vous devez créer les informations sur les images SAC (voir l'onglet Objet de la fenêtre Configuration > Images).
Des informations détaillées sur la localisation des observatoires peuvent être enregistrées dans la base, pays par pays à partir
de l'onglet Configuration > Observatoire

L'installation standard CdC créé une base de données SQLite, mais vous pouvez choisir entre les SGBD SQLite et MySQL (par
exemple pour la partager sur un réseau local).

SQLite : Une zone d'entrée contient le chemin vers la base de données SQLite, par défaut elle est stockée dans le
répertoire Vos_Documents\Cartes du Ciel\database\. Vous pouvez spécifier ici une autre localisation.

MySQL : Vous avez besoin d'un serveur MySQL auquel vous connecter. L'installation propose une connection à un
serveur local qui fonctionne bien avec une installation de serveur MySQL locale (WAMP, EazyPHP…). Vous pouvez
spécifier une alternative à la connection par défaut dont les paramètres sont :

Nom BD cdc
Serveur localhost
Utilisateur root
Mot de passe empty area
Port 3306 (standard MySQL port)

Le bouton Création BD lance le script SQL de définition des tables.
Le bouton Contrôle vous permet de vérifier la création des tables.
Le bouton Config. asteroïdes vous dirige vers l'onglet Configuration > Système solaire > Asteroïde
Le bouton Config. Comètes vous dirige vers l'onglet Configuration > Système solaire > Comète
Le bouton Détruire la BD efface le contenu de la base de données.
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Répertoire Spécifie le chemin d'installation de CdC et le chemin vers le répertoire de vos données personnelles
(Vos_Documents\Carte du Ciel\). Vous pouvez spécifier d'autres répertoires dans le cas d'une installation non standard (Aidez
vous de l'icône répertoire à droite de la zone d'entrée).

Serveur

Ici se règlent les paramètres de connexion de CdC en temps que serveur afin de recevoir des commandes depuis un autre
programme.
Vous pouvez vérifier l'état de ces connexions dans Voir > Information sur le serveur

CdC accepte les connexions en cochant Utiliser le serveur.
CdC Verifie la présence des clients et ferme les connexions s'ils ne sont plus actifs en cochant Garde la connexion
client.
Pour les clients distants, vous précisez l'adresse IP de CdC dans Interface réseau.
CdC écoute sur le port indiqué dans Port, si vous le changez, vous devez aussi le changer dans les applications clientes.

Si vous voulez vous connecter avec votre propre programme consultez la liste des commandes disponibles

Télescope

Avant de pouvoir utiliser Cartes du Ciel avec votre télescope, vous devez faire quelques réglages de base ici. Tout d'abord,
sélectionnez l'interface que vous allez utiliser. Selon votre choix, le contenu des boîtes de dialogue change. Vous pouvez
choisir parmi:

ASCOM

L'utiliser sur Windows uniquement. Avec ASCOM vous pouvez piloter la plupart des équipements astronomiques comme votre
dôme ou votre caméra. Si vous n'avez pas le pilote Ascom installé, vous pouvez le télécharger à partir de http://ascom-
standards.org/ [http://ascom-standards.org/] 

Pilote Indi

Utilisez le sous Linux ou Mac. Indi [http://indilib.org] est conçu pour utiliser avec toutes sortes d'appareils astronomiques.
Beaucoup de monture, camera et dômes peuvent être piloté avec Indi. Vous pouvez le télécharger [http://indilib.org/download]
si il n'est pas déjà installé avec votre distribution Linux. Pour utiliser le driver faite votre choix dans le dialogue spécifique.

Monture manuelle

Lorsque vous utilisez cet interface, Cartes du Ciel vous demande de donner les paramètres de votre monture. Choisissez votre
type de monture: Équatorial ou Alt/Az. Ensuite, vous définissez le nombre de tours complet, vous devez faire sur votre
bouton pour avancer votre monture d'un degré d'arc. Habituellement, les montures manuelles sont à vis sans fin, Le plus
courant est un montage avec 144 dents sur la roue à vis sans fin pour les deux directions. Si vous connaissez le nombre de
dents, le calcul du nombre de tours par degré d'arc, ou par heure est facile: 
Par degré: 144 / 360 = 0.4 
Par heure: 144 / 24 = 6

Vous devez cocher “Retourner la vis” seulement si un tour du bouton dans le sens antihoraire cause une augmentation de
l’ascension droite, azimut, déclinaison, ou altitude.
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A partir de maintenant, vous pouvez trouver des instructions pour tourner les boutons de votre monture pour passer d'un
objet à un autre. Pour trouver ceci, cliquez d'abord sur l'objet sur lequel votre télescope est pointé. Ensuite, cliquez sur l'objet
que vous voulez observer. Maintenant, cliquez sur l'étiquette afin de récupérer les informations détaillée.Les dernières lignes
vous montrent comment tourner les boutons sur votre monture.

Langues

Ici vous pouvez choisir la langue de l'interface graphique de CdC.

SAMP

Réglage des options par défaut pour l'interface SAMP.

Essayer de se connecter : Se connecter automatiquement à un hub SAMP en cours d'exécution lorsque le
programme démarre.
Recevoir les coordonnées : Autoriser le programme à sauter aux coordonnées reçues d'autres applications. Par
exemple, un clic dans Aladin.
Recevoir des images FITS : Autoriser le programme à recevoir une image à partir d'autres applications. Depuis
Aladin utiliser le menu “Interop / Broadcast selected image to…”
Recevoir des tables VO : Autoriser le programme à recevoir des tables de données depuis d'autres applications.
Depuis Aladin utiliser le menu “Interop / Broadcast selected table to…”.

Vous pouvez demander une confirmation avant d'accepter les données et conserver les données que vous recevez pour une
utilisation hors connexion. La valeur par défaut est d'effacer les données lorsque la connexion SAMP est fermée.

Il est également possible d'envoyer des données à partir de Cartes du Ciel aux autres applications.

Pour vous connecter à un hub après le démarrage du programme, ou d'obtenir le statut de connexion, utilisez le menu
Fichier -> SAMP.
Pour envoyer les coordonnées, utilisez le menu du clic droit SAMP envoyer les coordonnées
Vous pouvez envoyer des tables de donnée depuis le réglage des catalogues Catalogue VO.
Pour envoyer une image FITS utiliser le menu clic droit Liste des images, puis le bouton “Envoyer l'image”.
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Interface ASCOM
depuis le menu: Télescope

Cette interface peut être utilisée avec n'importe quel télescope supporté par la plate-forme ASCOM. Il ne fonctionne que sur
Windows. Veuillez vous référer à http://ascom-standards.org [http://ascom-standards.org] pour obtenir la dernière version du
pilote et pour plus d'informations.

Ensuite, utilisez Configuration → Général → Télescope pour sélectionner l'interface Ascom puis ouvrez le panneau de
configuration.

Pour la première utilisation, vous devez Sélectionner le pilote à utiliser et fournir des informations de configuration en
fonction du télescope que vous utilisez.

Le bouton Paramètres avancés ouvrir une fenêtre avec les paramètres que vous avez normalement pas besoin de changer.
En ce moment, c'est utiliser pour forcer l'équinoxe du système équatorial quand il est mal signalé par un pilote.

Puis cliquez sur le “Bouton de connexion”, la couleur doit changer au vert et les coordonnées du télescope sont affichées.

Vous pouvez maintenant définir les coordonnées géographiques et l'heure du télescope en utilisant les valeurs de votre
ordinateur. Mais ce n'est normalement pas nécessaire puisque votre télescope doit être déjà aligné avant de vous connecter.

Pour libérer de l'espace sur l'écran, vous pouvez fermer la fenêtre de l'interface en cliquant sur le bouton “Masquer”.

Reportez-vous au menu principal Télescope pour apprendre à suivre la position du télescope sur la carte ou d'utiliser la
fonction Goto si votre télescope le permet.

Aussi, si supporté vous pouvez affiner la précision de pointage locale en utilisant la fonction “Sync” sur une étoile proche à
tout moment.

Les options de configuration sont sauvegardés lorsque vous masquez la fenêtre. Enregistrer également les options par défaut
dans le menu de CdC de garder votre choix d'interface.
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Interface de télescope INDI
depuis le menu: Télescope

La configuration du pilote de télescope s'effectue à partir du menu Configuration -> Général -> Télescope

Cliquez sur le “Bouton de connexion”, la couleur doit changer au vert et les coordonnées du télescope sont affichées.
En cas de problème de connexion, vous pouvez consulter les messages au bas de la fenêtre.

Pour libérer de l'espace sur l'écran, vous pouvez fermer la fenêtre de l'interface en cliquant sur le bouton “Masquer”.
Reportez-vous au menu principal Télescope apprendre à suivre la position du télescope sur la carte ou d'utiliser la fonction
Goto si votre télescope le permet.

Aussi, si supporté vous pouvez affiner la précision de pointage locale en utilisant la fonction “Sync” sur une étoile proche à
tout moment.
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Internet

Proxy

Proxy HTTP

Si vous êtes connecté à Internet à travers un proxy, CdC a besoin de connaître les paramètres de connexion.
Ces paramètres sont :

Serveur Proxy adresse IP ou nom symbolique du proxy.
Port numéro de port utilisé pour communiquer avec le proxy.
Utilisateur Nom utilisé pour se connecter au proxy.
Mot de passe mot de passe utilisé pour se connecter au proxy.

Par défaut, on n'utilise pas de proxy et il n'y a aucun paramètre à entrer.

FTP est utilisé par Cdc pour télécharger les grands fichiers du MPC, une connexion anonyme avec un mot de passe
contenant “@” est nécessaire.

Elements d'orbites

On trouve ici les URLs du site MPC utilisés pour télécharger les éléments orbitaux des comètes et des asteroïdes.

La zone d'entrée supérieure contient les URLs pour les comètes, vous pouvez choisir le protocole de téléchargement :

MCP Http montre l'URL pour téléchargement par HTTP de site MPC.
Défaut est la même chose que HTTP.

Il n'y a pas de site miroir disponible actuellement.

La zone d'entrée inférieure montre les URLs de MPC utilisés pour les asteroïdes, Vous pouvez choisir les fichiers d'éléments
orbitaux par quatre boutons :

Premier 5000 pour un choix de 5000 asteroïdes (Fichier téléchargé à partir du Site CdC)
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Premier 5000 + NEO + TNO pour les trois listes (brillants, inhabituels et distants) du MPC.
MPCORB > 70MB! pour le fichier complet (plus de 700 000 asteroïdes), attention que cela peut ralentir l'affichage.
Défaut est la même chose que Premier 5000.

Images DSS

On trouve ici les URLs du Site DSS utilisés pour télécharger les images DSS.

Chaque ligne de la liste a une étiquette et un URL correspondant à un jeu d'images DSS (voir le Site DSS
[http://archive.eso.org/cms/catalogs-dss] pour les détails).

Les étiquettes sont utilisées quand vous demandez le téléchargement des images DSS à l'aide du bouton DSS de la barre
d'outils “objet”.

Vous pouvez ajouter des lignes (uniquement pour utilisateurs avertis!).

Satellites artificiels

On trouve ici les URLs de téléchargement des fichiers TLE.

Vous pouvez spécifier des fichiers TLE avec une extension de .tle ou .txt, ou un .zip contenant l'un de ces fichiers.

Cliquer un des bouton pour choisir une liste d'URL des sites suivants:
http://celestrak.com [http://celestrak.com] 
http://www.tle.info [http://www.tle.info] 

Conserver le fichier qsmag.zip pour la mise à jour de l'estimation de luminosité des satellites.

Le bouton Manuel efface la liste et dans ce cas la fonction de mise à jour vous redirige sur le site https: ​www.space-track.org

comme dans les versions précédentes. 
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Labels

Labels CdC

Vous configurez les labels de la carte par Configuration du programme > Affichage > Labels Vous pouvez modifier la police,
sa taille, sa couleur et les types d'objets à étiqueter. Vous pouvez choisir le contenu des étiquettes d'étoiles et de
constellations.

Modification des labels

Vous devez passer en “Modification labels” par l'icône  de la barre d'outil “objet”. 

Ensuite, quand vous faites un clic droit sur une étiquette, un menu contextuel apparaît avec ces entrées :

Move labels le curseur devient une croix et drague l'étiquette jusqu'à ce un clic gauche fixe l'étiquette à l'endroit que
vous avez choisi.

Edit labels Une fenêtre apparait et vous pouvez entrer un nouveau texte pour l'étiquette.
Default label restaure l'étiquette d'origine et son emplacement.
Hide label efface l'étiquette.
Reset All labels annule toutes les modifications d'étiquettes.

Ajout de labels utilisateur

Dans le menu contextuel obtenu par un clic droit sur un objet, vous pouvez gérer les étiquettes utilisateur (voir Menu

contextuel ).  

L'entrée “New label” ouvre une fenêtre “Ajout d'un label” :

Label zone d'entrée du texte de l'étiquette.
Type combo-box pour choisir le type d'objet à étiqueter.
Alignement groupe de boutons-radio pour positionner l'étiquette par rapport à l'objet.
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Recherche avancée

Cette fonction est accessible dans la barre principale (icône  ).

Vous devez choisir le type d'objet, puis entrer son identifiant dans la zone d'entrée en bas.

Quelques boutons à droite de cette zone vous aident à entrer l'identifiant du catalogue puis l'identifiant de l'objet.

Si l'objet est trouvé, il est placé au centre de la carte.
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Position

On ouvre cette fenêtre en cliquant sur l'icône  de la barre d'outils principale.

Elle fournit un moyen aisé et rapide de donner les coordonnée du centre de la carte.

Les coordonnées peuvent être données en Ascension droite - Déclinaison ou en Azimuth - Hauteur. La conversion est
automatique.

Vous pouvez aussi fixer un champ de vision plus précis (à la seconde près) et une rotation au degré près de la carte.
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Liste d'observation
Il s'agit d'une liste d'observation simple qui permet de préparer à l'avance une liste d'objets à observer.
Vous pouvez filtrer les objets visibles à partir de quelques critères, trier la liste sur une colonne, passer à l'objet suivant ou
précédent.

Utilisez le bouton Tour pour démarrer un tour d'observation des objets sélectionnés et pointer le télescope.

Vous pouvez commencer avec une liste vide et ajouter des objets avec le menu clic droit de la carte.

Ou vous pouvez créer un fichier avec une ligne de titre suivie d'un nom d'objet sur chaque ligne, comme dans cet exemple de
liste Messier [http://www.ap-i.net/pub/skychart/catalogues/messier.txt]. Plusieurs logiciel de planification d'observation
permettent de créer un fichier dans ce format. 
Les coordonnées seront ajoutée la première fois que le fichier est chargé.

N'oubliez pas d’enregistrer vos modifications.
Le bouton Effacer permet de commencer une nouvelle liste vide avec le nom par défaut.
Le bouton “Mise à jour des coordonnées” recharge les coordonnées à partir des catalogues de Cartes du Ciel.

Les objets de la liste peuvent avoir un label spécifique sur la carte pour les distinguer, cochez “Marquer les objets sur la
carte” pour cela. 
L'autre coche “Toujours voir les objets de la liste” est à être utilisé dans des cas particulier, si les objets sont très faibles et
que vous voulez les voir sur carte à grande échelle. Attention que cette option peut dégrader sérieusement les performances.

Les colonnes AR et DEC sont les coordonnes de l'objet obtenu dans les catalogues. Les unités sont en degré pour les deux.

Vous pouvez entrer un texte libre dans la colonne Description. Par exemple, l'heure d'observation pendant votre marathon
Messier.

Les heures de début et fin sont calculée selon les filtres de sélection.

Vous pouvez faire une sélection basée sur l'heure de transit.

Dans ce cas indiquez le côté du méridien (important pour éviter de retourner une monture allemande) ainsi que l'angle
horaire limite depuis le méridien.

Choisir ensuite si vous voulez filtrer les objets qui remplissent les critères durant la nuit, c'est utile pour la planification. Ou
filtrer les objets qui remplissent les critères maintenant, c'est utile pendant la session d'observation.
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Vous pouvez aussi faire une sélection basée sur l'altitude minimale de l'objet, ou sa masse d'air maximale.

Dans ce cas choisir la masse d'air maximale que vos observations peuvent supporter ou choisir “Horizon” si une simple
détection près de l'horizon est acceptable.

Choisir ensuite si vous voulez filtrer les objets qui remplissent les critères durant la nuit, c'est utile pour la planification. Ou
filtrer les objets qui remplissent les critères maintenant, c'est utile pendant la session d'observation.

Vous pouvez trier la liste par heure de fin pour connaître les objets à observer en priorité. Notez que l'heure est indiquée de
midi à midi pour assurer la continuité en cours de nuit.

Cliquez sur le numéro de ligne pour centrer un objet sur la carte.
Un clic droit sur une ligne ouvre un menu avec les options suivantes:

Voir sur la carte
Mise à jour des coordonnées
Supprimer

Cliquez le bouton “Enregistrer” pour sauvegarder le contenu de la liste d'observation.

Pour enregistrer les sélection et autres option, utiliser l'enregistrement de la configuration du programme principal depuis le
menu Configuration → Enregistrer la configuration.

Il est possible d'automatiser les fonctions de la liste d'observation en utilisant les commandes du serveur. Un script d'exemple
qui pointe le télescope sur chaque objet visible en séquence est disponible ici:
http://sourceforge.net/p/skychart/code/HEAD/tree/trunk/skychart/sample_client/python/
[http://sourceforge.net/p/skychart/code/HEAD/tree/trunk/skychart/sample_client/python/]
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Tour d'observation
Cette fonction vous permet de parcourir votre liste d'observation séquentiellement et de déplacer le télescope vers les
différents objets. 
Si vous voulez pointer le télescope vers les objets, vous devez vous assurer d'utiliser les fonctions de sélection de la liste
d'observation pour ne conserver que des objets observable en ce moment.

Vous pouvez utiliser les boutons pour naviguer dans la liste ou les raccourcis clavier suivant:

Touche Fonction

F, Home Premier objet

L, End Dernier objet

N, Right, Down, PageDown Objet suivant

P, Left, PageUp Objet précédent

Ctrl+S, Tab Goto

I Identifie l'objet courant

Si vous cochez Activer la voix le programme dit aussi le nom de l'objet sur le haut-parleur de l'ordinateur afin que vous
puissiez utiliser cette fonction sans regarder l'écran, vous pouvez même éteindre l'écran, pour préserver votre vision
nocturne

Cette fenêtre est configurée pour rester au-dessus des autres afin de maximiser la chance qu'il obtienne votre pression de
touche. Mais il peut aussi perdre le focus si une autre application le prend, dans ce cas, vous devrez peut-être alimenter
l'écran pour cliquer sur la fenêtre Tour pour obtenir le focus à nouveau.

Appuyez sur la touche Fin lorsque vous avez terminé et souhaitez revenir au programme principal.
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Interface SAMP de l'Observatoire virtuel
SAMP [http://www.ivoa.net/samp/] est un protocole de message, une partie de l'Observatoire Virtuel, qui permet aux logiciels
d'astronomie [http://wiki.ivoa.net/twiki/bin/view/IVOA/SampSoftware] d'interagir et communiquer. Cartes du Ciel peut se
connecter à d'autres logiciels et envoyer ou recevoir des coordonnées, des images FITS et des tables VO ou des sélections.
Des logiciels très utile à utiliser avec Skychart sont Topcat [http://www.star.bris.ac.uk/~mbt/topcat/] et Aladin [http://aladin.u-
strasbg.fr/aladin.gml].

Cartes du Ciel n'inclut pas la partie hub, vous devez vous connecter à un autre logiciel qui comprend cette partie.

Initialisation

Pour utiliser SAMP avec Cartes du Ciel vous devez configurer quelques options depuis le menu Configuration -> Général ->
SAMP. Cela inclut comment se connecter au hub, quelles fonctions accepter, et comment conserver les données après la
fermeture du programme.

Si vous choisissez de ne pas connecter automatiquement ou si le hub n'est pas lancé avant Cartes du Ciel, vous devez vous
connecter depuis le menu Fichier -> SAMP.

Depuis le même menu vous pouvez connaître l'état de la connexion ainsi que la liste des clients.

Messages envoyé

Pour ces fonctions vous avez le choix d'envoyer le message à tous les clients ou de choisir un client particulier dans une liste.

Coordonnées

Pour envoyer les coordonnées utiliser le menu du bouton droit de la souris SAMP envoi des coordonnées.

Table de donnée

Vous pouvez envoyer une table VO que vous avez obtenu depuis le catalogue de l'observatoire virtuel. Seul le format VOtable
est supporté.

Sélection de table

Lorsque vous cliquez sur un objet qui fait partie d'une table partagée, l'objet sélectionné est envoyé comme sélection. Cela est
limité à une sélection d'une seule ligne.

Image

Pour envoyer une image FITS utiliser le menu du bouton droit de la souris Liste des images, puis le bouton “Envoi de l'image
à”.

Messages reçus

Rappelez-vous que vous pouvez configurer les messages que vous voulez recevoir ainsi que si un message de confirmation est
nécessaire avec d’exécuter une action.
Vous pouvez également choisir de conserver ou non les données quand le programme est fermé. Cela permet de faire par
exemple une sélection complexe dans Topcat, puis de conserver ces données pour les utiliser au télescope.

Coordonnées

Centre la carte sur les coordonnées reçues et cherche si un objet se trouve à cette position.
Si un objet est trouvé vous pouvez utiliser toutes les fonctions disponibles dans ce cas: voir les informations détaillée, déplacer
le télescope, …

Table de donnée
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Ajoute la table aux catalogues de l'observatoire virtuel et affiche ces objets sur la carte. Seul le format VOtable est supporté.
Vous pouvez changer les symboles, la couleurs ou le choix de colonnes avec le bouton “Mise à jour” en dessous de la liste.

Sélection de table

Marque les objets sélectionnés en vert sur la carte.

Image

Affiche l'image et centre la carte de la même façon qu'avec l'affichage DSS. Seul le format FITS est supporté.

Exemple

Nous voulons afficher une carte des super-géantes de l'amas des Hyades en utilisant les données du catalogue XHIP. Si vous
savez déjà comment utiliser Topcat vous pouvez sauter aux trois dernières étapes.

Nous utilisons Topcat pour obtenir les données. Lancez Topcat et Cartes du Ciel, connectez Cartes du Ciel au hub.

Dans Cartes du Ciel faire une carte de 20° de large centrée sur les Hyades.

Dans Topcat utilisez le menu VO → Vizier catalog service. Object name: hyades, cliquez Resolve, entrez 10 pour “radius
(degrees)”.
Pour “Output columns” choisir “all”.
Pour “Catalog selection”, cliquez “By keyword”, pour “Keyword” entrer XHIP, cliquez Search catalogues, choisir “V/137D”
dans la liste, cliquez OK.

Envoie de la table à Cartes du Ciel: choisir la table principale V_137D_XHIP dans Topcat, ouvrir le menu Interop → Send table
to .. skychart.

Créer le diagramme Hertzsprung–Russell dans Topcat: ouvrir le menu Graphics → Plot, choisir Table=V_137D_XHIP, X
Axis=B-V, YAxis=VMag (pas Vmag!), cliquez Flip pour Y Axis.

Faire une sélection de la branche des géantes rouge.
Depuis le menu du graphique choisir Subset → Draw subset region, puis entourer la branche des super-géantes avec la souris.
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Depuis le menu du graphique choisir Subset → Finish drawing region. Donnez un nom à la sélection: “super-giant”, choisir
“skychart” et cliquez “Transmit Subset”.

Cela marque en vert toutes les super-géantes sur la carte, avec les autres étoiles de XHIP en rouge.

Cliquez sur Aldébaran dans Cartes du Ciel, cela envoie une ligne de sélection à Topcat. Il met en évidence la position
d'Aldébaran dans le diagramme HR et dans l'afficheur de table.

Après avoir terminé avec cet exemple, vous pouvez explorer les fonctionnalité puissante que Topcat peut offrir pour produire
le catalogue idéal pour les données dont vous avez besoin. Commencez par les autres options dans le menu VO et essayez
également les jointures pour fusionner les données de plusieurs tables.
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CATGEN
Les fichiers de catalogues qui contiennent les données pour n'importe quel objet céleste sont disponible par millier depuis les
sites web du CDS [http://cdsweb.u-strasbg.fr/cats/Cats.htx] ou de l'ADC [http://adc.gsfc.nasa.gov/] , ou depuis d'autres
sources. Chacun contient des informations sur quelques dizaines ou jusqu'à plusieurs millions d'objets.

Le but de ce programme est de préparer un catalogue sous forme de fichier texte pour l'utiliser avec le programme Cartes du
Ciel.
Du fait du grand nombre de données disponible actuellement il est impossible de faire un choix valable pour toutes les
utilisations, il vaut mieux que chacun puisse assembler les données qui conviennent le mieux à ses intérêts à partir des
catalogues originaux des professionnels. Un autre avantage est de pouvoir disposer rapidement des données dès qu'elles sont
publiées.

Un catalogue préparé sous un format binaire avec cet utilitaire est bien plus performant que d'utiliser directement le fichier
texte comme catalogue externe.

Il s'agit de simples fichiers textes dont chaque ligne représente un objet et dont les différentes données sont identifiées par
leur colonne et leur longueur comme ci-dessous :

 1          BD+44 4550      3 36042          46           000001.1+444022000509.9+451345114.44

 2          BD-01 4525      6128569                       235956.2-010330000503.8-003011 98.33

 3 33    PscBD-06 6357     281285721002I         Var?     000013.0-061601000520.1-054227 93.75

 4 86    PegBD+12 5063     87 917012004                   000033.8+125023000542.0+132346106.19

En général un fichier d'accompagnement (Readme) décrit le format du fichier avec beaucoup de détails. Des informations sur
ce fichier sont disponibles ici [http://vizier.u-strasbg.fr/doc/catstd.htx] .

  Byte-by-byte Description of file: catalog.dat

  --------------------------------------------------------------------------------

     Bytes Format  Units     Label      Explanations

  --------------------------------------------------------------------------------

     1-  4  I4     ---       HR         [1/9110]+ Harvard Revised Number = Bright Star Number

     5- 14  A10    ---       Name       Name, generally Bayer and/or Flamsteed name

    15- 25  A11    ---       DM         Durchmusterung Identification (zone in bytes 17-19)

    26- 31  I6     ---       HD         [1/225300]? Henry Draper Catalog Number

Il est important de se familiariser avec ce fichier avant de vouloir utiliser le catalogue, il faut faire attention à plusieurs détails:
unités, valeurs limites (entre parenthèses carrées), format des nombres, identifiant, format et époque des coordonnées. Un
point d'interrogation indique que cette donnée n'est pas toujours présente, il faut regarder dans le fichier de donnée pour
avoir une idée de sa fréquence. N'oubliez pas de lire les notes le cas échéant. Un éditeur de texte capable de lire des grand
fichiers (comme Notepad++ [http://notepad-plus-plus.org/] ) est très utile.

Si les données sont disponibles seulement sous un autre format il est généralement facile d'écrire un simple programme pour
les extraire et les formater, un langage de script comme Perl est très utile pour cela. Pour manipuler les fichiers CSV il y a le
très bon CSVdb [http://home.hccnet.nl/s.j.francke/csvdb/csvdb.zip] , Calc inclut avec OpenOffice.org
[http://www.openoffice.org/] a aussi des possibilités.

Il vous faut choisir quelles données inclure dans votre catalogue. Pour chaque type de catalogue il y a un nombre minimal
d'information qui sont requise pour dessiner les cartes, mais vous pouvez choisir d'en ajouter d'autres qui seront affichée en
cliquant sur l'objet.

Il ne faut pas oublier que plus d'information sont ajoutée, plus la taille des fichiers sur le disque de l'ordinateur sera
important.
Ce n'est donc pas forcément une bonne idée de vouloir inclure toutes les informations disponibles, prenez votre temps pour
déterminer ce dont vous avez besoin. Il est toujours possible de faire une version complète pour l'ordinateur principal et une
autre version plus compacte pour l'ordinateur portable qui à un disque plus petit.

Structure de CATGEN

CATGEN a quatre étapes et une page pour chacune :

Page 1 Choisir le fichier d'entrée, le nom du catalogue et son type
Page 2 Régler des paramètres généraux selon le type de catalogue
Page 3 Choisir les données du fichier d'entrée à inclure dans le catalogue
Page 4 Régler les options du catalogue et le construire

A chaque étape, les paramètres peuvent être sauvés dans un fichier “.prj”, ainsi vous pouvez interrompre la construction du
catalogue et la reprendre plus tard après restauration des paramètres.
Deux boutons en bas de chaque page gèrent cette fonction :

Enregistrer permet de créer (s'il n'existe pas encore) le fichier “xxx.prj” (xxx = nom court du catalogue).
Charger restaure le fichier “.prj” de votre choix et rempli les paramètres.

Page 1
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Sur la première page il faut indiquer le type d'objet dans le catalogue, cela permet d'activer des options spécifiques pour les
pages suivantes. Vous avez le choix entre étoiles, étoiles variables, étoiles doubles, nébuleuses, contours de nébuleuses.

Nom court du catalogue est le nom utilisé pour identifier le catalogue, préfixer le nom des objets sur la carte, nommer les
fichiers du catalogue. Il doit avoir de 1 à 4 caractères de long.

Nom long du catalogue est le nom complet du catalogue.

Cliquez sur le bouton pour choisir le fichier du catalogue. Souvent les gros catalogues sont découpés en plusieurs fichiers,
dans ce cas il faut choisir tous les fichiers en même temps, l'ordre des fichiers n'a pas d'importance.

Choisir le Type du catalogue de sortie. Avec CdC V3, vous pouvez choisir une sortie sous forme de fichier texte pour les
petits catalogues. Dans ce cas Catgen va uniquement créer un fichier de description des données et le programme accédera
chaque fois le fichier texte original. De cette façon vous pouvez facilement mettre les données à jour et cela sera visible
immédiatement dans le programme sans avoir a revenir dans Catgen.

Si vous avez choisi “Fichier texte” vous pouvez également utiliser une URL de mise à jour qui pointe vers la dernière version
du fichier sur Internet. De cette vous pouvez mettre les données à jours en un seul clic depuis la configuration des catalogues.

Appuyez sur le bouton Suivant » pour passer à la page suivante. 

Page 2

Choisir le format des coordonnées en entrée :

Options AD Heures, minutes, secondes ou heures décimales or degrés, minutes, secondes ou degrés décimaux.
Options DEC Degrés, minutes, secondes ou degrés décimaux ou distance au Pôle Sud.

Equinoxeest l'époque des coordonnées pour la précession. Utilisez 2000 pour ICRS.
Epoque de la positionest l'époque par défaut de la position relative au mouvement propre, cette date peut être changée
pour chaque objet à partir des données du catalogue.
Magnitude maximum est la magnitude de l'objet le plus faible du catalogue. C'est particulièrement important pour les
étoiles afin de pouvoir utiliser une échelle de magnitude correcte sur la carte.

La seconde partie dépend du type du catalogue, elle est vide pour les étoiles, l'image ci-contre présente les options pour le
type “Nébuleuses” (tous objets du ciel profond) :
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Dimension et Unités dimension par défaut (en cas de données manquantes) et unité.
Echelle logarithmique cochez si la taille est un flux, par exemple dans un catalogue de radio-sources.
Modifier les types d'objets (voir ci-dessous) redéfini les codes de types d'objets (chaînes de caractères séparées par
des virgules). Cliquez sur “Retour” quand vous êtes prêts.
Modifier les Unités (voir ci-dessous) redéfini les codes d'unités (chaînes de caractères séparées par des virgules).
Cliquez sur “Retour” quand vous êtes prêts.

 

Contours de Nébuleuses

Type de tracé (utilisé pour relier les points de la liste) :
Lignes : droites
Spline : courbes splines
Surface : remplir la surface avec la couleur de ligne

Contour fermé force à relier le dernier point du tracé au premier.
Epaisseur Line auto-explicatif (en pixels)
Couleur de ligne ou de surface (cliquer dessus pour la changer)
Modifier l'action (voir ci-dessous) redéfini les codes d'opérations de tracé (chaînes de caractères séparées par des
virgules). Cliquez sur “Retour” quand vous êtes prêts.
Modifier la couleur (voir ci-dessous) redéfini les codes couleur de tracé (chaînes de caractères séparées par des
virgules). Cliquez sur “Retour” quand vous êtes prêts.

 

Appuyez sur le bouton Suivant » pour passer à la page suivante.

Page 3
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Cette page vous permet d'établir la correspondance entre les données du fichier d'entrée et celles de votre catalogue. La liste
montre les différent champs qui dépendent du type de catalogue choisit à la première page.
Cochez chaque champ que vous voulez inclure dans votre catalogue et définissez la position sur la ligne d'exemple.
Les champs obligatoires sont dans des parenthèses carrées “[]”, les unités requises sont indiquées entre parenthèse “()”. Voir
le bouton “Advanced” ci-dessous si il est nécessaire d'ajuster les unités.

Label sera l'étiquette affichée pour ce champ.
Premier caractère et Longueur sont la position et la longueur du champ d'entrée. Vous pouvez saisir la valeur ici (obtenue
du fichier Readme) ou marquer la position avec la souris sur la ligne d'exemple. Dans ce dernier cas il faut s'assurer que le
champ marqué est suffisant pour la plus longue donnée du catalogue.

Liste des champs selon le type de catalogue :

Champs obligatoires :

Etoiles Etoiles variables Etoiles doubles Nebuleuses Contour de nébuleuses

RA RA RA RA RA

DEC DEC DEC DEC DEC

Magnitude (V) Magn. comp. 1 Line operation

Separation

Champs utilisés pour dessiner les cartes :

Etoiles Etoiles variables Etoiles doubles Nebuleuses Contour de nébuleuses

Catalog ID Catalog ID Catalog ID Catalog ID Catalog ID

B-V Magnitude Max. Position angle Nebula type Line width

Proper motion RA Magnitude Min. Magnitude Line color

Proper motion DEC Magnitude code Surface brightness Drawing type

Position Epoch Largest dimension

Magnitude B Smallest dimension

Dimension unit

Position angle

Champs utilisés pour dessiner les cartes :

Etoiles Etoiles variables Etoiles doubles Nebuleuses Contour de nébuleuses

Magnitude R Period Magn. comp. 2 Radial velocity Comment

Spectral class Variable type Epoch Morphological class String..

Parallax Maxima Epoch Component name Comment Numeric..

Comment Rise Time Spectral class comp. 1 String..

String.. Spectral class Spectral class comp. 2 Numeric..

Numeric.. Comment Comment

String.. String..

Numeric.. Numeric..
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A la fin de la liste vous trouverez dix valeurs chaîne et numérique que vous pouvez utiliser librement pour n'importe quelle
données.
Les valeurs chaînes peuvent être utilisée comme nom secondaire pour l'objet, ce nom est utilisé si le nom principal (Catalog
Id) est manquant et il peut être ajouté au fichier d'index, cocher “Utiliser ce champ comme nom supplémentaire” si vous le
désirez.

Avancé Ce bouton permet d'effectuer une transformation linéaire des données du catalogue, il est activé seulement pour les
champs numériques. Par exemple pour convertir des minutes en secondes
Une autre utilisation peut être de calculer les coordonnées des objets si elles ne sont pas directement disponible dans le
catalogue.
Si le catalogue donne la position des objets en millimètre sur la plaque depuis le centre de la galaxie (p.ex: ra: 0h42m42.00s
dec:+41°16'00.0“), on sait que le nord est en haut et que l'échelle de la plaque est 2 secondes par millimètre.
Les coordonnées approximatives (sans correction de plaque) en degrés sont:

DEC = 41.26667 + Xmm * (2/3600)

RA = 10.67500 - Ymm * (2/3600/cos(DEC))

Choisir “Decimal degree” pour RA et DEC, indiquez la position en millimètres et utilisez les valeurs “Avancées” suivantes:

pour RA : -0.00073837 et 10.67500

pour DEC : 0.00055555 et 41.26667

Si vous devez faire une transformation plus complexe il est nécessaire de le faire avant de lancer Catgen. Un script Perl
permet de résoudre tout les cas de figure.

Appuyez sur le bouton Suivant » pour passer à la page suivante.

Page 4

La dernière page permet d'indiquer des options pour le catalogue généré.

Indiquez le Nombre de fichiers comme recommandé en fonction du nombre d'objet dans le catalogue, c'est très important
pour obtenir des bonnes performances.
Cochez Créer un index de recherche pour créer un index permettant de rechercher les objets par leur nom.
Cochez Ajouter les noms supplémentaires* à l'index pour ajouter le nom secondaire a l'index.
Cochez Préfixe le nom supplémentaire avec son label pour préfixer les noms secondaires avec leur étiquette. Par
exemple si une colonne du catalogue donne les numéros UGC des galaxies cela permet d'utiliser UGC7442 au lieu de 7442
comme entrée dans l'index.
Choisir un Répertoire de sortie pour enregistrer les fichiers du catalogue. C'est un bonne habitude d'utiliser un répertoire
séparé pour chaque catalogue.
Cochez Ajouter à un catalogue existant si vous voulez ajouter ces données à un catalogue existant de même nom dans le
même répertoire.
C'est utile pour créer un catalogue unique à partir de plusieurs sources. Dans ce cas la structure du catalogue doit être
exactement la même, autrement les données seront perdues, veuillez faire une copie de sauvegarde avant d'essayer cette
option.
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Quand tout est prêt, enregistrer le projet avec le bouton Enregistrer, puis appuyer sur le bouton Construire le catalogue.

Une boite de progression vous montre l'avancement des opérations. Il est possible de l'interrompre avec le bouton “Abort”,
dans ce cas le catalogue n'est pas utilisable.
Quand tout est terminé la boite de progression se ferme et vous pouvez quitter le programme avec le bouton “Close”.
Si certaines ligne du fichier catalogue ne contiennent pas des valeurs numériques valides pour certains champs ces objets ne
sont pas ajoutés au catalogue mais les lignes sont écrites dans un fichier reject.txt.

C'est une bonne idée de d'abord essayer vos définitions avec un nombre limité d'objet afin d'éviter un fichier reject.txt de
plusieurs millions de lignes! Vous pouvez trouver des versions pour Windows des commandes Unix head, tail et grep qui sont
très utiles pour extraire quelques lignes d'un gros fichier.

Si tout c'est bien passé vous êtes maintenant près a utiliser votre catalogue. Referez-vous à la documentation de Cartes du
Ciel pour définir ce catalogue dans le programme.

Notes pour les utilisateurs Linux et Mac

Veuillez lire attentivement si vous prévoyez de faire un gros catalogue avec 9537 fichiers.

Comme il lit les lignes des fichiers d'entrées, Catgen a besoin d'écrire de façon aléatoire les données dans les 9537 fichiers de
sortie, selon les coordonnées de l'étoile. Ainsi, les 9537 fichiers doivent être ouverts en même temps.

Comme Linux et Mac OS sont des système d'exploitation multi-utilisateur, il y a des garde-fou afin d'éviter qu'un utilisateur
prenne toutes les ressources système. Pour une installation standard de Linux par exemple le nombre maximal de fichiers
qu'un utilisateur peut ouvrir en même temps est limité à 1024.

Pour Mac OS X la manière de faire dépend de la version que vous utilisez. Voir la première réponse à cette question
[http://unix.stackexchange.com/questions/108174/how-to-persist-ulimit-settings-in-osx-mavericks].

Pour Linux, vous devez d'abord changer les limites du système dans le fichier limits.conf:

sudo vi /etc/security/limits.conf

ajouter ces deux lignes à la fin du fichier:

* soft nofile 1024

* hard nofile 32768

Je vous recommande de conserver la valeur par défaut de 1024, cela peut être une bonne protection contre un processus fou.

Enregistrez le fichier, et déconnectez vous du système car ce fichier ne s'applique qu'à la prochaine connexion.

Ensuite, ouvrez une fenêtre de terminal et tapez:

ulimit -S -n 20000

et depuis le même le terminal:

skychart

C'est très important car le changement de limite n'est que pour l'instance courante du shell, et non pour tout le système.
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Éditeur de boîte à outil
Cette fenêtre s'affiche lorsque vous cliquez sur le bouton Éditeur de script au bas d'une boîte à outil. Il permet de
configurer et de programmer les actions pour la boîte à outils.

Créer la mise en page de l'outil

Définissez d'abord le titre de votre outil dans le champ de texte en haut.

Ensuite, vous devez ajouter au moins un groupe: cliquez sur le bouton Groupe, définissez le titre du groupe et le nombre
d'éléments souhaité sur chaque ligne. Cliquez ensuite sur le bouton Ajouter.

Utilisez ensuite le même principe pour ajouter les éléments que vous voulez, par exemple une zone de saisie de texte et un
bouton. 
Ces éléments ne peuvent être ajoutés qu'à un groupe. 
Un nom est automatiquement attribué à chaque élément, par exemple Edit_1. C'est le nom que vous devez utiliser pour
accéder aux propriétés de l'élément à partir de votre script. 
Pour certains éléments, vous pouvez sélectionner un titre ou une hauteur en pixels. 
Pour modifier le nombre d'éléments par ligne, créez un nouveau groupe avec la valeur requise mais sans titre.

Les événements sont des éléments spéciaux. Cela n'ajoute rien de visible sur l'écran, mais vous permet d'écrire le script qui
va traiter un événement. 
Les événements sont:

Initialisation: Exécuté une fois après avoir cliqué sur le bouton Appliquer, ou lorsque le programme démarre.
Activation: Exécuté chaque fois que cette boîte à outils est affichée.
Timer: Exécuté à intervalle périodique, entrez l'intervalle en seconde lorsque vous sélectionnez cet événement.
Telescope move: Chaque fois que la position du télescope change.
Chart refresh: Chaque fois que la carte est redessinée.
Object identification click: quand un objet est sélectionné par un clic sur la carte ou suite a une recherche.
Distance measurement: Lorsque vous mesurez une distance sur la carte.
Telescope connected: Lorsque le télescope est connecté.
Telescope disconnected: Lorsque le télescope est déconnecté.
Translation: Exécuté après l'initialisation ou lorsque vous changez la langue du programme.

Les événements sont normalement inactifs lorsque l'outil n'est pas affiché. Une exception est l'événement Timer que vous
pouvez toujours activer en cochant la case correspondante. Mais attention que cette option peut engendrer des problèmes de
performance. 
Utilisez plutôt l'événement Activation pour mettre à jour votre outil avec les modifications ont pu se produire sur la carte
lorsque l'outil était inactif.

Vous pouvez réorganiser les groupe ou les éléments à l'aide des flèches verticales ou par glisser-déplacer dans l'arborescence
de gauche.

Si vous sélectionnez un élément dans l'arborescence et que vous modifiez l'une de ses propriétés, le bouton Mise à jour
apparaît pour permettre d'appliquer la modification.

Un script peut être attaché aux éléments suivants: Bouton, Menu, Liste déroulante, Événement. 
Lorsque vous sélectionnez l'un de ces éléments dans l'arborescence, le bouton “Modifier le script” apparaît. Voir ci-dessous
pour les détails. 
Vous pouvez ajouter une fonction au menu contextuel de la carte. Pour cela, créez un bouton et cochez “Menu”.

Lorsque vous êtes prêt, cliquez sur le bouton Enregistrer pour enregistrer votre travail dans un fichier et afficher vos
éléments dans la boîte à outils ainsi que compiler les scripts. (l'extension de fichier par défaut est .cdcps). 
Sauvegardez également la configuration du programme pour vous recharger la boîte d'outils automatiquement la prochaine
fois que vous démarrez le programme.
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Éditeur de script

L'éditeur permet d'écrire le script lui-même qui s'exécutera lors d'un clic sur le bouton, une sélection dans la liste déroulante,
ou un événement.

Le langage de programmation à utiliser est Pascal Script [https://en.wikipedia.org/wiki/Pascal_Script], basé sur Pascal Objet
[https://en.wikipedia.org/wiki/Object_Pascal].
Définissez d'abord les variables globales, puis les procédures et fonctions, le cas échéant, puis les variable privée et enfin le
code principal commençant par begin et terminé par end. 
Lisez la page exemple de script pour un démarrage rapide.

Comme chaque script est spécifique à un événement, il n'est pas possible d'avoir des variables globales entre les scripts. Par
exemple, vous ne pouvez pas définir une variable lorsqu'un bouton est pressé et utiliser cette variable dans le clic d'un autre
bouton. 
Pour résoudre ce problème, un certain nombre de variables globales sont prédéfinies dans le programme principal et des
fonctions spécifiques permettent de les lire et écrire.

Ces fonctions et d'autres spécifiques à l'interface avec CdC sont décrites dans une page séparée de référence des scripts.

Utilisez le bouton Enregistrer pour enregistrer votre changement et revenir à la fenêtre principale.

Les boutons du haut sont liés à la fonction de débogage comme décrit ci-dessous.

Débogage

Une fonction de débogage simple est disponible pour tester votre code.

Pour exécuter le script en mode debug, appuyez sur la flèche verte Exécuter . Le programme est d'abord compilé.

En cas d'erreur de compilation, la ligne correspondante est mise en surbrillance en jaune et le message d'erreur s'affiche dans
la zone de message.

Si la compilation se termine sans erreur, le programme démarre et s'arrête sur la première ligne de code de la procédure
principale. La position d'exécution actuelle est mise en surbrillance en bleu.

Vous pouvez maintenant utiliser le bouton Pas à pas pour exécuter votre programme ligne par ligne. 
Le bouton Pas à pas approfondi fait de même, sauf si la ligne en cours est un appel à l'une de vos fonctions. Dans ce cas Pas
à pas approfondi va détaillé l’exécution de la fonction, alors que Pas à pas continu dans le programme principal à la ligne
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suivante.

Vous pouvez également définir un point d'arrêt sur une ligne spécifique pour sauter directement à cette position.

Pour définir un point d'arrêt, cliquez sur la colonne la plus à gauche pour afficher une icône rouge. 
Utilisez le bouton Exécuter pour passer au prochain point d'arrêt. La ligne actuelle est alors mise en surbrillance en rouge.

Vous pouvez supprimer un point d'arrêt en cliquant sur l'icône rouge ou tous d'un coup avec le bouton Supprimer tous les
points d'arrêt .

Vous pouvez afficher la valeur des variables lorsque le programme est en pause à un point d'arrêt ou après un Pas à pas . 
Il suffit de cliquer sur le nom de la variable n'importe où dans le source du programme pour afficher la valeur dans la zone de
message. 
Notez que cela fonctionne uniquement pour les variables locales, et pas pour les propriétés d'un objet.

Vous pouvez utiliser la touche Pause pour suspendre l'exécution du programme. Cela peut être utile pour examiner l'état
d'une boucle infinie par exemple.

La touche Arrêt termine l'exécution du programme immédiatement.
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Ajouter des éléments manuellement
Depuis le menu: Configuration→ Système solaire… → Comète → Ajouter 
or
Depuis le menu: Configuration→ Système solaire… → Astéroïde → Ajouter 

Il peut être utile d'ajouter des éléments manuellement à votre liste existante des comètes ou des astéroïdes. Vous pouvez
également afficher un astéroïde au milieu des étoiles en supprimant les données de position des autres astéroïdes et en
entrant les données d'élément uniquement pour votre astéroïde.

Attention

Les éléments sont utilisés pour définir les orbites comme une section de coniques, ellipses pour les astéroïdes et ellipses ou
paraboles pour les comètes. Les positions calculées qui en résultent ne sont valide que pour une courte période et pour les
objets qui ne sont pas trop proches d'autres planètes. Dans le cas des objets qui passent près de la Terre (NEO), les postions
calculées sur la base des éléments sont totalement inutiles. Si vous souhaitez afficher la position ou le chemin d'un NEO avec
Cartes du Ciel, vous pouvez le faire sur la base d'une liste de positions calculées et en ajoutant cette liste à vos catalogues.
Vous trouverez ici la manière de le faire.

Obtenir les éléments

Vous pouvez obtenir les éléments depuis NASA JPL Horizons. Ouvrir ce lien dans une nouvelle fenêtre:
http://ssd.jpl.nasa.gov/horizons.cgi [http://ssd.jpl.nasa.gov/horizons.cgi] 
Copiez les réglages ci-dessous, avec bien sûr vos réglages. Choisir pour Ephemeris Type Orbital Elements. Choisir pour Target

Body l'objet dont vous désirez les éléments. Vous devez définir Center comme @sun. Régler Time Span l'intervalle de temps
pour lequel vous souhaitez récupérer les éléments.

Ephemeris Type [change] : ELEMENTS

Target Body [change] : Asteroid 5610 Balster (2041 T-3)

Center [change] : Sun (body center) [500@10]

Time Span [change] : Start=2014-08-09, Stop=2014-08-10, Step=1 d

Table Settings [change] : defaults

Display/Output [change] : default (formatted HTML)

Saisie des données

Les données de la partie "Object Data page"
Entrez un désignation claire de l'objet. Dans cet exemple, je choisis “Asteroid 5610 Balster (2041 T-3)”. 
Dans la partie Physical Parameters vous trouvez la valeur H= ... Copier la valeur dans H magnitude absolue.
Copier la valeur de G= .. dans G paramètre de pente.

Les données de "Results"
En outre, dans la partie Results nous trouvons plus de données à entrer. La liste des résultats affiche les données en notation
mathématique. Cartes du Ciel peut traiter ces données à la fois sous cette forme ou dans la notation décimale.
$$SOE

2456878.500000000 = A.D. 2014-Aug-09 00:00:00.0000 (CT)

EC= 4.410631654154605E-02 QR= 2.680223611595490E+00 IN= 3.348991791769490E+00

OM= 2.437396671671045E+02 W = 3.329253281089416E+02 Tp= 2456381.044945736416

N = 2.099239155691789E-01 MA= 1.044277128106851E+02 TA= 1.092504742118517E+02

A = 2.803893003977550E+00 AD= 2.927562396359610E+00 PR= 1.714907036789549E+03

2456879.500000000 = A.D. 2014-Aug-10 00:00:00.0000 (CT)

EC= 4.410698013669621E-02 QR= 2.680219915877766E+00 IN= 3.348991402148423E+00

OM= 2.437396179792080E+02 W = 3.329246715210186E+02 Tp= 2456381.042354188394

N = 2.099241311623329E-01 MA= 1.046382882182052E+02 TA= 1.094556083560238E+02

A = 2.803891084235605E+00 AD= 2.927562252593444E+00 PR= 1.714905275571270E+03

$$EOE

Prenez note des abréviations et copier les données correspondantes:

1. 2456338.500000000 comme valeur pour Epoque (JD) (en haut juste après $$SOE)
2. MA: 1.044277128106851E+02 comme valeur pour Anomalie moyenne
3. W: 3.329253281089416E+02 comme valeur pour Argument de périhélie
4. OM: 2.437396671671045E+02 comme valeur pour Longitude du noeud ascendant
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5. IN: 3.348991791769490E+00 comme valeur pour Inclinaison
6. EC: 4.410631654154605E-02 comme valeur pour Excentricité
7. A: 2.803893003977550E+00 comme valeur pour Demi grand axe

Comme Référence entrez la référence de la source des données. Dans cet exemple “Horizons”. 
Pour Nom vous entrez le nom qui apparaîtra sur le label de la carte. Pour la distinction entre les données de positon calculés
précédemment, il peut être utile d'utiliser un nom d'objet avec des informations supplémentaires.

Cliquez sur le bouton Ajouter. Si vous avez entré toutes les données dans un format qui peut être traiter, vous recevrez un
“OK!”. 

Maintenant, allez à préparer les données mensuelles, afin de calculer les positions comme décrit dans ces instructions.

138



Affichage des objets géocroiseurs

Affichage de NEO pendant le transit terrestre
Cette méthode ne peut fonctionner que pour le passage d'un astéroïde bien connu avec une bonne précision pour la
détermination de l'orbite. Ceci est nécessaire pour que le MPC ou Horizon puisse calculer une orbite perturbée précise.
Dans le cas d'un objet nouvellement découvert, il est préférable d'utiliser l'autre méthode décrite au bas de cette page.

Il est possible d'afficher les objets géocroiseurs (NEO) dans Cartes du Ciel après avoir calculé leurs position dans le ciel. Pour
faire ces calculs, nous avons besoin de notre position sur la Terre ainsi que la date et heure de l'affichage. Nous pouvons
obtenir les résultats de ces calculs à partir du Minor Planet Center [http://www.minorplanetcenter.net/iau/MPEph/MPEph.html] ou
du site JPL Horizons [http://ssd.jpl.nasa.gov/horizons.cgi]. Après cela, nous pouvons copier les données dans un fichier texte
ASCII et utiliser CatGen pour compiler un catalogue.

Nous ne pouvons pas utiliser les éléments orbitaux pour afficher un passage d'un NEO!

Il est fortement conseillé de faire un dernier calcul et la compilation du catalogue juste avant d'observer. La
trajectoire du NEO sera certainement différente des prévisions antérieures!

Pourquoi nous n'utilisons des éléments orbitaux

Habituellement Cartes du Ciel est capable de créer des cartes fiables avec des comètes et des astéroïdes sur la base des
éléments orbitaux. En raison des grandes distances, les perturbations provoquées par le champ de gravité de la Terre ou
d'autres planètes n'ont qu'une faible influences sur la trajectoire des objets du système solaire. Dans le cas d'une situation de
survol, la gravité de la Terre est un perturbateur significatif, elle a une grande influence sur la trajectoire.

Les éléments orbitaux sont des données mathématiques pour déterminer les orbites de section conique (ellipses, parabole)
des objets du système solaire en mouvement autour du Soleil. Les éléments orbitaux sont calculés sur la base de deux corps,
l'objet lui-même et le Soleil. Bien sûr, il y a des perturbations par les planètes, mais les distances sont très grandes, de sorte
que les influences sont faibles. C'est pourquoi nous-dans des conditions normales nous pouvons utiliser les éléments orbitaux
de faire des prévisions fiables pour un certain temps.

Dans le cas des objets géocroiseurs, ces conditions ne sont pas remplie. Pour faire une prédiction la position, nous avons
besoin de faire des calculs sur la base de trois corps: L'objet lui-même, le Soleil et la Terre. Sous l'influence supplémentaire de
la gravité terrestre, la trajectoire de l'objet ne suit plus son ancienne orbite de section conique. Parce que les éléments
orbitaux décrivent uniquement des sections coniques, ils ne sont pas utiles dans ce cas. Si vous souhaitez conserver
l'utilisation des éléments orbitaux lors d'un événement de survol, vous remarquerez de grands changements des données sur
une courte périodes de temps. C'est seulement quand l'objet s'est éloigné suffisamment de la Terre que vous pourrez utiliser
les éléments a nouveaux.

Télécharger le fichier du projet CatGen

Vous pouvez utiliser les calculs à la fois du Minor Planet Center (MPC) et de JPL Horizons, ou vous pouvez choisir l'un d'eux.
Cartes du Ciel est capable d'afficher les donnée des deux sources sur une seule carte.

Pour faciliter le travail, j'ai compilé un fichier zip contenant:

MPC.prj Le fichier de projet CatGen pour les éphémérides format MPC

Horizons.prj Le fichier de projet CatGen pour les éphémérides format JPL Horizons

mpc.txt Fichier ASCII-text avec un exemple d'éphéméride du MPC

horizons.txt Fichier ASCII-text avec un exemple d'éphéméride de Horizons

mpc.hdr Exemple d'en-tête de catalogue prêt pour l'utilisation à la date du 15 février 2013, générer à partir des
donnée du MPC.

horizons.hdr Exemple d'en-tête de catalogue prêt pour l'utilisation à la date du 15 février 2013, générer à partir des
donnée de Horizons.

mpc.info2 Exemple d'en-tête de catalogue prêt pour l'utilisation à la date du 15 février 2013, générer à partir des
donnée du MPC.

horizons.info2 Exemple d'en-tête de catalogue prêt pour l'utilisation à la date du 15 février 2013, générer à partir des
donnée de Horizons.

README.txt Brève description de l'utilisation de ces fichiers.

Tout d'abord, télécharger ce fichier zip [https://ap-i.net/pub/skychart/neo/ephemerides.zip] et l'enregistrer dans le répertoire où
vous souhaitez stocker vos catalogues. Avec Windows, le répertoire standard est C:\Program Files\Ciel\cat, avec Linux c'est
/usr/share/apps/ciel. Décompressez le fichier dans le répertoire de votre catalogue. Après cela, vous trouverez un nouveau
répertoire nommé ephemerides. Il contiendra les fichiers mentionnés ci-dessus.

Récupération des donnée du Minor Planet Center

Ouvrir la source des donnée MPC avec ce lien [http://www.minorplanetcenter.net/iau/MPEph/MPEph.html] dans une nouvelle
fenêtre. 
Sélectionnez le bouton radio Return Ephemerides, au cas où il n'a pas été sélectionné. Entrez l'identification (s) de l'objet dans la
fenêtre rectangulaire pour lequel vous souhaitez générer le catalogue, par exemple 2012 DA14. 
Saisir également sur la même page:

La date de début souhaité pour les calculs, en temps universel.Plusieurs formats sont autorisés, par exemple 
2013 02 15 194600 pour le 15 février 2013 à 19:46:00 UT (h:m:s) 
2013/02/15.75 pour le 15 février 2013 à 18:00 UT.

Le nombre de positions que vous voulez calculer (number of dates to output).
Facultatif: entrez un nombre dans la zone de texte (Ephemeris interval) si vous souhaitez un intervalle pour un certain
nombre d'unités de temps. Vous sélectionnez cette unité de temps à Ephemeris units.
Votre unité de temps souhaité (Ephemeris units) en jours, heures, minutes ou secondes.
En notation décimale la (longitude), la (latitude) et l'(altitude) au dessus du niveau de la mer en mètres de votre lieu
d'observation.
Gardez sélectionné: full sexagesimal, total motion and direction, ”/min.
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Choisissez selon vos préférences Measure azimuths.
Gardez sélectionné: Format for elements output: none.
Cliquez à le bouton Get ephemerides/HTML page.

2013 02 15 180000 11 46 49.9 -59 00 03   0.00036 0.988  105.1  74.9   9.6 1164.89    006.0    128  -54   -11   0.30   128  +45        54 078.6 / Map / Offsets

2013 02 15 180100 11 47 05.7 -58 40 38   0.00036 0.988  105.4  74.6   9.8 1178.23    006.0    127  -54   -11   0.30   129  +45        54 078.5 / Map / Offsets

2013 02 15 180200 11 47 21.4 -58 21 00   0.00036 0.988  105.7  74.3   9.7 1191.74    005.9    127  -54   -12   0.30   129  +45        54 078.4 / Map / Offsets

2013 02 15 180300 11 47 36.9 -58 01 07   0.00036 0.988  105.9  74.0   9.7 1205.47    005.9    126  -53   -12   0.30   129  +45        54 078.2 / Map / Offsets

2013 02 15 180400 11 47 52.4 -57 41 01   0.00035 0.988  106.2  73.8   9.7 1219.36    005.8    126  -53   -12   0.30   129  +45        54 078.1 / Map / Offsets

2013 02 15 180500 11 48 07.7 -57 20 41   0.00035 0.988  106.5  73.5   9.7 1233.43    005.7    125  -53   -12   0.30   130  +44        54 078.0 / Map / Offsets

2013 02 15 180600 11 48 22.9 -57 00 07   0.00035 0.988  106.8  73.2   9.7 1247.67    005.7    125  -53   -12   0.30   130  +44        54 077.9 / Map / Offsets

2013 02 15 180700 11 48 38.0 -56 39 18   0.00035 0.988  107.1  72.9   9.6 1262.14    005.6    124  -52   -12   0.30   130  +44        55 077.8 / Map / Offsets

Maintenant dans le répertoire ephemerides ouvrez le fichier MPC.txt avec un éditeur de texte (p. ex. notepad ou vi).
Sélectionner les lignes de l'éphéméride dans votre navigateur et copier dans le fichier. Enregistrer le fichier MPC.txt. Nous
allons utiliser ce document comme fichier du catalogue avec CatGen. 

Si vous ne souhaitez pas utiliser les données sur les éphémérides de Horizons vous pouvez sauter le paragraphe suivant et
continuer Génération d'un catalogue d'éphémérides avec CatGen.

Récupération des donnée de Horizons

Ouvrir ce lien [http://ssd.jpl.nasa.gov/horizons.cgi] dans une nouvelle fenêtre. 
Adaptez vos paramètres comme dans l'exemple ci-dessous. 

Sélectionner pour Ephemeris Type Observer Tables. 
Entrez l'objet désiré à Target Body. 
Cliquez sur Specify Observer Location: à la ligne specify latitude, longitude, and altitude et définir les coordonnées
et l'altitude au dessus du niveau de la mer à Specify Observer Coordinates. Après cela, cliquez sur le bouton Use
specified Coordinates.
Ensuite, définissez l'intervalle de temps pour lequel vous souhaitez récupérer les données de position.

Ephemeris Type [change] : OBSERVER

Target Body [change] : Asteroid (2012 DA14)

Observer Location [change] : user defined ( 5°52'07.0“E, 51°49'24.0” N, 60 m )

Time Span [change] : Start=2013-02-15 19:00, Stop=2013-02-16 02:00, Step=10 m

Table Settings [change] : defaults

Display/Output [change] : default (formatted HTML)

Toutes les données exigées sont entrés. Alors maintenant, cliquez sur le bouton Generate Ephemeris. Après la ligne Results
vous trouverez les positions comme dans l'exemple ci-dessous.

 2013-Feb-15 19:00  m  12 00 04.31 -31 04 57.4   8.32 0.00025777599773  -3.0499410 127.3788 /L  52.6083

 2013-Feb-15 19:01  m  12 00 15.84 -30 26 57.6   8.30 0.00025656475249  -2.9902275 127.8449 /L  52.1423

 2013-Feb-15 19:02  m  12 00 27.35 -29 48 37.0   8.27 0.00025537764519  -2.9295700 128.3127 /L  51.6746

 2013-Feb-15 19:03  m  12 00 38.84 -29 09 55.8   8.25 0.00025421505430  -2.8679690 128.7818 /L  51.2056

 2013-Feb-15 19:04  m  12 00 50.31 -28 30 54.3   8.23 0.00025307735783  -2.8054258 129.2522 /L  50.7354

Maintenant dans le répertoire ephemerides ouvrez le fichier horizons.txt avec un éditeur de texte (p. ex. notepad ou vi).
Sélectionner les lignes de l'éphéméride dans votre navigateur et copier dans le fichier. Enregistrer le fichier horizons.txt.
Nous allons utiliser ce document comme fichier du catalogue avec CatGen. 

Génération d'un catalogue d'éphémérides avec CatGen

Si vous gardez le nom de fichier par défaut pour les données et vous ne voulez pas faire tout changement à l'exemple fourni
mpc.hdr ou hori.hdr vous pouvez ignorer cette section et passer directement à Activer le catalogue.

Pour une documentation générale sur l'utilisation de CatGen regarder ici.

Dans le menu: Configuration → Catalogue, choisir l'onglet Catalogue et cliquer le bouton CatGen en haut de la fenêtre.

CatGen Page 1

Cliquez sur le bouton en bas de la nouvelle boîte de dialogue Charger un projet. Trouvez le répertoire avez-vous été
précédemment décompressé le fichier téléchargé et sélectionnez le fichier .prj file qui appartient à la source des
éphémérides.

Entrer pour Nom court un nom court et reconnaissable pour le catalogue, max. 4 caractères. Par exemple, les quatre
derniers caractères du nom de l'objet.

Entrer pour Nom complet l'identification de l'objet associé à la date.

Cliquez sur le bouton Fichiers du catalogue. Choisir le fichier .txt des données d'éphémérides.

Laissez le type de catalogue à Fichier texte.

Cliquez Suivant.

CatGen Page 2

Pour MPC: Laissez équinoxe à 2000, pour Epoque utilisez l'année pour laquelle vous créez la carte.

Pour Horizons: Trouver dans les résultats la partie concernant l'équinoxe et l'époque. Ceux-ci sont affichés au-dessus de la
table de coordonnées. Il est probable que vous trouverez Initial FK5/J2000.0 heliocentric ecliptic osculating elements, dans
ce cas, laissez équinoxe à 2000. L'époque a été donnée au format Julien et date ordinaire. Prenez pour l'époque l'année de la
date ordinaire.

Rechercher dans la table des résultats la magnitude maximale que nous pouvons attendre de l'objet. Arondir la valeur, et
entrer dans le champ Magnitude.

Comme Type d'objet vous pouvez déterminer la forme affichée. Choisissez une forme simple, bien reconnaissable comme un
losange.
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Cliquez Suivant.

CatGen Page 3

Ici, tous les réglages nécessaires sont en place pour les formats de MPC ou Horizons. Cliquez sur Suivant.

CatGen Page 4

Définir le chemin où vous voulez écrire le fichier de catalogue. Un endroit logique est le même répertoire où vous avez placé
les fichier texte et .prj. 
Sauvegardez vos paramètres de projet par un clic à la touche Enregistrer le project.
Maintenant cliquez sur le bouton Créer le catalogue, après cela, cliquez sur Quitter.

Activer le catalogue

Dans le menu: Configuration → Catalogue, à l'onglet Catalogue, cliquez sur le bouton Ajouter. Recherche le fichier .hdr du
catalogue dans son répertoire. Après cela, activez le catalogue par un clic sur le point rouge. Pour confirmer l'activation, il
devient vert.

Affichage

Si vous n'avez pas modifié les autres paramètres, la position de l'astéroïde sera affiché par un losange rouge. Le catalogue se
comporte comme un catalogue du ciel profond, de sorte que vous pouvez définir la magnitude des étoiles indépendamment de
l'astéroïde.

Affichage des NEO à confirmer
Dans le cas où il n'y a pas assez d'observations pour être sur de la position d'un nouvel objet vous pouvez utiliser la méthode
suivante développée par Basil Rowe basée sur les données de la page de Confirmation des NEO du MPC (NEOCP
[http://www.minorplanetcenter.net/iau/NEO/toconfirm_tabular.html]).

Cette méthode vous permet de tracer la carte d'incertitude dans CdC pour aider à planifier une session d'imagerie pour
retrouver l'astéroïde.

Commencez par télécharger les fichiers du projet [https://ap-i.net/pub/skychart/neo/NEO-CdC_plot_project.zip].

Extrayez le fichier zip et lisez les documents Uncertainty Map Plotting in Cartes du Ciel et How to Use pour Excel ou
OpenOffice

Le processus implique de copier/coller les différents éléments orbitaux du NEOCP dans une feuille de calcul, puis d'utiliser
une macro pour reformater les éléments à utiliser dans CdC.

Après cela, vous pouvez afficher la carte d'incertitude dans CdC: 

Veuillez adresser vos questions et commentaires (en anglais) à Basil Rowe (adresse e-mail dans les dossiers de projet)
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Raccourcis clavier

Echelle, champ de vision

+ : Zoom avant
- : Zoom arrière
1,2,…9,0,a : numéro de plages de champ de vision prédéfinis
molette souris poussée : Zoom avant
molette souris tirée : Zoom arrière
clic gauche et draguer le curseur : définir la zone à agrandir
clic gauche dans la zone : confirmer le Zoom
clic gauche et draguer le curseur in zone : déplacer la zone

Direction, déplacement

n : horizon Nord
e : horizon Est
s : horizon Sud
w : horizon Ouest
z : Zénith
Flèches clavier et pavé numérique (y compris diagonales) : déplacement de la carte dans la direction de la flèche

+ Ctrl : déplacement plus rapide
+ Shift : déplacement moins rapide

clic et draguer avec molette souris : déplacement de la carte

Le fonctionnement du clic gauche de la souris peut être modifier avec le bouton /

Marque des oculaires et cameras

Entrez dans le mode de rotation

Shift+C : Rotation du rectangle de la caméra principale.
Shift+G : Rotation du guide autour de la caméra principale.
Shift+S : Rotation de la caméra et du guide en même temps.

Rotation

Flèche gauche : Tourner dans le sens antihoraire de cinq degrés.
Flèche droite : Tournez dans le sens horaire cinq degrés.

Quitter le mode de rotation en utilisant la même touche que pour entrer.

Télescope

* Ctrl+K : Cancel le goto

Etoiles

Etoiles en mode paramétrique

ctrl + q : augmenter la taille des étoiles faibles
ctrl + a : réduire la taille des étoiles faibles
ctrl + w : augmenter la luminosité
ctrl + s : réduire la luminosité
ctrl + e : augmenter le contraste
ctrl + d : réduire le contraste
ctrl + r : augmenter la saturation des couleurs
ctrl + f : réduire la saturation des couleurs
ctrl + i : Montrer/cacher les images

Sélection d'objet

clic gauche sur l'objet: Sélectionne l'objet le plus proche dans le rayon du curseur et affiche le label de sélection.
Ctrl + clic gauche sur l'objet: Sélectionne l'objet étendu dont le curseur est dans le diamètre.
Alt + bouton gauche : Identifie en continu les objets sous le curseur.

Etiquettes, information sur les objets

clic gauche sur l'objet : sélectionner l'objet, montrer l'étiquette
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clic droit sur l'objet : menu contextuel de l'objet
Ctrl+L: Afficher les informations sur la carte.
Ctrl+Shift+L:​ Afficher la légende sur la carte.

Mode “modifier label” actif

clic gauche sur l'étiquette : informations détaillées
clic droit sur l'étiquette : menu contextuel d’édition de l'étiquette

Fenêtre

F1 : aide contextuelle
F11 : plein écran
ctrl + b : montrer/cacher les barres d'outils et la barre d'état
ctrl + c : copier la carte dans le presse-papier
ctrl + l : recharge le fichier de traduction
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Commandes de la ligne de commande
CdC, accepte les options suivantes en ligne de commande :

Option Paramètres Fonction

--config chemin du fichier de configuration Permet de spécifier le fichier de configuration à utilisé a la place de
“%LOCALAPPDATA%\skychart\skychart.ini” ou
“~/.skychart/skychart.ini”

--loaddef nom_fichier Même chose que la commande du serveur LOADDEFAULT
Utilisez cette option pour charger un extrait du fichier de
configuration skychart.ini

--obslist chemin de la liste d'observation Charge la liste d'observation spécifiée

--unique Ne lance pas le programme si une autre instance est déjà active mais
passe les nouvelles options à l'instance en cours

--quit S'utilise avec l'option --unique pour fermer l'instance en cours, ou
pour quitter immédiatement.

--nosplash Ne montre pas l'écran de démarrage

--daemon Lance le programme en arrière plan sans montrer la fenêtre principale

--nosave N'enregistre pas les options en quittant. Utile avec --loaddef

--
loadmpcorb

nom_fichier Même chose que la commande du serveur LOADMPCORB 
Utilisez cette option pour charger un fichier d'éléments d’astéroïdes.

Options concernant la première carte active

--load nom_fichier Même chose que la commande du serveur LOAD 
Utilisez cette option pour charger un modèle avec les options que vous
ne pouvez pas modifier ici.

--search nom_objet Même chose que la commande du serveur SEARCH

--setproj ALTAZ/EQUAT/GALACTIC/ECLIPTIC Même chose que la commande du serveur SETPROJ

--setfov 00d00m00s or 00.00 Même chose que la commande du serveur SETFOV

--setra RA:00h00m00s or RA:00.00 Même chose que la commande du serveur SETRA

--setdec DEC:+00d00m00s or DEC:00.00 Même chose que la commande du serveur SETDEC

--setobs LAT:+00d00m00s
LON:+000d00m00s
ALT:000mOBS:name

Même chose que la commande du serveur SETOBS

--settz Etc/GMT Même chose que la commande du serveur SETTZ

--setdate yyyy-mm-ddThh:mm:ss 
or "yyyy-mm-dd hh:mm:ss"

Même chose que la commande du serveur SETDATE

--setcat "path shortname active min max " Même chose que la commande du serveur SETCAT

--resize "largeur hauteur" Même chose que la commande du serveur RESIZE

--dss Même chose que la commande du serveur PDSS

--saveimg "PNG/JPEG/BMP Fichiername
quality"

Même chose que la commande du serveur SAVEIMG

--print "PRT/PS/BMP
PORTRAIT/LANDSCAPE COLOR/BW
filepath"

Même chose que la commande du serveur PRINT

Attention, contrairement aux commandes envoyée par TCP/IP, les options et les paramètres sont séparés par le signe "=" sans
aucun espace. Si la valeur du paramètre contient des espaces il doit être entouré de doubles guillemets "".

Sous Unix vous pouvez envoyer un signal au programme avec la commande kill :

Signal Action

1, HUP Recharge la carte et les options par défaut

15, TERM Ferme le programme proprement

Example d'automatisation utilisant la ligne de commande

L'automatisation se fait normalement en envoyant des commandes par la connexion TCP/IP Mais dans certain cas il est plus
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simple d'utiliser uniquement la ligne de commande.

Lancer l'instance principale : 
# skychart --unique

Définir la taille de l'image :
# skychart --unique --resize="1024 768"

Ensuite cette commande affiche une carte de Messier 1 sans ouvrir de nouvelle fenêtre:
# skychart --unique --setfov=3 --setproj=EQUAT --search=M1

Enregistrer l'image:
#skychart --unique --saveimg="PNG /tmp/m1.png"

Il est possible de répéter avec d'autres objets. Quand on a terminé on peut fermer la fenêtre principale:
# skychart --unique --quit

Il est aussi possible de tout faire d'un coup et de quitter, sans rien afficher à l'écran. C'est utile si on ne veut qu'une seule
image:
#skychart --nosplash --daemon --resize="1024 768" --setfov=3 --setproj=EQUAT --search=M1 --saveimg="PNG
/tmp/m1.png" --quit
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Commandes du serveur
CdC, en temps que serveur, accepte les commandes suivantes par la connexion TCP/IP

Connexion

Vous pouvez utiliser n'importe quelle libraire ou objet fournissant un socket pour vous connecter depuis votre logiciel, ou
utiliser les commandes telnet ou netcat depuis un script.
Pour envoyer une commande, écrivez sur le socket la commande, tout paramètre séparé par un espace, et enfin une
terminaison CR-LF.
Pour des exemples dans divers langages voir: https://github.com/pchev/skychart/tree/master/skychart/sample_client
[https://github.com/pchev/skychart/tree/master/skychart/sample_client]

Le port par défaut est 3292 mais il peut être modifier par l'utilisateur dans le menu de configuration. Le programme peut
aussi choisir un autre port si celui-ci est occupé.

Cartes du Ciel maintient un fichier avec le port de connexion et son état.
Avec Linux et Mac : [Configuration utilisateur /tmp/tcpport 
Avec Windows : Clé de registre HKCU\Software\Astro_PC\Ciel\Status\TcpPort

Le fichier (ou clé) n'existe pas si Cartes du Ciel n'a jamais été lancé.
Il contient 0 si le programme n'est pas démarrer ou si le serveur est désactivé dans la configuration.
Il contient le numéro du port si le programme est prêt à accepter une connexion.

Commandes principales

Commande Paramètres Commentaires ou équivalent Interface Utilisateur

NEWCHART nom_carte Fichier > Nouvelle Carte

CLOSECHART nom_carte Fichier > Fermer la Carte

SELECTCHART nom_carte Fenêtre > nom_carte

LISTCHART Fenêtre

SEARCH nom_objet Outil Recherche (Barre principale)

GETMSGBOX Retourne le contenu de la barre d'état

GETCOORBOX Retourne les coordonnées affichées dans la barre d'état

GETINFOBOX Configuration > Configuration du programme > Affichage > Labels -
Information sur la carte

FIND classe_objet
nom_objet

Même chose que search mais permet d'indiquer la classe de l'objet:
0=nébuleuse, 1=na, 2=étoile, 3=étoile, 4=variable, 5=double, 6=comète,
7=astéroïde, 8=planète, 9=constellation, 10=catalogue de ligne

SAVE nom_fichier Enregistre la carte courante dans le fichier spécifié

LOAD nom_fichier Charge la carte à partir du fichier

LOADDEFAULT nom_fichier Utilisez cette option pour charger un extrait du fichier de configuration
skychart.ini

SETCAT path shortname
active min max

Ajoute ou modifie un catalogue Catgen. Les champs sont les mêmes que
dans la configuration des catalogues

SHUTDOWN Quitte le programme

RESET Recharge la carte et les options par défaut (même chose que signal HUP)

PLANETINFO numéro_de_la_page Ouvre la fenêtre d'Informations du système solaire à la page donnée

GETSELECTEDOBJECT Renvoie des informations sur le dernier objet sélectionné

LOADMPCORB nom_fichier Charge le fichier d'éléments d’astéroïde au format MPCORB. Le résultat
détaillé est disponible dans le fichier [Configuration utilisateur] /​
database/LoadAsteroidFile.log

? Liste des commandes disponibles

Commandes de Carte

Commande Paramètres Commentaires ou équivalent Interface
Utilisateur

ZOOM+ Voir > Zoom avant
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ZOOM- Voir > Zoom arrière

MOVEEAST Clavier flèche gauche

MOVEWEST Clavier flèche droite

MOVENORTH Clavier flèche haut

MOVESOUTH Clavier flèche bas

MOVENORTHEAST Pavé numérique 7 (Sans verrou numérique)

MOVENORTHWEST Pavé numérique 9 (Sans verrou numérique)

MOVESOUTHEAST Pavé numérique 1 (Sans verrou numérique)

MOVESOUTHWEST Pavé numérique 3 (Sans verrou numérique)

FLIPX Carte > Tranformation > Miroir Horizontal

FLIPY Carte > Tranformation > Miroir Vertical

SETCURSOR pixX pixY

CENTRECURSOR Clic droit > Centrer

ZOOM+MOVE Clic droit > Centrer et Zoom +

ZOOM-MOVE Clic droit > Centrer et Zoom -

ROT+ Carte > Tranformation > Rotation à droite

ROT- Carte > Tranformation > Rotation à gauche

SETEQGRID ON/OFF Carte > Lignes/Grilles Ajouter la grille équatoriale

SETGRID ON/OFF Carte > Lignes/Grilles Voir les grilles de coordonnées

SETSTARMODE 0/1/2 Configuration > Mode d'affichage > Affichage des
étoiles

SETNEBMODE 0/1 Configuration > Mode d'affichage > 1Affichage des
nébuleuses

SETAUTOSKY ON/OFF Configuration > Configuration du programme >
Affichage > Voir la couleur du ciel

UNDO Edition > Défaire

REDO Edition > Refaire

SETPROJ ALTAZ/EQUAT/GALACTIC/ECLIPTIC Carte > Système de coordonnées

SETFOV 00d00m00s or 00.00 Icône  (champ de vision) ou Icône  (Barre
principale)

SETRA RA:00h00m00s ou 00.00 Icône  (Coordonnées AD)

SETDEC DEC:+00d00m00s ou 00.00 Icône  (Coordonnées DEC)

SETOBS LAT:+00d00m00sLON:+000d00m00s
ALT:000mOBS:name

Configuration > Observatoire
Attention que la longitude doit être négative vers
l'Est. Dans de nombreux cas, vous devez changer le
signe de longitude.

IDCURSOR

SAVEIMG PNG/JPEG/BMP Fichiername quality Fichier > Enregistrer l'image…

PRINT PRT/PS/BMP PORTRAIT/LANDSCAPE
COLOR/BW filepath

Imprime ou exporte en Postscript ou Bitmap,
Fichier → Imprimer et Fichier→ Options imprimante

SETNORTH Carte > Voir l'horizon > Nord

SETSOUTH Carte > Voir l'horizon > Sud

SETEAST Carte > Voir l'horizon > Est

SETWEST Carte > Voir l'horizon > Ouest

SETZENITH Icône  (Barre de droite)

ALLSKY Icône  (Barre de droite)

REDRAW Suit toute commande modifiant la carte, nécessaire à
sa mise à jour

GETCURSOR

GETEQGRID

GETGRID
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GETSTARMODE

GETNEBMODE

GETAUTOSKY

GETPROJ

GETFOV S/F

GETRA S/F

GETDEC S/F

GETDATE

GETOBS LAT:+00d00m00sLON:+000d00m00s
ALT:000mOBS:name

Attention que la longitude est négative vers l'Est.
Dans de nombreux cas, vous devez changer le signe
de longitude.

SETDATE yyyy-mm-ddThh:mm:ss or “yyyy-mm-
dd hh:mm:ss”

Configuration > Date/Heure

SETTZ Etc/GMT Configuration > Observatoire (Zone horaire du pays)

GETTZ

SETGRIDNUM ON/OFF Configuration > Configuration du programme >
Affichage > Lignes - Voir les labels de grille

SETCONSTLINE ON/OFF Configuration > Configuration du programme >
Affichage > Lignes - Figure des constellations

SETCONSTBOUNDARY ON/OFF Configuration > Configuration du programme >
Affichage > Lignes - Limites des Constellations

RESIZE largeur hauteur Dimensionne la carte

GETRISESET Heure de lever/transit/coucher pour l'objet
sélectionné

MOVESCOPE RA Dec [00.00] Déplace le curseur du télescope aux coordonnée. RA
en heures décimale.

MOVESCOPEH HourAngle Dec [00.00] Comme MOVESCOPE mais avec l'angle horaire plutôt
que l’ascension droite. Angle horaire en heures
décimale

IDCENTER Identifie l'objet au centre de la carte

IDSCOPE Identifie l'objet à la position du télescope

SHOWPICTURE ON/OFF Carte → Voir les objets → Voir les images

SHOWBGIMAGE ON/OFF Affiche l'image d'arrière plan

LOADBGIMAGE fits_filename Charge une nouvelle image FITS, force la mise a jour
de l'image si le nom est le même.

LOADCIRCLE nom_fichier Charge une liste de marqueur, comme clic droit -
Cercle du chercheur - Charge depuis un fichier

SETCIRCLE num diametre rotation offset Défini un cercle du chercheur, comme Configuration -
Affichage - Cercle du chercheur

SETRECTANGLE num largeur hauteur rotation offset Défini un rectangle du chercheur, comme
Configuration - Affichage - Rectangle du chercheur

SHOWCIRCLE num_list Liste séparée par des virgules de cercle a afficher 1,2,
…,10

SHOWRECTANGLE num_list Liste séparée par des virgules de rectangle a afficher
1,2,…,10

MARKCENTER ON/OFF Marque le centre de la carte avec un cercle, comme
Voir les marques

GETSCOPERADEC Retourne les coordonnées du télescope.

TRACKTELESCOPE ON/OFF Comme le menu Télescope / Suit le télescope.

CONNECTINDI Connecte le télescope INDI configuré.

DISCONNECTINDI Déconnecte le télescope INDI.

SLEWINDI RAhr Dec [décimal] Déplace le télescope INDI aux coordonnées
spécifiées.

ABORTSLEWINDI Abandon de la commande de déplacement en cours.
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SYNCINDI RAhr Dec [décimal] Sync du télescope INDI aux coordonnées spécifiées.

CONNECTTELESCOPE Connecte le télescope par défaut.

DISCONNECTTELESCOPE Déconnecte le télescope par défaut.

SLEW RAhr Dec [in decimal] Déplace le télescope par défaut aux coordonnées
spécifiées.

ABORTSLEW Abandon de la commande de déplacement en cours.

SYNC RAhr Dec [in decimal] Sync du télescope par défaut aux coordonnées
spécifiées.

OBSLISTLOAD list_file_name

OBSLISTFIRST

OBSLISTLAST

OBSLISTNEXT

OBSLISTPREV

OBSLISTLIMIT ON/OFF

OBSLISTAIRMASSLIMIT [airmass]

OBSLISTTRANSITLIMIT [hours]

OBSLISTTRANSITSIDE EAST/WEST/BOTH

GETSCOPERATES Retourne une liste des vitesses supportée par le
télescope

SCOPEMOVEAXIS axe(0/1) vitesse Déplace le télescope le long de (axe) à la (vitesse)

SETSCOPEREFRESHRATE delay [ms] Rafraîchir la position du télescope chaque (delay) [ms]

PLANISPHEREDATE ON/OFF Afficher ou masquer l'échelle de date de la
planisphère

PLANISPHERETIME ON/OFF Afficher ou masquer l'échelle d'heure de la
planisphère

SETFOVPROJECTION fov_number
HAI/MER/CAR/ARC/TAN/SIN

Définir la projection pour le champ fov_number

SHOWONLYMERIDIAN ON/OFF Afficher uniquement le méridien au lieu de la grille
complète

SHOWALWAYSMERIDIAN ON/OFF Afficher le méridien pour toutes les projections

CLEANUPMAP Supprime toute les sélections et redessine la carte

GETCHARTEQSYS Retourne le système équatorial courant, Date or
J2000, B1950, …

Compatibilité avec V2.7 - commandes DDE

Commande Paramètres Commentaires ou équivalent Interface
Utilisateur

MOVE obsolete RA: 00h00m00.00s DEC:+00d00m00.0s
FOV:+00d00m00s

Icône 

DATE obsolete same as SETDATE

OBSL obsolete same as SETOBS

RFSH obsolete same as REDRAW

PDSS Même chose que le menu Carte - Voir les
images DSS

SBMP obsolete use SAVEIMG

SGIF obsolete use SAVEIMG

SJPG obsolete use SAVEIMG

IDXY X:pixelx Y:pixely

GOXY X:pixelx Y:pixely

ZOM+ obsolete same as ZOOM+

ZOM- obsolete same as ZOOM-

STA+ Icône  (Barre principale)
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STA- Icône  (Barre principale)

NEB+ Icône  (Barre principale)

NEB- Icône  (Barre principale)

GREQ obsolete use SETEQGRID

GRAZ obsolete use SETGRID

GRNM obsolete use SETGRIDNUM

CONL obsolete use SETCONSTLINE

CONB obsolete use SETCONSTBOUNDARY

EQAZ obsolete use SETPROJ

Information sur l'objet sélectionné

Les informations suivantes sont retournée quand un objet est sélectionné sur la carte, que ce soit par un clic de souris ou le
résultat d'une recherche. Chaque champ est séparé par le caractère <tab>.

> Chart_1 : 23h21m39.85s +61°19'04.8" Nb  NGC 7635 m:11.00 Dim: 15.0 x  8.0 ' class:  Identifier:C11,LBN 548

> indique le début d'un message.
Chart_1 : le nom de la carte où l'objet est sélectionné.
23h21m39.85s AD de l'objet utilisant l'équinoxe de la carte.
+61°19'04.8“ Dec de l'objet utilisant l'équinoxe de la carte.
Nb le type d'objet.
NGC 7635 le nom de l'objet

Viennent ensuite plusieurs champs dont le contenu dépend du type d'objet et du catalogue utilisé.

Si la sélection provient d'un clic de souris il y a également ces informations donnant la distance au dernier objet sélectionné:

> Chart_1 : From: "Sh 2-150" to "NGC 7635 " Separation: +06°48'05.6" PA:119° Offset:  0h49m46.4s -03°53'47"
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Répertoire des données
Voici un aperçu des répertoires et fichiers d'une installation standard.

Windows

Utilisation Répertoire

exécutable skychart.exe (le programme principal)

exécutable cdcicon.exe (l'icône de la barre de tache)

exécutable varobs.exe (observation des étoiles variables)

Installation C:\Program Files\ciel

Configuration utilisateur C:\Users\[user]\AppData\Local\Skychart (Vista,Win7,Win8)
C:\Documents and Settings\[nom_utilisateur]\local Settings\Application Data\Skychart (Win XP)

Certain répertoires sont caché. modifier les réglages de l'Explorateur pour les voir.

Linux

Utilisation Répertoire

exécutable /usr/bin/skychart (le programme principal)

exécutable /usr/bin/cdcicon (l'icône de la barre de tache)

exécutable /usr/bin/varobs (observation des étoiles variables)

Installation /usr/share/skychart

Configuration utilisateur ~/.skychart (attention au point qui fait que ce répertoire est caché)

Mac OS X

Utilisation Répertoire

exécutable skychart.app (le programme principal)

exécutable varobs.app (observation des étoiles variables)

Installation /Application/Cartes du Ciel

Configuration ~/Library/Application Support/skychart

Contenu du répertoire de configuration utilisateur

skychart.ini. Ce fichier contient toute la configuration du programme faite par l'utilisateur. Par exemple la position de
l'observatoire, les répertoire des catalogues, les définitions de vos marques de recherches.
cdc_trace.txt. Ce fichier contient la trace des évènement de la dernière session du programme. Il peut aider a trouver
la cause de problèmes. Seulement sous Windows et Mac OSX, sous Linux cette trace se fait dans stdout
Archive. Les images FITS archivées.
database. Répertoire de la base de donnée. C'est dans la base de donnée cdc.db que le programme enregistre les
informations comme les lieux d'observations, les éléments et résultat de calcul des comètes et astéroïdes, ainsi que la
table des images associée au divers objets.
MPC. Répertoire pour le téléchargement des éléments des comètes et astéroïdes depuis le site du Minor Planet Center.
pictures. Répertoire pour les images FITS du DSS en ligne sont téléchargée. Vous trouverez la dernière image dans le
fichier $temp.fit
tmp. Répertoire pour les fichiers de travail ou de téléchargement temporaire.
varobs Les fichiers de donnée pour les étoiles variables.
vo Vos donnée téléchargée des catalogues de l'Observatoire Virtuel.
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Référence des scripts
Cette page contient du matériel de référence pour les fonctions de script.

Voir la page Boîtes à outils pour des informations générales.

Voir les exemples de scripts pour un démarrage rapide avec les fonctions de programmation.

Langage de script

Le langage de programmation utilisé est Pascal Script [https://en.wikipedia.org/wiki/Pascal_Script].
Pour une référence complète du langage Pascal Objet, vous pouvez lire Free Pascal Reference guide
[http://www.freepascal.org/docs-html/ref/ref.html]. Mais attention, certaines fonctionnalités ne sont pas implémentées par le
langage de script, par exemple: pas de pointeur, pas d'assembleur, pas de surcharge.

En plus des fonctions standard de Pascal Script, les fonctions suivantes spécifiques à Cartes du Ciel sont ajoutées.

Fonctions du menu principal

Tous les éléments du menu principal peuvent être utilisés à partir des scripts. 
La liste complète des noms de menu est disponible à partir de la liste des menus
[http://sourceforge.net/p/skychart/code/HEAD/tree/trunk/skychart/menu.txt].

Vous pouvez exécuter l'action du menu à l'aide de la méthode Click ou tester si une option est activée en testant la propriété
Checked.

Chaînes des traductions

Chaque chaîne traduite pour le programme principal peut être utilisée dans un script. 
Utilisez directement la constante rsXXX pour obtenir la chaîne traduite. 
La liste complète des chaînes disponibles est disponible à partir du code source
[http://sourceforge.net/p/skychart/code/HEAD/tree/trunk/skychart/u_translation.pas].
Si une chaîne n'est pas traduite pour votre langue n'hésitez pas à le faire vous même.

Constantes

name value

deg2rad degree to radian conversion constant

rad2deg radian to degree conversion constant

Accès aux variables globales

function GetS(varname:string; var str: string):Boolean;

Get the global string variable identified by varname

varname value

ChartName The name of the last chart that send an event

RefreshText The text of the ChartRefresh event

SelectionText The short text of the selected object

DescriptionText The object full description

DistanceText The text of the last distance measurement event

Str1 .. Str10 Ten global variable for your use

function SetS(varname:string; str: string):Boolean;

Set the global string variable identified by varname for later use

varname value

Str1 .. Str10 Ten global variable for your use

function GetSL(varname:string; var strl: Tstringlist):Boolean;

Get the global stringlist variable identified by varname

varname value

Strl1 .. Strl10 Ten global variable for your use
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function SetSL(varname:string; stlr: Tstringlist):Boolean;

Set the global stringlist variable identified by varname for later use

varname value

Strl1 .. Strl10 Ten global variable for your use

function GetI(varname:string; var i: Integer):Boolean;

Get the global integer variable identified by varname

varname value

Int1 .. Int10 Ten global variable for your use

function SetI(varname:string; i: Integer):Boolean;

Set the global integer variable identified by varname for later use

varname value

Int1 .. Int10 Ten global variable for your use

function GetD(varname:string; var x: double):boolean;

Get the global double variable identified by varname

varname value

TelescopeRA The telescope position right ascension

TelescopeDE The telescope position declination

TimeNow The current time in TDateTime format

Double1 .. Double10 Ten global variable for your use

function SetD(varname:string; x: Double):Boolean;

Set the global double variable identified by varname for later use

varname value

Double1 .. Double10 Ten global variable for your use

function GetV(varname:string; var v: Variant):Boolean;

Get the global variant variable identified by varname

varname value

Telescope1 , Telescope2 Two ASCOM Telescope objects

Dome1 , Dome2 Two ASCOM Dome objects

Camera1 , Camera2 Two ASCOM Camera objects

Focuser1 , Focuser2 Two ASCOM Focuser objects

Filter1 , Filter2 Two ASCOM Filter wheel objects

Rotator1 , Rotator2 Two ASCOM Rotator objects

Variant1 .. Variant10 Ten global variable for your use

function SetV(varname:string; v: Variant):Boolean;

Set the global variant variable identified by varname for later use

varname value

Telescope1 , Telescope2 Two ASCOM Telescope objects

Dome1 , Dome2 Two ASCOM Dome objects

Camera1 , Camera2 Two ASCOM Camera objects

Focuser1 , Focuser2 Two ASCOM Focuser objects

Filter1 , Filter2 Two ASCOM Filter wheel objects

Rotator1 , Rotator2 Two ASCOM Rotator objects

Variant1 .. Variant10 Ten global variable for your use

Carte et objets

function Cmd(cname:string; arg:Tstringlist):string;

Execute one of the Skychart server command. Add the command name first to the string list, then each parameter.

procedure SendInfo(origin,str:string);
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Send a message to the clients connected to the Skychart server.

function GetObservatoryList(list:TstringList):boolean;

Return the list of the Observatory favorite

function GetScopeRates(list:TstringList):boolean;

Return a list of speed rate supported by the telescope

function GetCometList(const filter: string; maxnum:integer; list:TstringList):boolean;

Return a list of comet according to the filter

function GetAsteroidList(const filter: string; maxnum:integer; list:TstringList):boolean;

Return a list of asteroid according to the filter

function CometMark(list:TstringList):boolean;

Mark the listed comet to the chart

function AsteroidMark(list:TstringList):boolean;

Mark the listed asteroid to the chart

Conversion de coordonnées

Procedure Eq2Hz(var ra,de : double ; var a,h : double);

Convert Equatorial ra,de to Alt/Az a,h for the location and time of the current chart, all angle in radian

Procedure Hz2Eq(var a,h : double; var ra,de : double);

Convert Alt/Az a,h to equatorial ra,de for the location and time of the current chart, all angle in radian

Procedure Eq2Gal(var ra,de : double ; var l,b : double);

Convert Equatorial ra,de to Galactic l,b , all angle in radian

Procedure Gal2Eq(var l,b : double; var ra,de : double);

Convert Galactic l,b to equatorial ra,de , all angle in radian

Procedure Eq2Ecl(var ra,de : double ; var l,b : double);

Convert Equatorial ra,de to Ecliptic l,b with obliquity for the date of the current chart, all angle in radian

Procedure Ecl2Eq(var l,b : double; var ra,de : double);

Convert Ecliptic l,b to Equatorial ra,de with obliquity for the date of the current chart, all angle in radian

Conversion et Formatage

Function ARtoStr(var ar: Double) : string;

Return a string formated Right Ascension of ar value

Function DEtoStr(var de: Double) : string;

Return a string formated Declination of de value

Function StrtoAR(str:string; var ar: Double) : boolean;

Convert a formated string to Right Ascension decimal value

Function StrtoDE(str:string; var de: Double) : boolean;

Convert a formated string to Declination decimal value

Function JDtoStr(var jd: Double) : string;

Format a julian date to YYYY-MM-DD string

Function StrtoJD(dt:string; var jdt: Double) : boolean;

Convert a formated string YYYY-MM-DD to julian date value

Function FormatFloat(Const Format : String; var Value : double) : String;

Format a decimal number according to the Format [http://www.freepascal.org/docs-html/rtl/sysutils/formatfloat.html]
specification

Function Format(Const Fmt : String; const Args : Array of const) : String;

The Format [http://www.freepascal.org/docs-html/rtl/sysutils/format.html] Pascal function

Procedure StrtoFloatD(str:string; var defval: Double; var val: Double);
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Convert a string to a floating point value. Return defval if the string is a invalid number

function IsNumber(str: String): boolean;

Return True if the string represent a valid number

function StringReplace(str,s1,s2: String): string;

Replace all occurrence of s1 by s2 in str

procedure JsonToStringlist(jsontxt:string; var SK,SV: TStringList);

Parse a JSON formated string and return two stringlist. SK contain the names and SV the corresponding values

Dialogues standard

function OpenDialog(var fn: string): boolean;

The standard Open File dialog. Return True if the OK button is pressed after the file selection.

function SaveDialog(var fn: string): boolean;

The standard Save File dialog. Return True if the OK button is pressed after the file selection.

function MsgBox(const aMsg: string):boolean;

A message confirmation dialog. Return True if YES is clicked.

Procedure ShowMessage(const aMsg: string);

Display a message.

function CalendarDialog(var dt: double): boolean;

The Skychart Calendar dialog. Return dt julian date

Exécution de programme externes

function Run(cmdline:string):boolean;

Execute the specified command. Return immediately without waiting for the execution to end.

function RunOutput(cmdline:string; var output:TStringlist):boolean;

Execute the specified command, wait for termination and put the stdout to “output”. Beware this function can completely
lock the main program if it not finish in time.

function OpenFile(fn:string):boolean;

Open a document file using the default program

Voir aussi les exemples de scripts pour l'appel de libraires externes.

Client socket TCP/IP

Pour toutes ces fonctions socknum identifie le socket à utiliser. Il s'agit d'un nombre entre 1 et 10, permettant ainsi 10
connexion simultanée à des serveurs différent.

function TcpConnect(socknum:integer; ipaddr,port,timeout:string):boolean;

Connect to the server at ipaddr:port and set the timeout for the subsequent operations

function TcpDisconnect(socknum:integer):boolean;

Disconnect from the server

Function TcpConnected(socknum:integer) : boolean;

Return True if the socket is connected

Function TcpRead(socknum:integer; var buf : string; termchar:string) : boolean;

Read data from the socket until the character termchar is encountered, typically termchar is CRLF

Function TcpReadCount(socknum:integer; var buf : string; var count : integer) : boolean;

Read data from the socket until count character are read or timeout is reached

Function TcpWrite(socknum:integer; var buf : string; var count : integer) : boolean;

Write data to the socket from buf for a length of count

Procedure TcpPurgeBuffer(socknum:integer);

Purge all the received data currently queued in the receive buffer
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Exemple de script
Cette page donne des conseils et des exemples de script. 
Vous pouvez également regarder le code des boîte à outils standard à partir du programme. 
Pour plus de détails sur une fonction spécifique, voir la page de référence des script.

Généralités

Nous examinons d'abord en détail le code du bouton Goto de la boîte à outils standard pour l'observation. 
Cela couvre de nombreuses bases de programmation.

Le code complet du script ressemble à ceci:

// Slew telescope

  var ra,de: double;

      a,b,r: string;

      c: Tstringlist;

  begin

  memo_1.clear;

  if MenuTelescopeConnect.checked then begin

    if not StrToAR(Edit_1.text,ra) then begin memo_1.lines.add(rserror+' RA!');exit;end;

    if not StrToDE(Edit_2.text,de) then begin memo_1.lines.add(rserror+' DE!');exit;end;

    a:=floattostr(ra);

    b:=floattostr(de);

    GetSL('STRL1',c);

    c.clear;

    c.add('SLEW');

    c.add(a);

    c.add(b);

    r:=cmd('',c);

    c.clear;

    memo_1.lines.add(r);

  end

  else memo_1.lines.add(rsTelescopeNot);

  end.

Regardons chaque partie en détail:

// Slew telescope

C'est un commentaire, vous pouvez utiliser // {..} (*..*) pour marquer les commentaires.

  var ra,de: double;

      a,b,r: string;

      c: Tstringlist;

Définit les variables que nous utiliserons plus loin dans le script.
Les types de variable important sont: integer, double, string.
Le type Tstringlist est utilisé pour envoyer des commandes à Cartes du Ciel.

  begin

Le début de notre programme.

memo_1.clear;

Efface la zone de texte que nous utilisons pour afficher les messages. Cela garantit que la zone de texte n'est pas remplie par
les messages précédents.

  if MenuTelescopeConnect.checked then begin

Nous testons la propriété Checked de l'élément de menu MenuTelescopeConnect. Ceci indique que nous avons connecté le
télescope. 
Si le résultat est vrai, nous exécutons le bloc de code commençant par “begin” jusqu'à “end” correspondant.

    if not StrToAR(Edit_1.text,ra) then begin memo_1.lines.add(rserror+' RA!');exit;end;

Nous essayons de convertir RA du format HMS de la zone de texte Edit_1 dans une valeur numérique. Si la conversion échoue
(parce que nous tapons n'importe quoi dans la zone de texte) nous affichons un message d'erreur et nous quittons.

   a:=floattostr(ra);

Conversion de RA à nouveau en chaîne de caractères mais avec le format décimal requis par la commande.

GetSL('STRL1',c);

c.clear;
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Demande un objet TStringList identifié par STRL1. Nous effaçons toutes les données qui peuvent rester dans l'objet.

    c.add('SLEW');

    c.add(a);

    c.add(b);

Ajoutez la commande et les paramètres requis (dans ce cas, RA et DEC) à la liste de chaînes.

   r:=cmd('',c);

Exécute la commande et stocke le résultat dans la variable r.

memo_1.lines.add(r);

Affiche le résultat de la commande dans la zone de texte.

else memo_1.lines.add(rsTelescopeNot);

Dans le cas où le test MenuTelescopeConnect.checked est faux, nous exécutons cette ligne. 
Il affiche dans la zone de texte une traduction dans la langue locale de 'Télescope non connecté'.

 end.

La fin du programme.

Appel d'une librairie externe

Vous pouvez définir une fonction dans une librairie externe à utiliser dans votre script comme une autre fonction locale.

Cet exemple implémente un chronomètre simple en utilisant la fonction GetTickCount de l'API Windows. 
Il y a deux boutons Start et Stop et deux zone de texte. Une variable globale integer est utilisée pour stocker l'heure de
début.

Script du bouton Start:

 function GetTickCount: Longint; external 'GetTickCount@kernel32.dll stdcall';

 var

   tick: Longint;

 begin  

   tick:=GetTickCount;

   setI('Int1',tick);

   edit_1.text:='Started';

 end.

Script du bouton Stop:

function GetTickCount: Longint; external 'GetTickCount@kernel32.dll stdcall';

var

  t: double;

  t1,tick: Longint;

begin

  tick:=GetTickCount;

  getI('Int1',t1);

  t:=double(tick-t1)/1000;

  edit_1.text:='';

  edit_2.text:=formatdatetime('HH:MM:SS.ZZZ',t/24/3600);

end.

Vous pouvez appeler n'importe quelle fonction d'un librairie de cette façon, mais méfiez-vous que cela dépend du système, la
librairie kernel32.dll n'est pas disponible sur Mac ou Linux.

Une autre limitation est que beaucoup de fonctions de librairie attendent un pointeur vers une structure de paramètre.
Comme le langage de script utilise un byte code en interne (comme Java), il ne peut pas utiliser un pointeur pour donner les
paramètres. Une solution est d'écrire un wrapper en C qui exporte la fonction avec une liste de paramètres à plat.

Utiliser ASCOM directement

Cela décrit comment utiliser un périphérique ASCOM directement à partir de votre script sans utiliser le télescope ASCOM
de Cartes du Ciel.

Il peut être utilisé pour accéder à une autre classe de périphérique, l'exemple se connecte à un dôme, ou pour accéder à des
propriétés supplémentaires de votre télescope. 
Dans ce dernier cas, vous devez faire attention que votre script fonctionne en concurrent du programme principal pour
l'accès au périphérique.

Choisir un périphérique ASCOM

Le code suivant assigné à un bouton permet de sélectionner le pilote ASCOM Dome que nous voulons utiliser. Le nom du
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pilote est enregistré dans le champ de texte Edit_1.

 var

   V: variant;

   w,s: widestring;

 begin

   V := CreateOleObject('ASCOM.Utilities.Chooser');

   w:='Dome';

   V.DeviceType:=w;

   s:=edit_1.text;

   s:=V.Choose(s);

   edit_1.text:=s;

   V:=Unassigned;

 end.

Remplacer w:='Dome'; par Telescope, Focuser, Rotator, Camera, Filter pour choisir un autre type de périphérique.

Connecter le pilote ASCOM

Le code suivant est pour le bouton “Connecter”. Il se connecte au pilote ASCOM Dome que nous avons sélectionné
précédemment. Nous utilisons la variable globale Dome1 pour stocker l'objet ASCOM.

var

  D: variant;

  s: widestring;

begin

  s:=edit_1.text;

  getV('Dome1',D);

  if VarIsEmpty(D) then

    D := CreateOleObject(s);

  D.connected:=true;

  setV('Dome1',D);

end.

Utilisation du pilote ASCOM

Maintenant, nous voulons ajouter un bouton pour ouvrir le volet du dôme. C'est juste un exemple, à ce stade, n'importe quelle
propriété ASCOM peut être utilisée. 
Le premier test protège d'un blocage du programme si nous essayons d'utiliser une variante non initialisée. 
Le deuxième test protège d'une erreur ASCOM si le dôme n'est pas connecté.

var

  D: variant;

begin

  getV('Dome1',D);

  if (not VarIsEmpty(D)) then

    if D.Connected then

       D.OpenShutter;

end.

Déconnexion du pilote ASCOM

Ajout d'un bouton pour déconnecter le pilote et libérer les ressources.

var

  D: variant;

begin

  getV('Dome1',D);

  if (not VarIsEmpty(D)) then

    if D.Connected then

       D.connected:=false;

  D:=Unassigned;

  setV('Dome1',D);

end.

Ouvrir un document

Le code suivant ouvre la documentation de Cartes du Ciel dans le navigateur Web par défaut. 
Vous pouvez utiliser n'importe quel type de document avec cette fonction, le document sera ouvert avec l'application par
défaut de la même manière que si vous double-cliquez sur le document dans l'explorateur de fichiers.

begin

  OpenFile('doc\wiki_doc\en\documentation\start.html');

end.

Exécuter une commande

Il existe deux façons différentes d'exécuter une commande externe ou un programme, selon si vous voulez attendre un
résultat ou non.

Avec attente du résultat

Le code suivant exécute la commande DIR dans le répertoire courant. Le résultat est stocké dans une liste de chaînes et
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affiché plus tard dans un mémo texte. Il contient la liste des fichiers du répertoire.

var r:TstringList;

begin

  GetSL('STRL1',r);

  r.clear;

  RunOutput('dir',r);

  Memo_1.lines.assign(r);

end.

Sans attente

Si la commande peut s'exécuter pendant un temps indéterminé ou ne produit pas un résultat, vous devez utiliser le code
suivant. 
Cet exemple exécute le programme “Variable star observer” et quitte immédiatement.

begin

  Run('varobs');

end.
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Méthode de calcul et précision
Cette page donne quelques informations sur les méthodes de calcul utilisées par Cartes du Ciel et la précision que vous
pouvez attendre pour les valeurs affichées.

Attention que cette description est valable avec les paramètres de configuration par défaut du programme, en utilisant les
données des catalogues par défaut. Vous avez de nombreuses options disponibles pour modifier les résultats, principalement
dans la page de configuration Carte,coordonnées. Utilisez ces paramètres que si vous savez vraiment ce que vous faites!

Positions équatoriales des étoiles

La précision de base dépend du catalogue d'étoiles utilisé, pour la précision de la position mais aussi pour le mouvement
propre. Le catalogue par défaut est le Extended Hipparcos Compilation (XHIP, V/137 [http://cdsarc.u-strasbg.fr/viz-bin/Cat?
V/137D]). L'avantage de ce catalogue est la disponibilité des paramètres complets de mouvement propres pour toutes les
étoiles.

Après avoir lu les données du catalogue le programme calcule la position des étoiles corrigée du mouvement propre à la date
de la carte en utilisant les valeurs de pmRA et pmDEC values, ainsi que la parallaxe et la vitesse radiale si elle sont disponibles
(u_projection.pas, ProperMotion). Cela donne la position équatoriale J2000 astrométrique.

Ensuite, la précession est calculé pour la date de la carte à l'aide de la méthode proposée par J. Vondrak, N. Capitaine, P.
Wallace dans “New precession expressions, valid for long time intervals A&A 2011
[http://adsabs.harvard.edu/abs/2011A%26A...534A..22V]” (u_projection.pas, PrecessionV). Cela donne la position équatoriale
moyenne de la date.

Pour trouver la position apparente nous calculons la nutation en utilisant la valeur donnée par les éphémérides JPL, puis
l'aberration annuelle et la déviation de la lumière par le Soleil (u_projection.pas, apparent_equatorialV). Cela donne la position
équatoriale apparente.

Pour l'époque actuelle, la précision doit être meilleure que 0.1 seconde d'arc. 
La précision du calcul de mouvement propre pour une longue période de temps dépend de la disponibilité de la parallaxe et de
la vitesse radiale, mais aussi de l'erreur-type sur les valeurs. Une erreur d'environ 1 seconde d'arc par millénaire est à
attendre.
Le calcul de précession est valable pour une période de +/- 200'000 ans. La précision est meilleur qu'un millième de seconde
d'arc pour l'époque actuelle, elle est de quelques secondes d'arc pour la période historique, et quelques dixièmes de degré à la
fin de la période.

Positions équatoriales des nébuleuses

Le principal problème concernant la position des objets du ciel profond est la difficulté de définir avec précision le centre de
l'objet. En raison de cette difficulté, les positions différent selon le catalogue source. En outre, beaucoup de catalogues
historiques encore en usage donnent la position avec une précision d'une minute d'arc seulement.

Après avoir obtenu les données du catalogue le programme calcule la précession et la position apparente comme décrit ci-
dessus pour les étoiles.

Positions équatoriales des planètes

Les positions des planètes sont calculées en utilisant les éphémérides du JPL ou si aucun fichier n'est trouvés pour la date du
jour, la librairie plan404 de Steve Moshier [http://www.moshier.net/] qui permet le calcul de -3000 à 3000 ans avec une
précision supérieure à une seconde d'arc.
Par défaut un extrait de DE430 valide entre 2000 et 2050 est fourni avec le programme. Donc la première chose à faire si
vous voulez position des planètes avec une haute précision à long terme est d'installer un fichier DExxx complet
[ftp://ssd.jpl.nasa.gov/pub/eph/planets/Linux/].
DE431 est recommandé si vous pouvez vous permettre le téléchargement de 2.5 Go. Avec ce fichier, vous pouvez calculer la
position précise des planètes et la nutation entre -13000 et 17000.

La fonction de calcul retourne la position de la planète pour J2000 corrigée pour le temps de lumière, ensuite le programme
utilise la même fonction que pour les étoiles pour calculer la précession. C'est la position géocentrique moyenne la date.

Ensuite, nous corrigeons la parallaxe selon l'emplacement de l'observateur sur Terre (u_projection.pas, Paralaxe). Cela donne
la position topocentrique moyenne de la date.

Ensuite, la position apparente est calculée par application de la nutation et de l'aberration annuelle (pas pour la Lune). C'est la
position topocentrique apparente.

Pour l'époque actuelle, la précision devrait être meilleure que 0.1 seconde d'arc.
Pour une date loin dans le passé ou l'avenir la principale source d'erreur est l'incertitude sur la différence entre le temps
universel et le temps terrestre deltaT [http://en.wikipedia.org/wiki/%CE%94T]. Vous pouvez voir et modifier la valeur de deltaT
dans la fenêtre de configuration de l'heure.
La précision du calcul lui-même dépend de chaque éphéméride, mais elle est toujours largement supérieure aux besoin d'un
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observateur terrestre. Reportez-vous à la documentation JPL.
L'erreur sur la précession est la même que discuté pour les étoiles.

Positions équatoriales des comètes et astéroïdes

Les calculs des comètes et astéroïdes sont basés sur des éléments au format MPCORB. Vous devez tout d'abord télécharger
les éléments nécessaires.
Les éléments sont ensuite chargés dans une base de données qui permet d'avoir plusieurs jeux de donnée valide à différentes
époques.Le programme utilise toujours les éléments les plus proche de la date de la carte. 
Pour les astéroïdes il calcule également une valeur mensuelle de la magnitude qui est utilisé pour exclure les objets qui sont
actuellement trop faibles pour être visible. Cela aide à accélérer les autres calculs.
Lorsque la date change, le programme calcule une position pour chaque objet. Cette position est ensuite utilisée pour savoir si
une position précise doit être calculé pour la carte en cours. Les NEO sont exclut de ce processus parce que la position
change trop rapidement. Tout ce traitement est nécessaire pour éviter de calculer trop position chaque fois que la carte est
actualisée.

Après que les éléments des objets sont sélectionnés, le programme calcule les coordonnées rectangulaires héliocentrique puis
la position géocentrique J2000 corrigée pour le temps de lumière.

Puis précession, la parallaxe et la position apparente est calculée de la même façon que pour les planètes.

Avec l'utilisation d'éléments récent, la précision devrait être meilleure que 0.1 seconde d'arc.
Vous pouvez calculer la position des astéroïdes et des comètes de manière fiable que pour quelques mois autour de la date des
éléments. Il n'y a donc aucun sens à calculer ces positions pour une date loin dans le passé ou le futur.

Positions Alt/Az

C'est ainsi que le programme convertit la position équatoriale apparente d'un objet à l'azimut et la hauteur pour un lieu
donné.

On obtient d'abord les azimut/hauteur géométriques par une rotation du système de coordonnées en utilisant les coordonnées
équatoriales, le temps sidéral, et la position de l'observateur.
Si vous donnez les coordonnées actuelles du pôle de la Terre dans les paramètres de l'Observatoire la position est corrigée
pour compenser cela.

Ensuite, la position est corrigée pour l'aberration diurne et la réfraction.

La réfraction est calculée en utilisant deux méthodes différentes, l'une pour l'affichage de la carte, l'autre pour afficher une
valeur plus précise dans la fenêtre d'informations détaillées.
La première méthode a besoin d'être entièrement réversible sans trop de calcul. Elle est actuellement basée sur la formule de
Bennett.
La deuxième est basée sur les procédures de SLALIB [http://star-www.rl.ac.uk/docs/sun67.htx/sun67.html]
(REFCO,REFZ,REFRO) et tient compte de plus de paramètres atmosphériques. Pour profiter pleinement de cette précision
vous devez indiquer soigneusement la pression atmosphérique, la température, l'humidité relative et si possible le gradient
troposphérique (à partir d'un sondage proche ou d'un modèle météo). La longueur d'onde utilisée pour le calcul est 550nm.

Si tous les paramètres de l'observatoire sont donnés avec le maximum de précision, la précision de l'azimut et l'altitude
géométrique doit être meilleure que 0.5 seconde d'arc. La précision de l'altitude réfractée dépend de la différence entre le
modèle et l'atmosphère réelle.
Mais rappelez-vous que 0.1 seconde d'arc représente 3 mètres sur le sol et qu'une étoile sur l'équateur céleste se déplace de
cette distance en 7 millièmes de seconde. Vous devez définir la position de votre observatoire et mesurer le temps avec cette
précision si vous voulez que ça soit cohérent.

161



Installation du programme à partir du code source

Obtenir le code source

Créez un nouveau répertoire pour contenir le code source. Vous pouvez l'obtenir de deux manières:

Téléchargez le fichier des sources skychart_v4_xxx_source.tar.gz 
dans ce répertoire et extrayez les fichiers.
Pour Linux la commande est : tar xzf skychart_v4_xxx_source.tar.gz 
Avec Windows utilisez 7-zip disponible depuis: http://sourceforge.net/projects/sevenzip/
[http://sourceforge.net/projects/sevenzip/]

Ou mieux clone ou fork le repository [https://​github.com/​pchev/​skychart] git [https://git-scm.com/] pour obtenir la toute
dernière version et ne mettre a jour que les changement journalier. Vous devez procéder ainsi si vous voulez me
proposer une modification du code avec un pull request. 
La commande est: 

git clone https://github.com/pchev/skychart.git 

Compilation et installation automatique

Si vous voulez juste compiler le programme sans utiliser l'environnement interactif de Lazarus vous trouverez les scripts
nécessaires dans le répertoire de base.

Avant de lancer ces scripts veillez a avoir le chemin des exécutables de Free Pascal dans votre environnement PATH, c'est là
que ce trouve entre autres la commande fpcmake.

Il y a également dans le répertoire de base un script buildpkg.sh qui construit automatiquement les paquets de distribution
pour Linux et Windows. C'est celui qui est utilisé pour produire les paquets disponibles en téléchargement.

Pour Linux et Mac

./configure [fpc=répertoire_free_pascal] [lazarus=répertoire_lazarus] [prefix=répertoire_d'installation]

make

make install

make install_data

Pour Windows

Attention à ne pas avoir une autre commande make que celle de Free Pascal dans le path. 
Compilez manuellement les librairies getdss et plan404 avec Mingw [http://www.mingw.org/] 
Installez la commande sed pour Windows [http://gnuwin32.sourceforge.net/packages/sed.htm] 
Editez le fichier configure.cmd et ajuster les valeurs pour sed=, fpc=, lazarus=, prefix=
Vous devrez surement modifier les scripts selon la version Linux car je ne les utilisent pas et ils ne sont probablement
pas à jours.

configure.cmd 

make

make install

make install_data

Compilation interactive

Commencez par les composants requis depuis le répertoire src/skychart/component

Ouvrez le fichier “component/cdccomponents.lpk” dans Lazarus et cliquez sur Compile puis Install, accepter l'installation
dans tous les cas.
Quand on vous demande de reconstruire Lazarus repondez Oui.

Vous pouvez maintenant ouvrir le projet principal cdc.lpi

Lazarus affiche la dernière unité ajoutée au programme. Pour afficher la fiche principale utilisez le menu Projet / Forms, et
ouvrez f_main.

Pour compiler et executer le programme depuis l'IDE ajuster Run-Run Parameters-Working Directory pour le répertoire ou
CDC est installé.

Installation de Lazarus

Pour déterminer quelle version de Lazarus est nécessaire pour compiler une version spécifique de Skychart, installez la
version binaire et ouvrez le menu Aide / A propos. Il y a une ligne qui indique la version de FPC et Lazarus utilisée.

Installez Lazarus depuis http://lazarus.freepascal.org [http://lazarus.freepascal.org]. Voir:
http://wiki.lazarus.freepascal.org/Installing_Lazarus [http://wiki.lazarus.freepascal.org/Installing_Lazarus] pour plus
d'informations.

162



Dans Lazarus ouvrez Components-Configure, Installed Packages. 
Controlez que Printer4Lazarus et TurboPowerIPro sont installés, c'est normalement le cas.
Sinon installez depuis lazarus/component :

printers/printer4lazarus.lpk
turbopower_ipro/turbopoweripro.lpk

Voila la procédure que j'utilise pour installer ou mettre à jours Free Pascal et Lazarus sous Linux avec l'environnement de
cross compilation pour Windows:

cd ~/fpc

# svn co http://svn.freepascal.org/svn/fpc/branches/fixes_xxx .

svn up

make clean

make build

sudo make install

make clean OS_TARGET=win32 CPU_TARGET=i386

make build OS_TARGET=win32 CPU_TARGET=i386

sudo make crossinstall OS_TARGET=win32 CPU_TARGET=i386

ver=`fpc -iV`

sudo ln -f -s /usr/local/lib/fpc/$ver/ppc386 /usr/local/bin

sudo ln -f -s /usr/local/lib/fpc/$ver/ppcross386 /usr/local/bin

cd ~/lazarus

# svn co http://svn.freepascal.org/svn/lazarus/trunk .

svn up

make clean

make OS_TARGET=win32 CPU_TARGET=i386 clean

make bigide

make OS_TARGET=win32 CPU_TARGET=i386 bigide

Convention de nom pour les fichiers source

La convention de nom suivante est utilisée pour les fichiers du projet principal afin de pouvoir rapidement savoir quel est
l'utilisation d'un fichier.

cdc.lpi         : Le projet principal

pu_*.pas        : Unité d'une fiche

pu_*.lfm        : Définition de la fiche

cu_*.pas        : Unité d'un objet non-visuel

u_*.pas         : Unité avec du code générique

Structure des répertoires

  |- source -|                          < répertoire de base, script de compilation

             |- skychart |              < le module skychart 

                         |- component   < les composant du projet

                         |- library     < les librairies du projet 

                         |- ...

                         |- units       < résultats de compilation .dcu

             |- varobs   |              < le module varobs 

             |- tools | - data          < le répertoire "data" requis pour exécuter le programme

                      | - cat           < les catalogues de base, les programmes utilisé pour les construire

                      | - ...           < autres fichiers de données
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FAQ

Général

 Comment contribuer à CdC

Vous pouvez contribuer de différentes manières:

Essayez souvent le dernier snapshot et rapportez les bugs que vous trouvez.
Ecrivez de la documentation ici ou corrigez mes fautes d'orthographe.
Traduisez dans votre propre langue le programme ainsi que ces pages.
Regardez le code du programme et proposez vos améliorations.
Une autre idée? … contactez moi [http://​www.ap-i.net/​mantis/​].

 Ainsi, la version 3.10 est plus récente que 3.8 ?

Oui, le numéro de version n'est pas un nombre décimal, mais une combinaison de deux nombres séparés par un point.

Le premier chiffre “3” est la version majeure, il ne change que si la nouvelle version est incompatible avec la précédente. La
dernière fois que ça c'est produit était entre 2 et 3 en 2010. Un nouveau changement n'est pas prévu pour le moment.

Le deuxième numéro “8” ou “10” est la version mineure, elle change avec chaque version stable. Un nombre pair indique une
version stable. Les numéros impairs sont utilisés pour le développement et les versions beta intermédiaire. Si CdC était un
logiciel commercial j'aurais utilisé X plutôt que 10 :)

Installation

 J'ai CdC version 2.76. Que faire pour utiliser la nouvelle version 3. Que télécharger et est-ce que je dois
effacer la version 2.76 en premier

Vous devez juste installer la version 3.0 pour Windows dans le même répertoire que la version 2.76. N'essayez pas de
l'installer dans un autre répertoire et n'effacez rien car les deux versions peuvent être utilisée en même temps, c'est utile si
vous voulez être sur que la version 3 vous convient. Utilisez cdc.exe pour la version 3 et ciel.exe pour la 2.76.

 Est-ce que les anciens catalogues de la version 2.76 sont compatibles avec CdC v3.0 beta

Oui, tout ces catalogues peuvent être utilisés. Ouvrez simplement la configuration des catalogues pour les ajouter. 
La seule exception est les catalogues externes, ils sont remplacés par les plus commodes Catalogue texte Catgen ou
l'Interface de l'Observatoire Virtuel.

 Ou est-ce que je dois installer les catalogues supplémentaires sous Linux, dans quel répertoire les mettre

Si vous avez les droits root le mieux est de les mettre dans /usr/share/apps/skychart/cat avec les catalogues de base. Mais
vous pouvez aussi les installer ailleurs puisque vous pouvez indiquer le chemin complet dans la configuration des catalogues.

 Est-ce que je peux obtenir Cartes du Ciel pour mon Macintosh

Oui, la version 3 fonctionne maintenant la même chose sur Mac OS X qu'avec Windows ou Linux. Regardez les instructions
d'installation spécifiques Pour plus d'informations sur les logiciel supplémentaire que vous devez installer pour piloter un
télescope ou calculer les satellites artificiels.

 Qu'est ce que je fais avec MySQL

MySQL était utilisé comme base de donnée par défaut jusqu'à la version alpha 7. Depuis juin 2005 il est remplacé par SQLite.
Vous pouvez toujours utiliser MySQL si vous en avez besoin, par exemple pour partager la base de donnée sur un réseau local.
La base de donnée est utilisée pour enregistrer les informations sur: les éléments des astéroïdes et comètes, les images des
objets, les lieux d'observations.

Utilisation

 Est que CdC V3.0 pour Linux supporte le suivi des télescopes comme la version 2.76

Oui, CdC V3.0 pour Linux ou Mac utilise INDI [http://indi.sourceforge.net/] comme interface pour les télescopes. Tout télescope
supporté par INDI doit fonctionner avec CdC.
Il est également possible d'utiliser l'interface intégré pour le protocole LX200 ou les encodeurs.

 Il n'y a pas d'option “Voir” et “Suivre” dans le menu du télescope comme en version 2.76

Il y a maintenant une entrés Suivre le télescope dans le menu Télescope.
Il est aussi possible d'utiliser la fonction “verrouillé sur” (le bouton avec l'ancre). Quand le télescope est connecté et qu'aucun
autre objet n'est sélectionné ce bouton verrouille sur la position du télescope.

 Pourquoi le ciel est-il bleu

164



Parce qu'il fait jour  ou que la Lune est levée. Vous pouvez changer cela par le menu Configuration , Affichage, Voir la
couleur du ciel.

 Comment est-ce que je peux voir une carte avec la simulation des planètes avant 3000 BC

Depuis la version 3.9, vous pouvez utiliser les éphémérides JPL DE431 qui étendent la validité du calcul des planètes de -
13000 à +17000.

 Comment changer la langue du programme pour ma propre langue

La langue par défaut est détectée automatiquement au lancement du programme. Le menu Configuration / Général / Langues
permet d'en choisir une autre.

 Est-ce que CdC V3 supporte le protocole DDE

Non, le protocole standard de la version 3 est TCP/IP pour des questions de portabilité.

 Pourquoi avec Linux les caractères sont trop petit / trop gros

Il y avait un problème avec les paramètres de police GTK1 sous Linux dans le passé. Dans les dernières versions de CdC, Gtk2
est utilisé par défaut. Il ne devrait plus y avoir de problème maintenant. Sinon, merci de rapporter rapporter le bug.

Problèmes courants

 Sur Mac OS X, vous ne pouvez pas rouvrir le programme après l'avoir minimisé dans le dock

Il s'agit d'un bug avec la version actuelle de Qt.
Pour rouvrir le programme, vous devez cliquer avec le bouton droit de la souris sur l'icône du dock, sélectionner “Afficher
toutes les fenêtres” et cliquer sur l'image des petites fenêtres.
Vous pouvez également désélectionner “Minimiser les fenêtres dans l'icône de l'application” dans Préférences Système / Dock.

 La version 64 bits du programme se bloque au démarrage

Vous avez besoin d'un processeur AMD ou Intel 64 bits plus récent que 2005 ou 2006 qui prennent en charge les instructions
LAHF et SAHF. Sinon, vous devez utiliser la version 32 bits. 
Voir: https://en.wikipedia.org/wiki/X86-64#Older_implementations [https://en.wikipedia.org/wiki/X86-64#Older_implementations]

 Sur Linux, chaque caractère que je saisis dans le champ de recherche est doublé

C'est un bug avec certaine méthode de saisie. La solution consiste à installer le paquet ibus-gtk pour votre système et à
définir ibus comme méthode de saisie par défaut. 
Ou s'il n'est pas possible de modifier la valeur par défaut, exécutez skychart à l'aide de la commande suivante:

GTK_IM_MODULE=ibus skychart

 J'ai installé CdC V3.0 mais le programme n'affiche pas les étoiles ou un autre objet.

Peut-être vous avez installé que le programme. Vous devez également installer le paquet des catalogues de base, il est
normalement inclure avec le téléchargement standard. Regarder la page Téléchargement et suivez les instructions à la
page Installation de catalogues supplémentaires. 
Est-ce que les catalogues d'étoiles sont activés? Assurez-vous qu'ils sont, voir la page Etoiles de Configuration →
Catalogue. Une autre possibilité est que vous avez accidentellement basculé l'affichage des étoiles. Vérifiez la position du
bouton  dans la barre d'objet. 
Ou peut-être la cause est le filtre d'affichage des étoiles. Vérifiez vos paramètres dans l'onglet Filtre d'objet depuis
Configuration → Carte, coordonnée.
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Licence de la documentation
Copyright © 2006 Patrick Chevalley et l'Equipe de documentation de Cartes du Ciel

 Cette création est mise à disposition selon le Contrat Paternité-Partage des Conditions Initiales à

l'Identique

disponible en ligne http://creativecommons.org/licenses/by-sa/3.0/ [http://creativecommons.org/licenses/by-sa/3.0/] \ ou par
courrier postal à Creative Commons, 559 Nathan Abbott Way, Stanford, California 94305, USA.

 Afin de permettre sa distribution avec le logiciel cette documentation est aussi licenciée sous la

GNU Free Documentation License

Permission is granted to copy, distribute and/or modify this document

under the terms of the GNU Free Documentation License, Version 1.3

or any later version published by the Free Software Foundation;

with no Invariant Sections, no Front-Cover Texts, and no Back-Cover

Texts. 

Disponible en ligne http://www.gnu.org/licenses/fdl.html [http://www.gnu.org/licenses/fdl.html]
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Licence du logiciel
Cartes du Ciel software, Copyright © 2006 Patrick Chevalley

This program is free software; you can redistribute it and/or

modify it under the terms of the GNU General Public License

as published by the Free Software Foundation; either version 2

of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of

MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the

GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, see:
http://www.gnu.org/licenses/ [http://www.gnu.org/licenses/]

Vous pouvez utiliser librement toute carte ou impression produite par le programme, que ce soit pour une utilisation
commerciale ou non (blog, site web, livre, …). Vous pouvez mentionner Cartes du Ciel et ajouter un lien vers la page
principale, mais cela n'est pas requis.
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